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MF 6990dn - Agoris C935

Dear Customer
For your safety and comfort, we urge you to carefully read the chapter safety [ 119] before attempting use.
Congratulations on your purchase of a new generation communications terminal. Both a multifunction black and white 
and colour device able to fax, print, copy and scan, your machine suits even the most demanding professional 
requirements.
Combining power, user-friendliness and ease of use thanks to its touch screen, your machine offers the following 
functions:
• colour and black and white copying, scanning and faxing.
• printing and finishing of complex documents (duplex printing, optional finisher: stapling, assembling and offset work)
• print server with hard disk
• local network usage (LAN 10 BaseT/100 BaseTx, PC Kit Companion Suite Pro)
• secure document printing
• access protection (user account management, biometric identification, user rights and administration of appliance 

resources)
• management of resources available to users (quotas, counters)

Rules for using symbols

This document makes use of symbols designed to help the reader identify the information supplied:
 

Symbol Definition

 CAUTION
Indicates important safety information.
Failure to respect these notes may lead to serious or even fatal injury. Read these 
notes carefully. You will find them in the Safety section of this manual.

 Warning
Indicates important safety information.
Failure to respect these notes may lead to minor to moderate injury, or damage to 
the apparatus or equipment. Read these notes carefully. You will find them in the 
Safety section of this manual.

 Important
Indicates points to be read with special attention when using the device, and 
explanations of probable causes of paper jams, damage to originals or loss of 
data. Read these explanations carefully.

 Note
Indicates additional explanations about device functions, and instructions for 
resolving user errors.
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Presentation of the machine
Description of the machine

1 Automatic document feeder (ADF) 10 Main paper tray

2 Paper adjustment guide 11 On/Off button

3 Automatic document feeder 12 Master USB connector (USB key)

4 Original document output 13 Power cable connection

5 Access handle to flatbed scanner 14 LINE In - telephone cable connection

6 Touch screen 15 LAN connector

7 Paper outlet (Finisher not installed) 16 Slave USB connector (for PC)

8 Fingerprint reader 17 Finisher (optional)

9 Access trap to toner cartridges 18 Smartcard reader
- 6 -
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19 Paper reception stop 21 Manual feeder

20 Duplex module 22 Number pad
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Control panel description

 

Key Description

To access the machine's home screen

To activate the Send Fax function

To activate the Scan Document function

To activate the Copy Document function

To cancel the operation in progress
To exit a menu without saving the changes

To run the operation in progress (copy, fax emission, scanning):

 in colour

 in black and white

Light indicator

Machine status indicator:
green: standby
flashing orange: starting
red: failure
- 8 -
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Installation

Packaging contents

The packaging contains the components listed below:
• Multifunction printer
• Apron
• 1 installation guide
• 1 User manual CD-ROM
• 1 installation CD-ROM for PC
• 1 mains cable
• 1 telephone cable
• 1 consumable leaflet

Installing the machine

The machine is supplied in two boxes. Check the contents 
of each box.

1 Unpack the printer part and remove all protective 
spacers and adhesive tapes, as illustrated in the in-
stallation guide.

2 Install the printer in a suitable place respecting the 
safety instructions described in the section Safety 
[ 119].

3 Place the document output tray on the printer and 
remove the protective plastic film from the screen.

4 Remove the protective spacers inside the printer, 
as illustrated in the installation guide.

5 Unpack the scanner and remove all protective 
spacers and adhesive tapes, as illustrated in the in-
stallation guide.

6 Take hold of the scanner by the handles and place 
it on the printer, aligning the studs in their housing, 
as illustrated in the installation guide.

Installing options

Finisher

Consult the installation guide supplied with this option for 
installation instructions.

Additional paper tray

Consult the installation guide supplied with this option for 
installation instructions.

Perfume diffuser

The perfume unit is an option enabling you to install a 
perfume diffuser on the machine. When this option is 
installed and activated, the machine diffuses perfume 
every hour, and for a period of time defined by you.
Consult the installation guide supplied with this option for 
installation instructions.
To activate and configure this option, consult the section 
Perfume setting [ 25].

Memory extension

The machine is equipped with a 512 Mb RAM memory. It 
is possible to add a 256 Mb memory extension.
Before installing the memory extension, read carefully the 
instructions for antistatic protection.

Antistatic protection

• Firstly, switch off the machine by pressing the On/Off 
button (position 0) and disconnect the mains cable.

• Disconnect all cables connected to the machine.
• If you are wearing an antistatic bracelet, attach one of 

the straps to your wrist and the other to the bare metal 
frame located at the rear of the machine.
Never attach a strap to the machine when switched 
on.
Plastic, rubber, wood, painted metal surfaces and tel-
ephone jacks are not sufficient earthing materials.

• If you are not wearing an antistatic bracelet, discharge 
any static electricity from your body by touching a sur-
face connected to the earth before handling the board 
or any electronic components in the machine.
Try not to move around too much after earthing your-
self.Caution

Before installing any options, the machine 
and the option to be installed must be swit-
ched off and disconnected from the mains 
power supply.

WARNING

The machine's electronic board must be 
protected from any electrostatic damage 
that may be caused by handling.
- 9 -
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Installing the memory extension

To install the memory extension on the machine:
1 Press the On/Off button to switch off the machine 

(position 0) and disconnect the mains power cable.

2 Disconnect all cables connected to the machine.
3 Using a screwdriver, remove the screw from the 

rear cover and slide the cover to the right to remove 
it.

4 Using a screwdriver, loosen the seven screws with-
out removing them completely.

5 Slide the panel slightly to the right and lift to remove 
it.

6 Insert the memory extension into its connector, en-
suring it is straight, until the two locking pins click 
into place.

7 Replace the panel and tighten the seven screws.
8 Replace the rear cover and fix it in place with the 

screw.
9 Reconnect all cables to the machine.
If you are installing your machine for the first time, do 
not switch it on. First, complete the configuration and 
connection steps described in the sections below.

Otherwise, connect the power cable to the mains and 
press the On/Off button to switch the machine on (po-
sition I).

Once the memory extension has been installed:
1 Declare the additional RAM memory in the printer 

driver (Properties > Tab Configure).
2 Print out a configuration page and check that the 

total RAM capacity installed is shown.

WARNING

Firstly, consult the antistatic protection in-
structions (see Antistatic protection [ 9]).

Note

Locate the notch on the side of the memory 
extension and align it with the connector. If 
you cannot click the memory extension into 
place, do not force it. Reposition it, ensuring 
that its base is correctly inserted into the 
connector.
- 10 -
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Loading media

Loading paper into the main paper tray

1 Open the main paper tray.

2 Press the paper compression flap to lock it.

3 Load the sheets into the paper tray with the print 
surface facing up.

4 Make sure the paper does not exceed the fill limit.

5 Close the main paper tray.

6 Define the paper format and type used in the ma-
chine.

The machine automatically detects standard paper 
formats. To check / define the format and type of pa-
per loaded, consult the section Paper settings [ 26].

Loading paper into the manual feeder

1 Open the manual feeder.

Note

Before loading paper, consult the section 
Recommendations for paper [ 146].

Note

The tray can contain up to 500 sheets of 
standard paper (80g/m² [22lb]).
- 11 -
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2 Move the paper guides apart to the maximum.

3 Press the centre of the sheet compression flap until 
the locking tabs (white) on the right and left are re-
leased.

4 Load the sheets into the paper tray with the print 
surface facing up.

5 Make sure the paper does not exceed the fill limit.

6 Adjust the paper guides against the side of the pile.

7 Define the paper format and type used in the ma-
chine.

The machine automatically detects standard paper 
formats. To check / define the format and type of pa-
per loaded, consult the section Paper settings [ 26].

Loading envelopes into the manual feeder

1 Open the right side cover by pulling on the latch.

2 Turn the cursors on the fuser unit so that the enve-
lope symbol is selected.

Note

The tray can contain up to 100 sheets of 
standard paper (80g/m² [22lb]).
- 12 -
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3 Close the right side cover.

4 Open the manual feeder.

5 Move the paper guides apart to the maximum.

6 Press the centre of the sheet compression flap until 
the locking tabs (white) on the right and left are re-
leased.

7 Load the envelopes into the manual feeder

8 Adjust the paper guides against the sides of the en-
velopes.

9 Define the paper format and type used in the ma-
chine.

The machine automatically detects standard paper 
formats. To check / define the format and type of pa-
per loaded, consult the section Paper settings [ 26].

Note

The tray can contain up to 10 envelopes at 
the same time.
- 13 -
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Loading paper into the additional paper tray

1 Open the additional paper tray.

2 Press the paper compression flap to lock it.

3 Move the paper guides apart to the maximum.

4 Load the sheets into the paper tray with the print 
surface facing up.

5 Make sure the paper does not exceed the fill limit.

6 Adjust the paper guides against the side of the pile.

7 Close the additional paper tray.

8 Define the paper format and type used in the ma-
chine.

The machine automatically detects standard paper 
formats. To check / define the format and type of pa-
per loaded, consult the section Paper settings [ 26].

Note

The tray can contain up to 500 sheets of 
standard paper (80g/m² [22lb]).
- 14 -
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Starting up the machine

Connecting the machine

1 Connect one end of the telephone cable to the ma-
chine socket and the other to the wall telephone 
socket.

2 Connect one end of the LAN network cable (not 
supplied) to the machine port and the other to your 
local network port for the machine.

3 Ensure that the On/Off button is on Off (position 0).

4 Connect the mains cable to the machine. Connect 
the mains cable to the wall socket.

5 Press the On/Off button to switch the machine on 
(position I).

Initial configuration of the machine

After a few seconds, when the printer preheating phase is 
complete, the home screen is displayed.
In this section, you will find the initial settings to be 
configured to be able to use your machine's basic 
functions:
• geographic settings (country, language, communica-

tion network);
• date / time settings;
• fax settings (machine name and number);
• local network settings (automatic configuration of the 

Ethernet network);
• paper settings.

To configure the geographic settings:
1 Press the MENU key.
2 Press SETTINGS > GENERAL > 

GEOGRAPHICAL > COUNTRY.
3 Select the required country from the list. Use the up 

and down arrows to scroll through the available 
countries. Press OK to confirm the new setting.

Choosing the country automatically configures 
the machine's default language and the telecom-
munications network.

4 In the navigation path at the top of the screen, 
press GENERAL to return to the previous menu.

To set the machine’s date and time:
1 In the menu GENERAL, press DATE AND TIME.
2 Press TIME. Enter the time using the virtual key-

board. Press OK to confirm the new setting.
3 Press DATE. Enter the date using the virtual key-

board. Press OK to confirm the new setting.
4 In the navigation path at the top of the screen, 

press GENERAL to return to the previous menu.

WARNING

Before connecting the mains cable, you 
must consult the Safety Instructions [ 119].

WARNING

The mains cable is used to disconnect the 
machine from the power supply. As a pre-
caution, the mains power socket must be lo-
cated near the machine and easily 
accessible in the event of danger.

Note

This section will help you to first configure 
the machine, assuming the use of a direct 
telephone line on the PSTN network, and an 
Ethernet configuration via a DHCP server 
with automatic allocation of IP address.
Consult the section Configuring the 
machine and services [ 23] if you want to 
configure the machine differently.
- 15 -



MF 6990dn - Agoris C935

2 
- 

In
st

al
la

tio
n
To set the machine's number and name, required for the 

fax function:
1 In the menu GENERAL, press FAX.
2 Press PHONE NUMBER. Enter the number using 

the virtual keyboard. Press OK to confirm the new 
setting.

3 Press NAME. Enter the machine's name using the 
virtual keyboard. Press OK to confirm the new set-
ting.

4 In the navigation path at the top of the screen, 
press SETTINGS to return to the higher menu.

To run an automatic configuration of the Ethernet 
network (automatic allocation of the IP address via the 
DHCP server):

1 In the menu SETTINGS, press COMMUNICATION 
> LOCAL NETWORK > ADDR. ALLOCATION.

2 Select AUTOMATIC from the options available in 
the list. Press OK to confirm the new setting.

The machine will search for a DHCP or BOOTP 
server on the local network that can dynamically 
allocate its network settings.

This operation may take a few minutes.
3 Check that the parameters IP ADDRESS, 

SUBNET MASK, GATEWAY, PRIMARY DNS, 
SECONDARY DNS, WINS 1 SERVER et WINS 2 
SERVER are correctly entered. If this is not the 
case, you will have to configure them manually.

4 Press MENU to return to the home screen.
To check and / or specify the paper type and format  in 
each paper tray:

1 Press PAPER.
2 Press FORMAT. Check that the paper format de-

tected in each tray is correctly entered. To correct 
a paper format, press on the corresponding tray; 
select the required format from the list and press 
OK to confirm.

3 Press TYPE. Check that the paper type detected in 
each tray is correctly entered. To correct a paper 
type, press on the corresponding tray, select the re-
quired paper type from the list and press OK to 
confirm.

4 Press MENU to return to the home screen.
Consult the section Configuring the machine and services 
[ 23] for more available parameters, and to configure the 
machine according to your specific needs.
- 16 -
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Getting to know 

the machine
Please read this section carefully to get to know your 
machine.
In it you will find the operating principles required 
whatever function you are using.

Navigation principles

Using the buttons

Navigating through the machine's functions and menus is 
very intuitive.
The touch screen displays the functions, menus, actions 
and parameters in the form of buttons.
Just press on a button to open a menu and access the 
sub-menus, run an action or change a parameter.
A greyed-out button means the function or action is 
unavailable (depends on another deactivated setting, or 
an option not installed, etc.).

Virtual editor

When you press on a parameter to change it, the machine 
automatically displays a virtual editor: a number pad for 
entering figures (e.g.: fax number), an alphabetical 
keypad for entering text (e.g.: file name). Check boxes or 
lists are used for activating or selecting functions.
When changing a field, conventional text editing actions 
are available: delete the character before the cursor 
( ), move through the data field ( / ), switch from 
upper to lower case, or display / hide punctuation marks 
and special characters.
Whatever the modification to be made, the editor allows 
you to carry out the following:
• OK: confirm the modification
• CANCEL: cancel the modification

Screen scrolling

When a dedicated function (e.g. copy a document) or 
menu (e.g. create a contact in the address book) includes 
a series of parameters on several screens, the lower 
frame on the screen displays the button OTHER 
COMMANDS or OTHER PARAMETERS.
You can scroll through the screens by pressing the button 
OTHER COMMANDS or OTHER PARAMETERS.

Navigation path

To help know where you are in the menu arborescence, 
the upper frame of the screen displays the navigation 
path leading to the current menu. For example, to create 
a contact in the address book, the path is as follows:

1 Press the MENU key to display the home screen.
2 Press the ADDRESS BOOK button.
3 Press the CONTACTS button.
4 Press CREATE.
The upper frame displays the following navigation 
path: icon Home > ADDRESS BOOK > CONTACTS 
> CREATE.

Use the navigation path to find your way around the 
menus, but also to return to a previous menu or directly to 
the home screen, by pressing directly the required button:
• CONTACTS to return to the previous menu
• Home icon to return to the home screen, etc.
The procedures described in this document use the 
principles of the navigation path. Thus, access to the 
creation of a contact in the address book is described as 
follows:

1 Press the MENU key.
2 Select ADDRESS BOOK > CONTACTS > 

CREATE.
The parameters that can be changed are then presented 
one by one with a description of the required data and 
confirmation of the modifications.

Presentation of specific functions

The machine is equipped with special keys enabling you 
to access specific functions directly:

• : activates the send fax function.
In this mode, the machine displays by default the 
screen for entering a fax number. You can start to 
configure your fax emission.

• : activates the scan and send document 
function.
In this mode, the machine displays by default the 
screen to select a Scan to function. Once selected, 
you can start to configure how your document is sent.

• : activates the copy document  function.
In this mode, the machine displays by default the 
screen for entering the number of copies to make. 
You can start to configure how your document is cop-
ied.

The backlit key identifies the mode activated on the 
machine.
Refer to the specific chapters for these functions for more 
information on how they work and tips for using them:
• Photocopying documents [ 47]
• Faxing documents [ 51]
• Scanning and sending documents [ 64]
- 17 -
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Presentation of the home screen and 

menus

The home screen allows you to access:
• machine configuration utilities and menus
• monitoring of operations and communications in 

progress
• warning and error messages
The machine displays the home screen either:
• by pressing the MENU key
• by pressing the Home icon in the navigation path
• or when a specific function is running, to display the 

current operation progress (document being scanned, 
fax being sent, etc.)

The home screen displays the available menus in the left 
and right frames. The central frame displays the current 
operations and warning or error messages in the form of 
buttons.

Configuration utilities and menus

The home screen allows you to access the following 
configuration utilities and menus:

 

Button Description

LANGUAGE The administrator can define two 
favourite languages to display 
the machine menus.
Press this button to switch from 
one language to the other.

PRINT QUEUE The print queue contains 
documents that are awaiting to 
be printed and currently being 
printed.
For more information, consult 
the section Print monitoring 
[ 58].

USB KEY This menu is specially for a USB 
key and is only accessible when 
a USB key is inserted in the 
machine.
For more information, consult 
the section Using a USB 
memory key [ 60].

SETTINGS This menu allows you to access 
the machine's configuration 
parameters.
For more information, consult 
the section Configuring the 
machine and the services [ 23].

ADDRESS BOOK Press this button to access the 
machine's address book and 
manage contacts and contact 
lists.
For more information, consult 
the section Address book [ 72].

PAPER Use this menu to check or 
specify paper formats and types 
loaded in the machine's paper 
trays.
For more information, consult 
the section Paper settings 
[ 26].

CONSUMABLES This utility allows you to check 
the status of the machine's 
consumables.
For more information, consult 
the section Consumable status 
[ 42].

STATUS This menu includes the 
hardware and software 
information for the machine, for 
use in the event of technical 
intervention.
For more information, consult 
the section Hardware and 
software information [ 42].

REPORTS This menu allows you to access 
report printing (function guide, 
consumable status, activity 
counters, current settings, 
address book entries, existing 
user accounts, prints to be 
released, installed fonts and 
communications log).

SEND QUEUE The emission queue contains all 
the documents that are awaiting 
emission and currently being 
sent (faxes, sent by the local 
network, etc.).
For more information, consult 
the sections Monitoring fax 
emissions [ 54] and Monitoring 
document emissions [ 70].

INTERNET The administrator can configure 
the machine to connect to the 
internet via the telephone line.
This menu allows you to 
manually force a connection in 
order to:

send / receive emails;
authorise technical support to 
take control of the machine 
(see Remote reading and 
maintenance [ 40])

Button Description
- 18 -
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Monitoring of operations and 
communications in progress

The operations and communications in progress are 
displayed in the central frame of the home screen in the 
form of buttons.
Sending a fax is thus represented by a button labelled Fax 
emission, receiving a fax by a button labelled Fax 
reception, etc.
To help you identify the operations and communications 
in progress, the possible labels are as follows:

 

To check or consult the operation data, just press the 
corresponding button. A detailed description window is 
displayed on the screen. In the event of simultaneous 
actions, a selection list allows you to choose the operation 
you require.
Once the operation or communication is complete, the 
corresponding button disappears.
If a communication could not be completed and requires 
sending again, the button disappears but the emission 
request is reallocated to the emission queue for 
subsequent emission.

To cancel the operation in progress, press the  key. A 
confirmation message is displayed.

Warning and error messages

When there is a problem on the machine, a warning 
window is automatically displayed on the screen, with a 
detailed description of the problem encountered.
Depending on the gravity of the problem, you should act 
immediately to correct it (paper jam, empty paper tray, 
etc.), or confirm that you acknowledge the warning (toner 
nearly out).
If you ignore the message by closing the window or if the 
touch screen is not touched for several seconds, the 
warning or error window closes. However, it is recorded in 
the central frame of the home screen in the form of a 
button.
The label is used to rapidly identify the nature of the 
problem (e.g.: paper jam). A colour code is used to 
identify the gravity of the problem:
• red: a serious error has occurred, rendering one or 

more machine functions unusable. You must resolve 
the incident immediately (e.g.: paper jam, paper out, 
cover open, toner out).

• orange: a minor problem has occurred. You must re-
solve the incident as soon as possible (e.g.: toner 
nearly out).

To consult the warning message or error, just press the 
corresponding button. A detailed description window is 
displayed on the screen.

IDENTIFICATION The administrator may restrict 
access to certain machine 
functions.
In this case, only authorised 
users can use the restricted 
functions after they have 
identified themselves correctly.
This menu allows you to access 
the options in your user account.
For more information, consult 
the section Logging in on the 
machine [ 21].

Label Action in progress

COPY Photocopy in progress.

FAX SCAN Document scanning in progress 
before fax emission.

PC SCAN Document scanning in progress 
before sending to a computer 
(Scan to PC function).

SENDING 
FAX

Fax emission in progress on the 
telephone line.

FAX 
RECEPTION

Fax reception in progress on the 
telephone line.

SENDING 
MAIL

Email emission in progress.

MAIL 
RECEPTION

Email reception in progress.

PC PRINT Document printing in progress 
sent from a computer.

FAX PRINT Printing in progress of a fax or 
email received.

PRINT 
REPORT

Printing in progress automatically 
generated by the machine 
(emission report, communication 
log) or launched by a user from 
the machine menu (printing of 
function guide, address book, 
settings, etc.).

Button Description

KEY SCAN Analysis in progress of the 
content of a USB key inserted in 
the machine.

Label Action in progress
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Inserting original documents

The instructions for inserting original documents are the 
same for copies, faxes or scanned documents.

Using the flatbed scanner

Accepted formats
The format of documents for scanning should respect the 
following conditions:
• Maximum length: 299 mm.
• Maximum width: 219 mm.
Inserting the document

1 Open the cover of the flatbed scanner.
2 Place your document with the side to be copied 

face down on the window respecting the indica-
tions around the window.

3 Close the cover of the flatbed scanner.

Using the autofeed scanner

The autofeed scanner enables you to scan original 
documents comprising one or several sheets. You can 
place up to 70 sheets of 80 g/m² in the automatic feeder.
Accepted formats
A5, A4, Letter, Legal or any other format respecting the 
following conditions:
• Length between 140 mm and 358 mm.
• Width between 139 mm and 219 mm.
• Weight between 60 and 105 g/m².
Recommendations for use
• Do not load documents of different sizes or weights.
• Remove staples or paper clips before inserting docu-

ments in the automatic feeder.
• Do not insert the following types of documents:

– Creased or folded paper.

– Torn paper.

– Corrugated paper

Inserting the document
1 Move the paper guides apart to the maximum.
2 Insert your document in the automatic feeder, side 

to be copied facing upwards.
3 Adjust the paper guides against the document.

4 Set the limit stop on the output tray for scanned 
documents to the size of the original document.

Using the Multiple Scan option correctly

To meet your scanning needs, the Scan to functions 
allow you to "add" and group pages from several 
documents in the same emission.
Activating the Multiple Scan option is especially useful in 
the following cases:
• you are using the autofeed scanner and your docu-

ment is voluminous. The number of pages exceeds 
the capacity of the document feeder (70 pages 80 g/
m²), but you want the recipient to receive a single file.

• you are using the flatbed scanner and your document 
contains several pages that you want to scan one after 
the other so that the recipient receives a single file.

• you want to use the flatbed scanner and the autofeed 
scanner to scan different pages, but you want the re-
cipient to receive a single file.
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Use the following table to know how to configure and use 
the Multiple Scan option.

 

Logging in on the machine

Depending on the machine configuration, access to 
functions may require logging in with a user code or by 
fingerprint reading. This information is defined in your 
user account by the machine administrator.
For your login information and user rights attributed to 
you, consult your machine administrator.
When a function (e.g.: colour copy, black and white scan, 
etc.) or access to a function requires authorisation, a login 
screen is displayed.
To login in under your user account:
• enter your 4-figure user code using the virtual key-

board or the keypad.
• if you have recorded your fingerprint in your user ac-

count (see Personalising your user account / 
fingerprint [ 22]), place your reference finger on the 
fingerprint reader and slide it slowly downwards.

When identification is successful, the machine allows you 
to access the function requested or performs the action in 
progress.
If identification fails, the machine displays an explanatory 
message (insufficient rights, unknown account, etc.). In 
this case, consult your machine administrator to check the 
validity of your identification.

Logging in or out of your user account

When the use of or access to a function requires rights, 
the machine displays the identification screen. If the 
machine is unused for a certain time, defined by the 
security level in your user account, you are automatically 
logged out.
However, you may manually force the connection or 
disconnection from your user account.
To login manually:

1 Press MENU.
2 Press [OTHER COMMANDS] > IDENTIFICATION 

> LOGIN.
The machine displays the identification screen.

To log out manually:
1 Press MENU.
2 Press [OTHER COMMANDS] > IDENTIFICATION 

> LOG OFF.
The machine disconnects you from your user ac-
count.

Setting Description

NO Multiple Scan deactivated.
The machine operates a single 
scanning operation.
Before sending, the machine checks 
for the presence of paper in the 
document feeder.

If a document is detected, the scan 
is launched from the autofeed 
scanner.
If no document is present in the 
document feeder, the scan is 
launched from the flatbed scanner.

Once the scan is complete, the 
machine sends the document.

YES Multiple Scan activated.
The machine allows you to repeat 
the scanning operations, and scan 
several groups of documents.
Before sending, the machine checks 
for the presence of paper in the 
document feeder.

If a document is detected, the scan 
is launched from the autofeed 
scanner.
If no document is present in the 
document feeder, the scan is 
launched from the flatbed scanner.

Once the scan is complete, a 
message is displayed asking you to 
accept or refuse scanning of 
additional pages.

1 Recover the previously 
scanned document.

2 Place the next document in the 
scanner of your choice.

3 Accept the additional scan.
4 Once the document scan is 

complete, refuse the scanning 
of additional pages.

The machine then sends the 
scanned document.
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Personalising your user account / 
fingerprint

Your user account is created by the machine 
administrator, who will inform you of your 4-figure user 
code.
You can personalise some information:

 

To personalise your user information:
1 Press MENU.
2 Press [OTHER COMMANDS] > IDENTIFICATION 

> PERSON. DATA.
The machine displays the identification screen.

3 Enter your 4-figure user code using the virtual key-
board or the keypad.

The consultable / customisable information in 
your user account appears on the screen.

4 To personalise your user account name, press 
NAME. Enter the name using the virtual keyboard. 
In the event of an error, use the  key to delete 
a character. Press OK to confirm.

5 To enter your email address, press EMAIL 
ADDRESS Enter your email address using the vir-
tual keyboard. In the event of an error, use the 

 key to delete a character. Press OK to con-
firm.

6 To enter your fingerprint, press FINGERPRINT 
Place the finger you will always use, your reference 
finger, on the fingerprint reader and slide it slowly 
downwards. The machine informs you when the 
option is successful.

If you have entered your email address, the ma-
chine automatically sends you your fingerprint.

7 When you have made the modifications, press 
MENU to return to the home screen.

Information Description

Code The 4-figure code for your user 
account. This code is unique and 
personal.
Note: only the administrator can 
modify the user code.

Name This information is optional, and 
may be useful to rapidly identify 
your work, especially in the print 
queue.

Email 
Address

Enter your email address if you 
wish to receive your fingerprint by 
email. You may then send 
documents securely from your 
computer for printing by attaching 
your fingerprint (see Secure 
printing [ 57]).
Each time your email is changed, 
the machine automatically sends 
you your fingerprint if it is 
recorded.

Fingerprint This action allows you to record 
the fingerprint of one of your 
fingers (reference finger), and use 
this identification method on the 
machine.
Note: you are free to use either 
your 4-figure user code or your 
fingerprint to identify you.
If you have entered your email 
address, the machine 
automatically sends you your 
fingerprint.
Each time your fingerprint is 
changed, the machine 
automatically sends you the 
updated fingerprint if you have 
entered your email address.
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Configuring the 

machine and the 
services
User rights

Printing out the guide to functions

Print out the guide to functions to familiarize yourself with 
the machine's available functions and the structure of the 
menus.
To print out the guide to functions:

1 Press MENU.
2 Select REPORTS > GUIDE.
The machine prints out the guide to functions.

Remote configuration

You can configure and consult the same parameters 
remotely as those used locally.
Prerequisites 
To be able to remotely configure the terminal, you should: 
• have a web browser on your PC (Internet Explorer ver-

sion 5 or later for optimal operation).
• define the parameters of the machine's local network - 

IP address, local address filter, etc. (see Network 
characteristics [ 35]).

Accessing the integrated web server
1 Open a browser with the PC that is registered on 

the network.
2 Enter the machine's IP address in the address field 

and confirm by pressing Enter.
3 When the home page opens, select the interface 

language.
4 Change the required parameters on the screen and 

confirm.
User rights

If user rights management is activated, and if access to 
the web server is restricted only to authorized user 
accounts:
• the site will only accept a maximum of 5 users con-

nected at once.
• the site will only accept 1 active session per user con-

nected.
• some operations may be cancelled if they are already 

being executed by another connected user.

General settings

Date/Time Settings

Setting the date and the time

At any time, you can edit the machine's date and time.
1 Press MENU.
2 Select SETTINGS > GENERAL > DATE AND 

TIME.
3 Select TIME to set the machine time.
4 Enter the time using the virtual keyboard. Use the 

 and  keys to pass from one character to the 
next. In the event of an error, use the  key to 
delete a character. Press OK to confirm the new 
setting.

5 Select DATE to set the machine date.
6 Enter the date using the virtual keyboard. Use the 

 and  keys to pass from one character to the 
next. In the event of an error, use the  key to 
delete a character. Press OK to confirm the new 
setting.

7 Press MENU to return to the home screen.

Personalizing the date and time format

You can modify the display format of the date and time to 
your needs.

1 Press MENU.
2 Select SETTINGS > COMFORT > DATE / TIME.
3 Select TIME FORMAT.
4 Select the required format from the list. Press OK 

to confirm the new setting.
5 Select DATE FORMAT.
6 Select the required format from the list. Use the up 

and down arrows to scroll through the available for-
mats. Press OK to confirm the new setting.

7 Press MENU to return to the home screen.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

The date and the time can be set automati-
cally if an SNTP server is present on the 
network. For more information, consult the 
section Configuring the SNTP server [ 37].
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Setting winter / summer time

You can activate automatic management of winter and 
summer time. The time will be changed automatically on 
the last Sunday in March for the switchover to summer 
time (+1hr) and the last Sunday in October for the 
switchover to winter time (-1hr).
To activate the automatic time change:

1 Press MENU.
2 Select SETTINGS > COMFORT > DATE / TIME.
3 Press AUTO ADJUST.
4 Select the required status from the list. Press OK to 

confirm the new setting.
5 Press MENU to return to the home screen.

Defining the time zone

To define the time zone:
1 Press MENU
2 Select SETTINGS > COMFORT > DATE / TIME.
3 Press TIME ZONE.
4 Select the time zone from the list. Use the up and 

down arrows to view all available time zones.
5 Press OK to confirm the new setting.
6 Press MENU to return to the home screen.

Geographic Settings

These parameters enable you to use your machine in the 
various pre-configured countries and in various 
languages.

Defining the country

By choosing a country, the following are reset:
• the public telephone network parameters;
• the machine's default language;
• the type of virtual keyboard;
• the display format for the date and time.
To define the country:

1 Press MENU.
2 Select SETTINGS > GENERAL > 

GEOGRAPHICAL > COUNTRY.
3 Select the required country from the list. Use the up 

and down arrows to scroll through the available 
countries. Press OK to confirm the new setting.

4 Press MENU to return to the home screen.

Defining the telecommunication network

This parameter enables you to specify manually the type 
of public telephone network for a country, so that your 
machine can communicate on the public telephone 
network of the selected country in accordance with the 
standards in force.
By default, when configuring a country, the type of public 
telephone network to be used in the country concerned is 
defined automatically.

1 Press MENU.

2 Select SETTINGS > GENERAL > 
GEOGRAPHICAL > PHONE TYPE.

3 Select the required option from the list. Use the up 
and down arrows to scroll through the available op-
tions. Press OK to confirm the new setting.

4 Press MENU to return to the home screen.

Defining the language

You can define two favourite languages to display the 
machine menus. To choose these two languages from the 
home screen, press LANGUAGE.
By default, when configuring the country, the preferred 
languages are defined automatically.

1 Press MENU.
2 Select SETTINGS > GENERAL > 

GEOGRAPHICAL > FIRST LANGUAGE.
3 Select the required language from the list. Use the 

up and down arrows to scroll through the available 
options. Press OK to confirm the new setting.

4 Press SECOND LANGUAGE.
5 Select the required language from the list. Use the 

up and down arrows to scroll through the available 
options. Press OK to confirm the new setting.

6 Press MENU to return to the home screen.

Defining the virtual keyboard

This parameter is used to define the type of virtual 
keyboard to be displayed on the screen depending on the 
country where the machine is used.
By default, when configuring the country, the type of 
virtual keyboard is automatically defined.

1 Press MENU.
2 Select SETTINGS > GENERAL > 

GEOGRAPHICAL > KEYBOARD.
3 Select the required country from the list. Press OK 

to confirm the new setting.
4 Press MENU to return to the home screen.

Ergonomics

Energy saving

This function is used to activate machine standby when it 
is not in use. The time to switch the machine to standby 
can be immediate or several minutes according to your 
needs.

1 Press MENU.
2 Select SETTINGS > COMFORT > ENERGY 

SAVING.
3 Press TIMEOUT.
4 Select the required option from the list. Press OK to 

confirm the new setting.
5 If you have selected PROGRAMMING, enter the 

parameters START TIME and END TIME with the 
start and end times of the standby time range. 
Press OK to confirm the new setting.

6 Press MENU to return to the home screen.
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Toner saving

This parameter is used to reduce the quantity of toner 
consumer by the machine's "internal" print-outs.
Internal print-outs mean print-outs regarding machine 
activity and include the following information: emission/
reception reports, communication logs, activity counters, 
print-out of the guide to functions, machine settings, user 
accounts, the print queue, etc.
The following options are available:

 

To activate toner saving printing:
1 Press MENU.
2 Select SETTINGS > COMFORT.
3 Press TONER SAVE.
4 Select the required option. Press OK to confirm the 

new setting.
5 Press MENU to return to the home screen.

Return to the previous function

1 Press MENU.
2 Select SETTINGS > COMFORT > RETURN 

FUNCTION.
3 Select the required option from the list. Press OK to 

confirm the new setting.
 

4 Press MENU to return to the home screen.

Perfume Setting

The perfume unit is an option enabling you to install a 
perfume diffuser on the machine. When this option is 
activated, the machine diffuses perfume every hour, and 
for a period of time defined by you.
By default, the machine does not recognize the perfume 
unit installed (set in WITHOUT).
To activate this option, you just need to configure the 
setting PERFUME to the diffusion length of your choice.
Note that the longer the diffusion time, the more the 
perfume is pronounced, and the shorter the lifespan of the 
perfume unit.

1 Press MENU.
2 Select SETTINGS > COMFORT > PERFUME.
3 Select the required option from the list. Press OK to 

confirm the new setting.
 

4 Press MENU to return to the home screen.

Default world

This parameter allows to define the default active function 
of the machine (Fax, Copy or Scan To). The idle screen 
of the function is displayed when one key of the control 
panel is pressed.

1. Press MENU.

2. SETTINGS > COMFORT > DEFAULT WORLD.

3. Select the required option from the list. Press OK to
confirm the new setting.

4. Press MENU to return to the home screen.

Option Description

WITHOUT Printing with toner saving is 
deactivated.

WITH The quantity of toner used is 
reduced. The print-outs are 
lighter.

WITHOUT 
COLOUR

Printing is in black and white.

Option Description

WITHOUT At the end of a user operation, the 
machine returns to the home 
screen.

MODERATE The machine returns to the home 
screen after the machine has not 
been used for a few minutes.

ALWAYS The machine displays the settings 
screen for the last function used 
(copy, fax, scanning).

Option Description

WITHOUT The perfume unit option is 
deactivated.

LOW The perfume unit option is 
activated, with a low diffusion 
time.

MODERATE The perfume unit option is 
activated, with a moderate 
diffusion time.

HIGH The perfume unit option is 
activated, with a high diffusion 
time.
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Paper settings

The machine automatically detects standard paper 
formats. You may however use this setting to check and/
or specify the paper type and format in each paper tray.

Defining the paper format

1 Press MENU.
2 Select PAPER > FORMAT.
3 Define the paper format for each tray on the ma-

chine. To select the right format of paper to use, 
consult the section Which paper formats can be 
used [ 146].

 

4 Press MENU to return to the home screen.

Defining the paper type

1 Press MENU.
2 Select PAPER > TYPE.
3 Define the paper type for each tray on the machine. 

To select the right type of paper to use, consult the 
section Recommendations for paper [ 146].

 

4 Press MENU to return to the home screen.

Scanner / Printer Settings

Scanner / Printer paper format

The paper format defined in this menu becomes the 
default format of the main printing paper tray and the 
flatbed scanner.

1 Press MENU.
2 Select SETTINGS > SCANNER/PRINTER > 

PAPER FORMAT.
3 Select the required format from the list: A4 or LET-

TER. Press OK to confirm the new setting.
4 Press MENU to return to the home screen.

Adjusting Scanner / Printer margins

If you notice an offset between the printer and the 
scanner, correct the margins (expressed in pixels) 
according to the reference paper specified in SETTINGS 
> SCANNER/PRINTER > PAPER FORMAT.
To correct and adjust the scanner / printer margins:

1 Press MENU.
2 Select SETTINGS > SCANNER/PRINTER > 

ADJUSTMENTS.
3 Make the necessary adjustment(s).

 

4 Press MENU to return to the home screen.

To define the paper 
format... then...

in the main tray 1 Press TRAY 1.
2 Select the required 

format from the list.
3 Press OK to confirm.

on the additional tray(s) 1 Press TRAY 2 or 
TRAY 3.

2 Select the required 
format from the list.

3 Press OK to confirm.

To define the paper 
type then...

in the main tray 1 Press TRAY 1.
2 Select the required pa-

per type from the list.
3 Press OK to confirm.

on the manual feeder. 1 Press MANUAL 
TRAY.

2 Select the required pa-
per type from the list.

3 Press OK to confirm.

on the additional tray(s) 1 Press TRAY 2 or 
TRAY 3.

2 Select the required pa-
per type from the list.

3 Press OK to confirm.

Setting Description / Procedure

Printer top margin Press TOP PRINTER.
Enter an offset value of between 
-100 and +100.
Press OK to confirm.

Printer left margin Press LEFT PRINTER.
Enter an offset value of between 
-100 and +100.
Press OK to confirm.

Flatbed scanner 
top margin

Press TOP FB SCANNER.
Enter an offset value of between 
-100 and +100.
Press OK to confirm.

Flatbed scanner 
left margin

Press LEFT FB SCANNER.
Enter an offset value of between 
-100 and +100.
Press OK to confirm.

Autofeed scanner 
top margin

Press TOP ADF SCANNER.
Enter an offset value of between 
-100 and +100.
Press OK to confirm.

Autofeed scanner 
left margin

Press LEFT ADF SCANNER.
Enter an offset value of between 
-100 and +100.
Press OK to confirm.
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PC printing parameters

To personalize PC printing parameters:
1 Press MENU.
2 Select SETTINGS > SCANNER/PRINTER > PC 

PRINT.
3 Make the necessary adjustment(s).

 

4 Press MENU to return to the home screen.

Default paper tray

This parameter allows to define the default paper tray of 
the machine. All printing operations on the machine will 
use this tray (Copy, fax reception, printing report,...). The 
machine never switches to another tray except for PC 
printing requirement. In this case, the user can choose 
another tray from the printing driver.
To define the default paper tray:

1 Press MENU.
2 Select SETTINGS > SCANNER/PRINTER > 

PAPER TRAY.
3 Select the required option from the list. Press OK to 

confirm the new setting.
 

4 Press MENU to return to the home screen.

Parameters Description / Procedure

TONER SAVE Lightens printing to save toner 
cartridge ink.

TASK DELAY Waiting time for data from the 
PC before the PC print task is 
cancelled.

FONTS This parameter is used to draw 
up the set of symbols. The 
possible values are between 
CS1 and CS30 included. The 
default value is CS1 (Roman8).

FONT NUMBER Start printing the list of fonts. 
This parameter can be used to 
set the default PCL font. The 
possible values are between 1 
and 77 included. The default 
value is 1.

LINES PER PAGE This parameter is used to set the 
number of lines per page.
This variable is linked to the PJL 
variables: PAPER and 
ORIENTATION. If you change 
one of these variables, the Line 
format variable is automatically 
updated (only for the current 
print task) in order to respect the 
same spacing.
The possible values are 
between 5 and 128 included. 
The default value is 60.

FONT SPACING This parameter is used to set the 
default font spacing in 
characters per inch (the default 
font must be non-proportional).
The possible values are 
between 0.44 and 99.99 
included. The default value is 
10.00.

FONT SIZE This parameter is used to set the 
default font height, in points (the 
default font must be 
proportional). The possible 
values are between 4.00 and 
999.75 (in intervals of 0.25). The 
default value is 12.00.

ORIENTATION This parameter is used to set the 
page orientation: portrait or 
landscape. The default value is 
"portrait".

Parameters Description

AUTOMATIC Tray 1 is used by default, then 
tray 2, then tray 3 and tray 4.

TRAY 1 Tray 1 is used for all operations 
performed on the machine. The 
machine never switches to 
another tray except for PC 
printing requirement.

TRAY 2 Tray 2 is used for all operations 
performed on the machine. The 
machine never switches to 
another tray except for PC 
printing requirement.

TRAY 3 
(if installed)

Tray 3 is used for all operations 
performed on the machine. The 
machine never switches to 
another tray except for PC 
printing requirement.

TRAY 4 
(if installed)

Tray 4 is used for all operations 
performed on the machine. The 
machine never switches to 
another tray except for PC 
printing requirement.
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Fax Settings

Defining the machine name and number

Your machine enables you to print the saved number and 
name on all faxes emitted.

Defining the machine name

To record the name of the machine:
1 Press MENU.
2 Select SETTINGS > GENERAL > FAX > NAME.
3 Enter the machine's name using the virtual key-

board. Use the  and  keys to pass from one char-
acter to the next. In the event of an error, use the 

 key to delete a character. Press OK to con-
firm the new setting.

4 Press MENU to return to the home screen.

Defining the machine number

To record the number of the machine:
1 Press MENU.
2 Select SETTINGS > GENERAL > FAX > PHONE 

NUMBER.
3 Enter the number using the virtual keyboard. Use 

the  and  keys to pass from one character to the 
next. In the event of an error, use the  key to 
delete a character. Press OK to confirm the new 
setting.

4 Press MENU to return to the home screen.

Fax emission settings

Local prefix

This function is used when your machine is installed in a 
private network, behind a company telephone 
switchboard. It enables you to set automatic dialling of a 
local prefix (to be defined), allowing the call to leave the 
company telephone network, on the condition that:
• the company extension numbers, for which the prefix 

is useless, are short numbers less than the minimum 
length (for example 10 digits in France). 

• the external numbers, for which the prefix is obligatory, 
are long numbers greater than or equal to the mini-
mum length (for example 10 digits in France).

There are two steps for configuring the machine's local 
prefix:

1. define the minimum (or equal) length for telephone
numbers outside the company;

2. define the local prefix for a line outside the company
telephone network. This prefix will be automatically
added when a number outside the company is di-
alled.

Prefix length

To define the length of the local prefix:
1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

TRANSMISSION > PREFIXES.
3 Press LENGTH.
4 Enter the length of the local prefix (between 1 and 

10) using the virtual keyboard. Use the  and  
keys to pass from one character to the next. In the 
event of an error, use the  key to delete a char-
acter. Press OK to confirm the new setting.

5 Press MENU to return to the home screen.

Fax prefix

To define the fax prefix:
1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

EMISSION > PREFIXES.
3 Press VALUE.
4 Enter the local prefix (maximum 10 characters) us-

ing the virtual keyboard. Use the  and  keys to 
pass from one character to the next. In the event of 
an error, use the  key to delete a character. 
Press OK to confirm the new setting.

5 Press MENU to return to the home screen.

Prefix for fax server

If you configure the machine to send faxes via a fax 
server, you can specify in this menu the outside prefix 
required for the fax server (see Configuring the fax server 
(optional) [ 32]).
To define the prefix for the fax server:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

TRANSMISSION > PREFIXES.
3 Press FAX SERVER.
4 Enter the local prefix for the fax server using the vir-

tual keyboard. Use the  and  keys to pass from 
one character to the next. In the event of an error, 
use the  key to delete a character.

5 Press OK to confirm the new setting.
6 Press MENU to return to the home screen.

Note

To use this function, you must set the para-
meter HEADER on YES (see Advanced fax 
emission settings [ 29]).

Note

If you define a local prefix, do not insert it in 
the numbers saved in the address book: it 
will be added automatically to each number.
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Emission report

You can print out an emission report for communications 
made via the telephone network.
You can choose between several criteria for printing out 
emission reports:
• WITH : a report is printed when the emission was suc-

cessful or when it is definitively abandoned (but there 
is only one report per emission request);

• WITHOUT: no emission report, but the machine 
records all emissions made in its emissions log;

• SYSTEMATIC: a report is printed at each emission at-
tempt;

• ON FAILURE: a report is printed only when the emis-
sion attempts have ended in failure and the emission 
request is definitively abandoned.

A reduced image of the first page of the document is 
automatically associated with each emission report.
To select the type of report:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

TRANSMISSION > REPORT.
3 Select the required report type from the list. Press 

OK to confirm the new setting.
4 Press MENU to return to the home screen.

Fax TX forwarding

This function is used to set the machine to send a copy of 
any document sent (by fax or to an email address) to 
another recipient. The recipient should be chosen from 
the entries in the machine's address book. It may be a fax 
number, an email address or an FTP address.

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

TRANSMISSION > COPY.
3 Press ACTIVATION.
4 Select the required option from the list. Press OK to 

confirm the new setting.
5 Press RECIPIENT.
6 Select the required recipient from the entries in the 

address book. Press OK to confirm the new setting.
7 Press MENU to return to the home screen.

Advanced fax emission settings

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

TRANSMISSION > ADVANCED.
3 To configure the advanced fax emission settings, 

use the table below:

 

Note

Check that the recipient exists in the 
address book (see Address book [ 72]).

Parameter Description / Procedure

Emission heading If this function is active, all 
documents received by your 
correspondents will be printed 
with  heading containing your 
name, number, the date and 
the number of pages.
Important: If you send a fax 
from a document feeder, the 
emission heading will not 
appear on the document 
received by your 
correspondent.
To change the setting:

1 Press HEADER.
2 Select the required sta-

tusfrom the list.
3 Press OK to confirm the 

new setting.

Emission speed Emission speed of outgoing 
documents.
If the quality of the telephone 
line is good (suitable, without 
echo), calls are usually made 
at maximum speed. 
However, it may be necessary 
to limit the emission speed for 
certain communications.
To change the emission 
speed:

1 Press SPEED.
2 Select the required val-

ue from the list.
3 Press OK to confirm the 

new setting.

Anti echo If this function is active, the 
line echo in long distance 
communications will be 
attenuated.
To change the status of the 
Anti echo parameter:

1 Press ANTI ECHO.
2 Select the required sta-

tus.
3 Press OK to confirm the 

new setting.

Overseas For some long distance calls 
(satellites), the line echo may 
make communication difficult.
To change the status of the 
Overseas parameter:

1 Press OVERSEAS.
2 Select the required sta-

tus.
3 Press OK to confirm the 

new setting.
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4 Press MENU to return to the home screen.

Fax reception settings

Print settings for received faxes

Secure printing of received faxes

By default, the machine is configured to print all 
documents received automatically.
However, you may configure the machine to keep 
confidential faxes in the memory and not print them out 
systematically on reception.
To configure secure printing of faxes received:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

RECEPTION > PRINT.
3 Press HELD PRINT.
4 Select the required status from the list. Press OK to 

confirm the new setting.
5 Press MENU to return to the home screen.

When secure printing of faxes received is active, users 
wishing to recover a document in the memory must 
manually force printing from the machine's print queue 

(see Printing received faxes in the memory [ 54]).

Number of copies

You can print several copies (1 to 99) of documents 
received.
To set the number of copies of each document received:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

RECEPTION > PRINT.
3 Press NUMBER OF COPIES.
4 Enter the number of copies to be printed by the ma-

chine for each document received. Press OK to 
confirm the new setting.

5 Press MENU to return to the home screen.

Printing with toner saving 

This parameter is used to reduce the quantity of toner 
consumed when printing received documents.
To activate toner saving printing:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

RECEPTION > PRINT.
3 Press TONER SAVE.
4 Select the required status from the list. Press OK to 

confirm the new setting.
5 Press MENU to return to the home screen.

Duplex printing

This parameter is used to activate duplex printing of 
documents received.
To activate duplex printing:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

RECEPTION > PRINT.
3 Press DUPLEX.
4 Select the required option. Press OK to confirm the 

new setting.
5 Press MENU to return to the home screen.

Binding 

If you have configured duplex printing of documents 
received, you can define the type of binding of printed 
sheets (see Binding [ 47]).
To configure the type of binding:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

RECEPTION > PRINT.
3 Press BINDING EDGE.
4 Select the required option. Press OK to confirm the 

new setting.
5 Press MENU to return to the home screen.

Number of call 
backs

Number of attempts to be 
made by the machine if 
emission fails.
To change the number of call 
backs:

1 Press ATTEMPTS 
NUMBER.

2 Enter the number of call 
backs the machine 
should make using the 
virtual keyboard.

3 Press OK to confirm the 
new setting.

Interval between 
call backs

Time between two machine 
call back attempts.
To change the time between 2 
call backs:

1 Press ATTEMPT TIME.
2 Enter the time between 

2 call back attempts 
made by the machine 
using the virtual key-
board.

3 Press OK to confirm the 
new setting.

Note

Some parameters also apply to printing of 
received emails.

Parameter Description / Procedure
- 30 -



MF 6990dn - Agoris C935

4 
- 

C
on

fig
ur

in
g 

th
e 

m
ac

hi
ne

 a
nd

 th
e 

se
rv

ic
es
Printing of images

This parameter is used to define the print format of image 
files (JPEG) inserted as attachments in received emails.
The print formats are as follows:

 

To specify the print format of photos received:
1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

RECEPTION > PRINT.
3 Press IMAGE SIZE.
4 Select the required option. Press OK to confirm the 

new setting.
5 Press MENU to return to the home screen.

Selecting the paper tray

This parameter is used to specify the paper tray to be 
used to print out received documents.
To select the paper tray:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

RECEPTION > PRINT.
3 Press PAPER OUTPUT.
4 Select the required option. Press OK to confirm the 

new setting.
5 Press MENU to return to the home screen.

Finishing options

If you have installed a finisher on the machine, this 
parameter is used to specify the finishing options for 
printing received documents.
The finishing options are as follows:

 

To select the finishing options for printing received 
documents:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

RECEPTION > PRINT.
3 Press OUTPUT FINISHING.
4 Select the required option. Press OK to confirm the 

new setting.
5 Press MENU to return to the home screen.

Selecting the paper type

This parameter is used to specify the type of paper to be 
used to print out received documents, in accordance with 
the paper loaded in the paper tray defined as the output 
tray (see Selecting the paper tray [ 31]).
To select the type of paper:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

RECEPTION > PRINT.
3 Press PAPER TYPE.
4 Select the required option. Press OK to confirm the 

new setting.
5 Press MENU to return to the home screen.

Fax or PC reception mode

This menu associated with the PC Kit software installed 
on your computer is used to select which device receives 
the documents:
• the machine,
• the PC,
• the PC if available, otherwise the machine.
For more information, consult the section PC functions 
[ 77].
To select the reception mode:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

RECEPTION > PC MANAGEMENT.
3 Press MODE.
4 Select the required option from the list.
5 Press OK to confirm the new setting.

To select the PC that will receive the documents:

1 Press PC RECEIVER.
2 Select the reception PC.
3 Press OK to confirm the new setting.
When a fax is received on the machine, it is sent to the 
receiving PC and a reception report is printed on the 
PC's default printer.

Format Description

PHOTO Classic 10x15 cm photo printing

FULL PAGE Print adjusted to page format 
used.

Option Description

UPPER TRAY Documents received and printed 
exit in the upper output tray of the 
finisher.

LOWER TRAY Documents received and printed 
exit in the lower output tray of the 
finisher.

LWR TRAY 
STAPLED

Documents received and printed 
are stapled and exit in the lower 
output tray of the finisher.

LOW. TRAY 
SHIFTED

Documents received and printed 
are offset and exit in the lower 
output tray of the finisher.

Note

This menu is only available if a PC is regi-
stered on the machine via the PC Kit.
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Fax RX forwarding

This function is used to set the terminal so that any 
document received is also sent to another recipient. The 
recipient should be chosen from the entries in the 
machine's address book.

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

RECEPTION > COPY.
3 Press ACTIVATION.
4 Select the required status from the list. Press OK to 

confirm the new setting.
5 Press RECIPIENT.
6 Select the required recipient from the entries in the 

address book. Press OK to confirm the new setting.
7 Press MENU to return to the home screen.

Advanced fax reception settings

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

RECEPTION > ADVANCED.
3 To configure the advanced fax emission settings, 

use the table below:
 

4 Press MENU to return to the home screen.

Configuring the fax server (optional)

If you have a fax server, this function enables you to 
select how faxes will be sent by the machine: direct 
transmission via the telephone line (without passing 
through a fax server) or transmission to the fax server via 
the local network.
Accessing the fax server configuration parameters

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

FAX SERVER.
3 Make the required adjustments using the proce-

dures described below.
4 When you have made the modifications, press 

MENU to return to the home screen.
If the fax server function is active, proceed as follows:

Note

Check that the recipient exists in the 
address book (see Address book [ 72]).

Parameter Description / Procedure

Reception 
heading

If this function is active, all 
documents received by the 
machine will be printed with a 
heading containing the name 
and number of the sender (if 
available) and the machine 
print date and the number of 
pages.
To change the setting:

1 Press HEADER.
2 Select the required sta-

tus from the list.
3 Press OK to confirm the 

new setting.

Reception speed Reception speed of incoming 
documents. If the quality of the 
telephone line is good 
(suitable, without echo), calls 
are usually made at maximum 
speed. 
However, it may be necessary 
to limit the reception speed for 
certain communications.
To change the reception 
speed:

1 Press SPEED.
2 Select the required val-

ue from the list.
3 Press OK to confirm the 

new setting.

Number of rings Number of rings to 
automatically trigger your 
machine.
To change the number of 
rings:

1 Press NUMBER OF 
RINGS.

2 Enter the number of 
rings using the virtual 
keyboard.

3 Press OK to confirm the 
new setting.

Note

Activating the fax server function automati-
cally activates the SMTP server (see 
Configuring the SMTP server [ 38]).

Parameter Description / Procedure
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1. Activate the fax server [ 33].

2. Define a reply address [ 33].

3. Define the fax server address [ 33].

4. Define the domain name [ 33].

5. Define the type of emission report [ 33].

Activating the fax server

To activate the fax server:
1 Press ACTIVATION.
2 Select the required option.

 

3 Press OK to confirm the new setting.

Defining a reply address

The reply address is used to receive emission and 
reception reports for faxes managed by the fax server.

1 Press SENDER'S ADDRESS.
2 Enter the required email address using the virtual 

keyboard. Use the  and  keys to pass from one 
character to the next. In the event of an error, use 
the  key to delete a character.

3 Press OK to confirm the new setting.

Defining the fax server address

To prevent any interruptions of service, you can define 
two fax servers to be used:
• NETWORK ADDR. 1: main fax server.
• NETWORK ADDR. 2: backup fax server, to be used if 

the connection with the main fax server fails.
To define the main fax server address:

1 Press NETWORK ADDR. 1.
2 Enter the IP address for the fax server using the vir-

tual keyboard. Use the  and  keys to pass from 
one character to the next. In the event of an error, 
use the  key to delete a character.

3 Press OK to confirm the new setting.
To define the address of the backup fax server, press 
NETWORK ADDR. 2 and enter its IP address.

Defining the domain name

1 Press DOMAIN.
2 Enter the domain name for the machine using the 

virtual keyboard. Use the  and  keys to pass from 
one character to the next. In the event of an error, 
use the  key to delete a character.

3 Press OK to confirm the new setting.

Defining the type of emission report

You can print out an emission report for communications 
made via the fax server.
You can choose between several criteria for printing out 
emission reports:
• WITH : a report is printed when the emission was suc-

cessful or when it is definitively abandoned (but there 
is only one report per emission request);

• WITHOUT: no emission report, but the machine 
records all emissions made in its emissions log;

• ON FAILURE: a report is printed only when the emis-
sion attempts have ended in failure and the emission 
request is definitively abandoned. A report is also 
printed when the fax is sent using the telephone fold-
back.

To select the type of emission report:
1 Press SENDING REPORT.
2 Select the required report type from the list.
3 Press OK to confirm the new setting.

Advanced fax settings

Line parameters

This parameter is used to adapt the telephone line 
according to the type of telephone switchboard to which 
your machine is connected. 
Two choices are possible: 
• PULSES: for a digital dialling switchboard (electrome-

chanical switchboards).
• MUSICAL: for a voice frequency dialling switchboard 

(electronic switchboards).
To define the type of switchboard:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

ADVANCED > DIALING.
3 Select the required option from the list.
4 Press OK to confirm the new setting.
5 Press MENU to return to the home screen.

Parameter Description

DIRECT (fax 
server activated)

The machine sends 
documents to the fax server 
over the local network.

DISABLE The machine sends directly 
documents over the telephone 
line.
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Type of telephone network

You can connect your machine to a public telephone 
network or to a private network built for example using a 
private automatic branch exchange (PABX). You must 
define the type of network you prefer.
To select the type of network:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

ADVANCED > NETWORK TYPE.
3 Select the required option from the list, PRIVATE 

or PUBLIC.

4 Press OK to confirm the new setting.
5 Press MENU to return to the home screen.

ECM (error correction mode)

This function is used to correct communication errors due 
to disturbance on the telephone line. This is a useful 
function when lines are of a low level or noisy. However, 
emission times may be longer.
To activate or deactivate error correction:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > FAX > 

ADVANCED > ECM.
3 Select the required option from the list.
4 Press OK to confirm the new setting.
5 Press MENU to return to the home screen.

Service default settings

The machine allows you to define default values for some 
Copy, Fax and Scan to parameters.
The default values must be configured depending on the 
habits of the people using the machine. The aim is to 
reduce the time required to set common functions and 
optimize their operation.
Accessing the default settings

1 Press MENU.
2 Select SETTINGS > BY DEFAULT.
3 Define the default parameters for the various func-

tions:
For the Copy function, see Copy function default 
settings.

For the Fax function, see Fax emission default 
settings.

For the Scan to function, see Scan to default set-
tings.

4 When you have made the modifications, press 
MENU to return to the home screen.

Copy function default settings

1 Press COPY.
The first settings appear on the screen. Use 
OTHER PARAMETERS to access all available 
settings.

2 Make the required adjustments. The following table 
lists the available parameters.

 

3 When you have made the adjustments, press:
BY DEFAULT in the navigation path to return to 
the previous menu.

MENU to return to the home screen.

Note

If your machine is connected to a private 
network, behind a company exchange 
(PABX), it may be necessary to specify a lo-
cal prefix (see Local prefix [ 28]).

Parameter Available settings

NUMBER OF 
COPIES

1 to 99

QUALITY SPEED, NORMAL, TEXT, TEXT 
AND IMAGE or PHOTO

CONTRAST -4, -3, -2, -1, 0, +1, +2, +3 or +4

BRIGHTNESS -4, -3, -2, -1, 0, +1, +2, +3 or +4

TONER SAVE YES or NO

COLLATE COPY YES or NO

DUPLEX FRONT -> FRONT,
FRONT -> DUPLEX,
DUPLEX -> FRONT or
DUPLEX -> DUPLEX

BINDING EDGE LONG or SHORT

OUTPUT 
FINISHING

UPPER TRAY,LOWER 
TRAY,LWR TRAY STAPLED or 
LOW. TRAY SHIFTED

PAPER TYPE NORMAL, RECYCLED, THICK, 
TRANSPARENT or GLOSSY

SCALE 1:1, ZOOM or FORMAT 
CONVERS.

SCAN FORMAT A5, A4, or LETTER

PRINTED PAPER A5, A4, LETTER, LEGAL-14, 
TRAY1/A4, MANUAL TRAY/A4, 
MANUAL TRAY/A5, MANUAL 
TRAY/LTER or MANUAL TRAY/
LEG14

ZOOM 25 to 400% in steps of 1

MOSAIC NONE, 2 -> 1 or 4 -> 1

BANNER NONE, 1 -> 4 or 1 -> 9

IDENTITY CARD YES or NO
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 Fax emission default settings

1 Press FAX TRANSMISSION.
2 Make the required adjustments. The following table 

lists the available parameters.
 

3 When you have made the adjustments, press:
BY DEFAULT in the navigation path to return to 
the previous menu.

MENU to return to the home screen.

Scan to default settings

1 Press SCAN TO.
2 Make the required adjustments. The following table 

lists the available parameters.
 

3 When you have made the adjustments, press:
BY DEFAULT in the navigation path to return to 
the previous menu.

MENU to return to the home screen.

Local network settings

You can include your machine in your local network.

Depending on the services and security policy 
implemented in your local network, other network 
parameters are also available:
• configuration of the SNTP server;
• configuration of the client FTP port;
• configuration of the SNMP service;
• configuration of the SMTP server;
• Active Directory configuration;
• print server settings (RAW, LPR);
• configuration of the LDAP server.

Configuring the Ethernet network

We recommend automatic configuration of the 
machine's local network settings when your local network 
has a DHCP or BOOTP server that can dynamically 
allocate addresses to the peripherals present on the LAN, 
on the condition that the IP address allocated to the 
machine is unique and always identical.
Otherwise, we recommend manual configuration.

Automatic configuration of the Ethernet network

To automatically configure the machine's local network 
settings:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > LOCAL 

NETWORK.
3 Press ADDR. ALLOCATION.
4 Select AUTOMATIC from the options available in 

the list. Press OK to confirm the new setting.
The machine will search for a DHCP or BOOTP 
server on the local network that can dynamically 
allocate its network settings.

This operation may take a few minutes.
5 Check that the parameters IP ADDRESS, 

SUBNET MASK, GATEWAY, PRIMARY DNS, 
SECONDARY DNS, WINS 1 SERVER et WINS 2 
SERVER are correctly entered. If this is not the 
case, you will have to configure them manually.

Parameter Available settings

QUALITY NORMAL,FINE,SUPER FINE or 
PHOTO

CONTRAST -4, -3, -2, -1, 0, +1, +2, +3 or +4

DUPLEX YES or NO

BINDING 
EDGE

LONG or SHORT

MULTIPLE 
SCAN

YES or NO

Parameter Available settings

DOCUMENT 
FORMAT

IMAGE, PDF or SECURED PDF

QUALITY LIGHT,TEXT,TEXT AND IMAGE 
or PHOTO

CONTRAST -4, -3, -2, -1, 0, +1, +2, +3 or +4

DUPLEX YES or NO

MULTIPLE 
SCAN

YES or NO

Note

Although quite simple, the network settings 
sometimes require expert knowledge of 
your computer configuration. We recom-
mend you consult the person in your com-
pany who administers the network to do the 
configuration described in this section.
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Manual configuration of the Ethernet network

To manually configure the machine, you must first avail of 
the usual information used to configure a peripheral on 
the local network (IP address, subnet mask and gateway 
address).
To manually configure the machine's local network 
settings:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > LOCAL 

NETWORK.
The first settings appear on the screen. Use 
OTHER PARAMETERS to access all available 
settings.

3 Press ADDR. ALLOCATION.
4 Select MANUAL from the options available in the 

list. Press OK to confirm the new setting.
5 Press IP ADDRESS.
6 Enter the machine's IP address using the virtual 

keyboard or the keypad. Press OK to confirm the 
new setting.

7 Press SUBNET MASK.
8 Enter the machine's subnet mask using the virtual 

keyboard or the keypad. Press OK to confirm the 
new setting.

9 Press GATEWAY.
10 Enter the network gateway IP address using the 

virtual keyboard or the keypad. Press OK to con-
firm the new setting.

11 Press PRIMARY DNS.
12 Enter the IP address of the primary DNS server us-

ing the virtual keyboard or the keypad. Press OK to 
confirm the new setting.

13 Press SECONDARY DNS.
14 Enter the IP address of the secondary DNS server 

using the virtual keyboard or the keypad. Press OK 
to confirm the new setting.

15 Press WINS 1 SERVER.

16 Enter the IP address of the WINS1 server using the 
virtual keyboard or the keypad.  Press OK to con-
firm the new setting.

17 Press WINS 2 SERVER.
18 Enter the IP address of the WINS2 server using the 

virtual keyboard or the keypad.  Press OK to con-
firm the new setting.

IEEE (or Ethernet address) or MAC address

The machine's Ethernet interface already contains an 
IEEE address that cannot be modified, but only consulted.

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > LOCAL 

NETWORK.
The machine's IEEE address is displayed in the 
IEEE ADDRESS network setting.

3 Press MENU to return to the home screen.

NetBIOS names

NetBIOS names, which can be used with network options, 
are used to identify the machine from a PC connected on 
a local network (for example with the name «IMP-
NETWORK-1»).

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > LOCAL 

NETWORK.
3 Press 1st NETBIOS NAME or 2nd NETBIOS 

NAME.
4 Enter the name using the virtual keyboard (maxi-

mum 15 characters). In the event of an error, use 
the  key to delete a character. Press OK to 
confirm the new setting.

5 Press MENU to return to the home screen.

Ethernet network communication speed

By default, the machine is configured to adapt its 
communication speed automatically to that of the 
Ethernet network. However, you can specify the 
communication speed to be used on the Ethernet 
network.

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > LOCAL 

NETWORK.
3 Press SPEED.
4 Select the communication speed required from the 

options available in the list: AUTOMATIC, 100 
FULL DUPLEX, 100 HALF DUPLEX, 10 FULL 
DUPLEX and 10 HALF DUPLEX. Use the up and 
down arrows to view all available options. Press 
OK to confirm the new setting.

5 Press MENU to return to the home screen.

Note

The servers WINS1 and WINS2, used with 
the network options, are used to access ma-
chines on other sub-networks using their 
NetBIOS names.
These addresses must be entered for the 
Scan to File function.

Note

If the machine is set to automatic configura-
tion (see Automatic configuration of the 
Ethernet network [ 35]), these addresses 
may be filled automatically by some DHCP 
servers.
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Configuring the SNTP server

The machine can set its time automatically by connecting 
to an SNTP server.
To activate and configure automatic updating of the 
machine time via an SNTP server:
Accessing SNTP server configuration

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > 

SERVICES > SNTP DATE TIME.
3 Make the required adjustments using the proce-

dures described below.
4 When you have made the modifications, press 

MENU to return to the home screen.
Activating / Deactivating automatic updating of the 
machine time via an SNTP server

1 Press ACTIVATION.
2 Select the required status from the list.
3 Press OK to confirm the new setting.

Once the SNTP function has been activated, you can 
change the following settings:
• Define the SNTP server address [ 37]
• Define the SNTP server port [ 37]
• Define the time zone
• Configure automatic switchover the summer / winter 

time

Defining the SNTP server address

1 Press NETWORK POSITION.
2 Enter the name of the SNTP server using the virtual 

keyboard or the number pad. This name may be in 
the form of an IP address, a DNS address or a Net-
BIOS name. Use the  and  keys to pass from one 
character to the next. In the event of an error, use 
the  key to delete a character.

3 Press OK to confirm the new setting.

Defining the SNTP server port

1 Press PORT.
2 Enter the number of the server port using the virtual 

keyboard or the number pad. The default port is 
123. In the event of an error, use the  key to 
delete a character.

3 Press OK to confirm the new setting.

Configuring the client FTP port

The machine uses this setting for the Scan to FTP 
function. You can modify it, for example to activate FTPS 
(Secure FTP).
To modify the machine's FTP port:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > 

SERVICES > TRANS. FTP FILE.
3 Press SECURITY.
4 Select the required encryption from the list. Press 

OK to confirm the new setting.
5 Press PORT.
6 Enter the number of the server port (from 1 to 

65535) using the virtual keyboard or the number 
pad. The default port is 21 (990 for a connection 
with IMPLICIT encryption). Press OK to confirm the 
new setting.

7 Press MENU to return to the home screen.

Configuring the SNMP service

An SNMP (Simple Network Management Protocol) agent 
is available on the machine for network administrators 
wishing to monitor and manage the device via the local 
network using their SNMP network service.
To activate and configure the SNMP service on the 
machine:
Accessing SNMP service configuration

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > 

SERVICES > SNMP MANAGER.
3 Make the required adjustments using the proce-

dures described below. Press OTHER 
PARAMETERS to view all available settings.

4 When you have made the modifications, press 
MENU to return to the home screen.

Activating / Deactivating the SNMP service
1 Press ACTIVATION.
2 Select the required status from the list.
3 Press OK to confirm the new setting.

Once the SNMP function has been activated, you can 
change the following settings:
• Configure the SNMP agent [ 37]
• Configure the SNMP console [ 38]

Configuring the SNMP agent

To configure the SNMP service on the machine:
1 In COMMUNITY, enter the required name for the 

shared read-write community enabling communi-
cation between SNMP agents (machine) and man-
agement stations (PC with console).

2 In SYSCONTACT, enter the contact information for 
the node administrator.

3 In SYSNAME, enter the official name of the node 
on the network.

4 In SYSLOCATION, enter the physical location in-
formation for the node.
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5 In WEB JET ADMIN, select the required compati-
bility status with the software HP Web JetAdmin: 
activated or deactivated.

6 In VERSIONS, select the version of your SNMP 
network. If you are using a SNMPv3 network, you 
can activate and configure the authentication and 
encryption information for network transactions.

7 In TRAPS, activate / deactivate the alerts to be col-
lected and specify for the SNMP version of your 
network the community and the IP address of the 
management station.

Configuring the SNMP console

The machine is supplied with the following integrated 
management information bases (MIBs):
• MIB-II (RFC 1213), sys, udp, tcp, ip, icmp, if, snmp
• PPP (RFC 1471, 1472, 1473)
• MIB Ressource hôte (RFC 2790)
• Imprimante MIB (RFC 3805)
• Moniteur de port d’imprimante (pwg 5107.1)

Configuring the SMTP server 

This setting is automatically activated when the fax server 
function is active and used during data exchanges 
between the machine and the fax server.
To edit this setting:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > 

SERVICES > SMTP SERVER.
3 To activate / deactivate this function, press 

ACTIVATION. Select the required status and press 
OK to confirm the new setting.

4 To modify the port number used, press PORT. En-
ter the number of the server port (from 1 to 65535) 
using the virtual keyboard or the number pad. The 
default port is 25. Press OK to confirm the new set-
ting.

5 Press MENU to return to the home screen.

Active Directory configuration

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > 

SERVICES.
3 Press ACTIVE DIRECTORY.
4 Make the required adjustments.
5 Press MENU to return to the home screen.

Configuring the print server (RAW or LPR)

Depending on your needs and on the architecture of your 
print network, you can configure the machine on the 
following print servers:
• RAW print server
• LPR print server

To activate and configure the protocol used by the 
machine on the print server:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > 

SERVICES.
3 Press the required setting, RAW PRINT or LPR 

PRINT.
4 To activate / deactivate the protocol selected, 

press ACTIVATION. Select the required status and 
press OK to confirm the new setting.

5 To modify the port number used, press PORT. En-
ter the number of the server port (from 1 to 65535) 
using the virtual keyboard or the number pad. The 
default ports are 9100 for RAW and 515 for LPR. 
Press OK to confirm the new setting.

6 Press MENU to return to the home screen.

Configuring the LDAP server

The LDAP server is used to access a directory server for 
contacts or lists of contacts (maximum 500 recipients).

The LDAP function can only be activated if at least 50 
free entries exist in the machine's local address book.
To activate and configure the LDAP function:
Accessing LDAP server configuration

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > 

SERVICES > LDAP SERVER.
The first settings appear on the screen. Use 
OTHER PARAMETERS to access all available 
settings.

3 Press NETWORK POSITION.
4 Enter the IP address or the name of the LDAP serv-

er using the virtual keyboard or the keypad.  Press 
OK to confirm the new setting.

5 Press LOGIN.
6 Enter the login for the LDAP server using the virtual 

keyboard. Press OK to confirm the new setting.
7 Press PASSWORD.
8 Enter the password for the LDAP server using the 

virtual keyboard. Press OK to confirm the new set-
ting.

9 Press BASE DN.
10 Enter the database name using the virtual key-

board. Press OK to confirm the new setting.
11 Press PORT.
12 Enter the number of the server port (from 1 to 

65535) using the virtual keyboard or the number 
pad. The default port is 389 (636 for a connection 
with IMPLICIT encryption). Press OK to confirm the 
new setting.

13 When you have made the modifications, press 
MENU to return to the home screen.

Note

The LDAP server must be compatible with 
LDAPv2 or earlier versions.
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Internet settings via the telephone 

line

You can configure the machine to connect to the internet 
via the telephone line, and thus send and receive 
electronic messages.
To use this configuration, you must:
• have an internet subscription with an internet service 

provider;
• check that all initialisation parameters comply with the 

data provided by the service provider;
• adjust the settings for internet access via the tele-

phone line on the machine.
Once these settings are complete, you can configure the 
connection settings for email and connect to the internet 
via your service provider to send and receive emails. 
These two operations will be performed during an internet 
connection, the frequency of which you can select.

Configuring the internet connection

To configure internet access via the telephone line, have 
the information provided by your internet service provider 
to hand.

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > 

INTERNET / TELEPH. > MAIL.
The first settings appear on the screen. Use 
OTHER PARAMETERS to view all available set-
tings.

3 Press PHONE NUMBER. Enter the call number 
and press OK to confirm.

4 Press LOGIN. Enter the login and press OK to con-
firm.

5 Press PASSWORD. Enter the password and press 
OK to confirm.

6 Press PRIMARY DNS. Enter the name or IP ad-
dress of the primary DNS server and press OK to 
confirm.

7 Press SECONDARY DNS. Enter the name or IP 
address of the secondary DNS server and press 
OK to confirm.

8 Press MENU to return to the home screen.
You can now configure the email service.

Email settings

The machine allows you to send and receive documents 
by email, via your local network or an internet access via 
the telephone line.
To configure and use the email service, you must first 
configure your machine to connect to the internet:
• either via your local network (see Local network 

settings [ 35]);
• or via the telephone line if you have an internet sub-

scription with an internet service provider (see Internet 
settings via the telephone line [ 39]).

You must also configure the email service settings. Have 
the following connection information to hand:
• email service login
• email service password
• email address
• name or IP address of the SMTP (outgoing) and POP3 

(incoming) servers
• SMTP authentication settings

Accessing the email configuration settings

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > 

SERVICES > MAIL.
The first settings appear on the screen. Use 
OTHER PARAMETERS to access all available 
settings.

3 Make the required adjustments using the proce-
dures described below.

4 When you have made the modifications, press 
MENU to return to the home screen.

Configuring the email service connection

1 Press CONNECTION.
2 Select the type of connection used on the machine. 

Press OK to confirm the new setting.
 

3 Depending on the type of connection selected, 
press BY ETHERNET or BY TELEPHONE.

4 Press POP3 SERVER. Enter the following settings:
 

Select... for a connection...

ETHERNET via the local network

PHONE via the telephone line

Parameter Description

NETWORK 
POSITION

POP3 server name or IP address.

PORT Server port number (from 1 to 
65535 - 110 by default).

LOGIN Email login.

PASSWORD Email password.
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5 Press SMTP SERVER. Enter the following set-
tings:

 

6 If you have set SMTP authentication to WITH , en-
ter your identification settings in LOGIN and 
PASSWORD.

Defining a reply address

1 Press REPLY ADDRESS.
2 Enter the required email address using the virtual 

keyboard.
3 Press OK to confirm the new setting.

Defining the type of emission report

You can print out an emission report for documents sent 
via email.
You can choose between several criteria for printing out 
emission reports:
• WITH : a report is printed when the emission was suc-

cessful or when it is definitively abandoned (but there 
is only one report per emission request);

• WITHOUT: no emission report, but the machine 
records all emissions made in its emissions log;

• SYSTEMATIC: a report is printed at each emission at-
tempt;

• ON FAILURE: a report is printed only when the emis-
sion attempts have ended in failure and the emission 
request is definitively abandoned.

To select the type of report:
1 Press SENDING REPORT.
2 Select the required report type from the list.
3 Press OK to confirm the new setting.

PC Management

Unregistering a PC

This menu allows you to delete one or more PCs 
registered on the machine via the PC Kit.
To unregister a PC from the machine:

1 Press MENU.
2 Select SETTINGS > PC MANAGEMENT.
3 Press UNREGISTER.
4 If several PCs are registered, select the required 

PC from the list proposed.
5 Press OK to confirm the new setting.
6 Press MENU to return to the home screen.

Automatic Consumable Ordering 
(ACO) and maintenance

Remote reading and maintenance are functions which 
are part of a maintenance contract and are activated by 
your installer.
The aim of these functions is to communicate to a server 
centre the following information which is essential:
• for automatic procurement of consumables;
• for preventive maintenance operations.
You machine will automatically transmit any information 
regarding its identification and maintenance to the server 
centre.
You can also print out the remote reading / maintenance 
information for your machine, or manually send this 
information to the server centre.

Connecting to the server centre

The connection to the server centre can be configured on 
the machine. This information will be supplied with your 
maintenance contract.
To consult / configure the connection to the server centre:

1 Press MENU.
2 Select SETTINGS > COMMUNICATION > 

INTERNET / TELEPH. > TELE-MAINTENANCE.
3 Press PHONE NUMBER. Enter the telephone 

number of the server centre. Press OK to confirm 
the new setting.

4 Press LOGIN. Enter the login for connection to the 
server centre. Press OK to confirm the new setting.

5 Press PASSWORD. Enter the password for con-
nection to the server centre. Press OK to confirm 
the new setting.

6 Press MENU to return to the home screen.

Parameter Description

SENDER'S 
ADDRESS

Outgoing email address.

NETWORK 
POSITION

SMTP server name or IP 
address.

PORT Server port number (from 1 to 
65535 - 25 by default).

AUTHENTICATION Select in TYPE:
WITHOUT to deactivate 
SMTP authentication.
AS POP3 to activate SMTP 
authentication and retain the 
identification settings.
WITH  to activate SMTP au-
thentication and enter other 
identification settings.

Note

This menu is only available if a PC is regi-
stered on the machine via the PC Kit.
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Triggering an ACO

The remote reading operates according to the following 
criteria:
• number of pages printed;
• number of days of operation.
The machine automatically sends all the information 
regarding its identification and maintenance to the server 
centre at a frequency and threshold defined by the 
installer.
You can however trigger the sending of this information to 
the server centre.

1 Press MENU.
2 Press CONSUMABLES.
3 Press AUTO ORDER.

Triggering  remote maintenance

Use this function when you want to authorize technical 
assistance to take over control of the machine.

1 Press MENU.
2 Select [OTHER COMMANDS] > INTERNET.
3 Press SERVICE / PHONE.

Printing / Exporting / Importing 
settings

Printing out a list of settings

To print out the list of the machine's current settings:
1 Press MENU.
2 Select REPORTS > SETTINGS.
The machine prints out the list of settings.

Printing out a list of fonts

At any time, you can print out a list of the character fonts 
installed on your machine.
To print out a list of fonts:

1 Press MENU.
2 Select REPORTS > FONTS.
The machine prints out the list of installed fonts.

Exporting settings

This function is only available from the integrated website.
To export the machine's current settings:

1 Go to the integrated website (see Remote 
configuration [ 23]).

2 Select the SETTINGS tab.
3 Select the menu TRANSFER PC.

4 Select EXPORT.
A file saving window opens.

5 Enter the name of the file, the destination directory 
and confirm.

The machine settings are exported in XML format.

Importing settings

This function is only available from the integrated website.

You can only import files exported from the machine.
To import settings:

1 Go to the integrated website (see Remote 
configuration [ 23]).

2 Select the SETTINGS tab.
3 Select the menu TRANSFER PC.
4 Select IMPORT.

A file selection window opens.
5 Select the file to import and confirm.
The settings are imported to the machine.

Machine monitoring and activity 
counters

Communications log

The machine saves the last 25 communications made 
(emission and reception) in a communications log.
The following communications are saved in the log:
• faxes sent and received
• emails sent and received
• scan to archive operations
The communications log is automatically printed out 
every 25 communications. However, you can request a 
print-out at any time.
For each direction of communication (incoming and 
outgoing), the log saves the following information:
• date and time the document was sent or received;
• correspondent's identification;
• document resolution;
• number of pages sent or received;
• length of the communication (only for faxes);
• emission or reception result:

– Correct when the communication was success-
ful;

– error code in the event of failure.
• cause of communication failure.

Note

You can also access this function via the 
PRINT QUEUE menu.

Caution

When you import settings, you overwrite the 
machine's current settings.
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To print out the communications log:
1 Press MENU.
2 Select REPORTS.
3 Press LOG.
The machine prints out the communications log.

Activity counters

At any time, you can consult the machine's activity 
counters.
The machine saves information on usage of:
• the printer;
• the scanner.
The usage counter for the printer contains the following 
print operations:

 

The usage counter for the scanner contains the following 
scan operations:

 

To print out the activity counters:
1 Press MENU.
2 Select REPORTS.
3 Press COUNTERS.
The machine prints out the activity counters.

Consumable status

You can check the status of consumables at any time.
To view  the status of consumables:

1 Press MENU.
2 Select CONSUMABLES > DISPLAY.
For each consumable, the machine displays the re-
maining capacity, expressed as a percentage.

To print out  the status of consumables:
1 Press MENU.
2 Select CONSUMABLES > PRINT.
For each consumable, the machine prints a report in-
dicating the remaining capacity, expressed as a per-
centage.

Hardware and software information

The STATUS menu contains the machine's hardware and 
software information which may be requested in the event 
of technical intervention or during a maintenance 
operation.
To access this information:

1 Press MENU.
2 Select [OTHER COMMANDS] > STATUS.

The following information can be consulted:
 

Counter Description

Copy Number of pages copied

Print Number of pages printed

Fax Number of pages received by fax 
and printed 

Total Total number of pages printed

Counter Description

Copy Number of scanned pages for 
copy

Fax Number of pages scanned and 
faxed

Scan to Mail Number of pages scanned and 
sent by email

Scan to File Number of pages scanned and 
sent to an FTP or SMB address

Scan to Key Number of pages scanned and 
saved on a USB key.

Scan to Archive Number of pages scanned and 
sent to the archive server

Scan to PC Number of pages scanned and 
sent to a PC

PC Scan Number of pages scanned from a 
PC

Total Total number of pages scanned

Note

You can also access this function via the 
STATUS menu.

Menu Description

DEVICE 
TYPE

Machine type

SERIAL 
NUMBER

Machine's serial number

SOFTWARE 
VERSION

Software version installed

MINIBOOT 
VERSION

Miniboot version installed

OPTIONS Access to options installed on the 
machine (additional paper trays, 
etc.)

PRINT Printing counters:
activities (see Activity counters 
[ 42])
consumables (see 
Consumable status [ 42])
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Creating and 
managing user 
accounts
By default, the machine is set to free access. The 
functions and configuration menus can be used by 
everyone with no access restrictions.
However, if you want to rationalize machine resources in 
your organization, you can activate management of user 
rights and create user accounts.
Thus, you can:
• reserve the use of certain costly functions (copying, 

scanning, fax emissions, etc.) to users;
• define monthly use quotas for each user (maximum 

number of photocopies, scans, fax emissions, etc.);
• monitor and assess the use of resources by means of 

monthly activity counters per user;
• delegate machine administration rights (access to 

configuration menus, management of user accounts, 
etc.) to certain users;

• preserve the confidentiality of faxes received by defin-
ing users authorised to view and print them.

A user account is characterized by a 4-figure user code, 
with a fingerprint if the user has recorded one. A restricted 
function can only be performed by entering a user code or 
reading a fingerprint. The machine authorises or prohibits 
the function requested by the user according to the rights 
allocated and the quotas defined in the user account.

Activating / Deactivating user rights 
management

When user rights management is deactivated, the 
machine functions are accessible by everyone with no 
access restrictions.
When user rights management is activated, the functions 
defined as restricted are only accessible to authorised 
user accounts.
The "Admin" user account is the machine's default user 
account. This account has administrator rights and thus 
authorizes access to all machine functions, with no quota 
restrictions. Note, if you activate user rights management 
and limit access to all machine functions, without creating 
user accounts, the machine will only be able to be used 
by the "Admin" user account.
Therefore, in order to set up user rights management, you 
must:

1. activate user rights management

2. define the restricted functions

3. create user accounts

To activate / deactivate user rights management:
1 Press the MENU key.
2 Select SETTINGS > [OTHER PARAMETERS] > 

RIGHTS MGT. > ACTIVATION.
3 Press ADMINISTRATION. Select the required sta-

tus from the list. Press OK to confirm the new set-
ting.

Activating user rights management makes the list 
of functions to restrict accessible. 

4 Specify the functions whose access you want to re-
strict to authorised user accounts, using the follow-
ing table. Press OTHER COMMANDS to view all 
available functions.

 

Function Description / Procedure

WEB ACCESS Select the required status:
NO: any person can access the 
machine's integrated website 
and remotely configure the ma-
chine. No identification is re-
quired.
YES: only authorised user ac-
counts can access the integrat-
ed website, after logging in.

Press OK to confirm the new 
setting.

PRINT Select the required status:
NO: any person can print on the 
machine. No identification is re-
quired.
YES: only authorised user ac-
counts can print on the ma-
chine. Authorised users must 
send their document for printing 
with their identification informa-
tion (secure printing). The ma-
chine cancels other print 
requests.

Press OK to confirm the new 
setting.

COPY Select the required status:
NO: any person can photocopy 
on the machine. No identifica-
tion is required.
YES: only authorised user ac-
counts can photocopy on the 
machine, after logging in.

Press OK to confirm the new 
setting.

FAX 
TRANSMISSION

Select the required status:
NO: any person can send faxes 
from the machine. No identifica-
tion is required.
YES: only authorised user ac-
counts can send faxes from the 
machine, after logging in.

Press OK to confirm the new 
setting.
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5 When the settings are complete, press RIGHTS 
MGT. in the navigation path to return to the previ-
ous menu.

You may now create user accounts and allocate 
rights and usage quotas.

Creating a user account

When user rights management is activated, you must 
have machine administration rights (by default, "Admin" 
user account) to create user accounts. You may create up 
to 49 user accounts.
To create a user account:

1 Press the MENU key.
2 Select SETTINGS > [OTHER PARAMETERS] > 

RIGHTS MGT. > CREATE USER.
The list of properties of the new user account is 
displayed on the screen. Press OTHER 
COMMANDS to view all properties.

3 Specify the properties of the user account using the 
following table. Press OK to confirm each property 
modified.

 

FAX 
RECEPTION

When automatic printing of 
received faxes is deactivated (see 
Secure printing of received faxes 
[ 30]), users wishing to recover 
a received fax saved in the 
memory must manually force 
printing from the print queue. You 
may restrict this right to 
authorised user accounts only.
Select the required status:

NO: any person can view and 
print faxes received saved in 
the memory in the print queue. 
No identification is required.
YES: only authorised user ac-
counts can view and print re-
ceived faxes saved in the 
memory in the print queue, after 
logging in.

Press OK to confirm the new 
setting.

SCAN Select the required status:
NO: any person can scan and 
send documents using the 
SCAN function. No identifica-
tion is required.
YES: only authorised users ac-
counts can scan and send doc-
uments using the SCAN 
function, after logging in.

Press OK to confirm the new 
setting.

Function Description / Procedure Property Description

CODE 4-figure code generated by the 
machine. This code is unique 
and personal.
The administrator may modify 
the user code, and must inform 
the user.

SECURITY 
LEVEL

Defines the time period during 
which the user account remains 
active on the machine, before 
the user account is automatically 
logged off:

LOW: identification of the user 
account remains active for 
180 seconds.
MODERATE: identification of 
the user account remains ac-
tive for 60 seconds.
HIGH: identification of the 
user account remains active 
for 15 seconds.
ABSOLUTE: the user must 
login each time a restricted 
function is used.

ADMINISTR. 
RIGHT

Allocates machine 
administration rights to a user 
account.

WEB ACCESS 
RIGHTS

Allocates the right to access the 
integrated website and remotely 
configure the machine to the 
user account.

B&W PRINT 
RIGHTS

Allocates the right to print black 
and white documents on the 
machine to the user account.

COL. PRINT 
RIGHTS

Allocates the right to print colour 
documents on the machine to 
the user account.

B&W COPY 
RIGHTS

Allocates the right to photocopy 
black and white documents on 
the machine to the user account.

COL. COPY 
RIGHTS

Allocates the right to photocopy 
colour documents on the 
machine to the user account.

FAX TRANSM. 
RIGHTS

Allocates the right to send faxes 
from the machine to the user 
account.

FAX RECEPT. 
RIGHTS

Allocates the right to view and 
print faxes received saved in the 
memory in the print queue to the 
user account.

SCAN RIGHTS Allocates the right to scan and 
send documents using the Scan 
to function to the user account.
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4 Once the user account is created, press:

RIGHTS MGT. in the navigation path to return to 
the previous menu.

MENU to return to the home screen.
The user account created can be used immediately. You 
may inform the user of his code.

Modifying a user account

Any modifications made to a user account take effect 
immediately.
To change the rights and quotas of a user account, 
proceed as follows:
Administrator rights

1 Press the MENU key.
2 Select SETTINGS > [OTHER PARAMETERS] > 

RIGHTS MGT. > DISPLAY/EDIT.
The list of existing user accounts is displayed on 
the screen. Use the up and down arrows to view 
the whole list.

3 Select the user account to modify and press OK.
4 Make the required modifications. Use the proce-

dure for creating a user account for help in modify-
ing the required properties.

5 Once the user account has been modified, press: 
RIGHTS MGT. in the navigation path to return to 
the previous menu.

MENU to return to the home screen.

Deleting a user account

Deleting a user account is immediate and leads to:
• invalid identification (user code and fingerprint no 

longer recognized);
• deletion of secure prints in the print queue;
• deletion of usage counters.
The "Admin" user account cannot be deleted.
To delete a user account, proceed as follows:
Administrator rights

1 Press the MENU key.
2 Select SETTINGS > [OTHER PARAMETERS] > 

RIGHTS MGT. > DELETE USER.
The list of existing user accounts is displayed on 
the screen. Use the up and down arrows to view 
the whole list.

3 Select the user account to delete and press OK.
The selected user account is deleted.

B&W PRINT 
QUOTA 

Defines the maximum number of 
black and white prints that the 
user account is authorised to 
make per month (maximum 
10000 pages).

COL. PRINT 
QUOTA 

Defines the maximum number of 
colour prints that the user 
account is authorised to make 
per month (maximum 10000 
pages).

B&W COPY 
QUOTA

Defines the maximum number of 
black and white photocopies that 
the user account is authorised to 
make per month (maximum 
10000 pages).

COL. COPY 
QUOTA

Defines the maximum number of 
colour photocopies that the user 
account is authorised to make 
per month (maximum 10000 
pages).

FAX EMISS. 
QUOTA 

Defines the maximum number of 
faxes that the user account is 
authorised to send per month 
(maximum 10000 pages).

SCAN QUOTA Defines the maximum number of 
scans that the user account is 
authorised to make per month 
(maximum 10000 pages).

Note

Only the user can specify his name, email 
address and record his fingerprint in his 
user account (see Personalising your user 
account / fingerprint [ 22]).

Property Description

Note

You must have machine administrator rights 
to access this function.

Note

You must have machine administrator rights 
to access this function.
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Printing the list of user accounts

For each user account on the machine, the print-out of the 
list of user accounts contains the following information:
• 4-figure user code
• personalised name of the user account
• the rights and usage quotas for machine functions
Administrator rights

To print out the list of user accounts:
1 Press the MENU key.
2 Select REPORTS > USER RIGHTS.
The machine prints out the list of user accounts.

User account reports and usage 
counters

User rights management allows you to monitor and 
assess the use of the machine's functions by means of 
monthly usage counters for each user.
The machine records usage counters for each existing 
user account:
• when user rights management is activated;
• only for restricted functions (whose use is not free).
At the end of each month, the machine generates a 
secure print-out under the "Admin" user account of a 
report containing the quotas and usage counters for each 
user account. usage counters are then reset to zero.

If you have administrator rights on the machine, you can 
perform the following operations at any time:
• print out an interim report
• send an interim report by email
• export an interim report
• reset the usage counters

Printing an interim report

Printing out an interim report does not affect monthly 
print-outs of the usage counters.
To print out an interim report of usage counters:

1 Press the MENU key.
2 Select SETTINGS > [OTHER PARAMETERS] > 

RIGHTS MGT. > COUNTERS.
3 Press PRINT.
The machine prints out the interim report for the us-
age counters.

Sending an interim report

Sending an interim report does not affect monthly print-
outs of the usage counters.
This action sends an interim report of usage counters by 
email to the "Admin" user account, on the condition that 
this user account specifies an email address.
To send an interim report of usage counters:

1 Press the MENU key.
2 Select SETTINGS > [OTHER PARAMETERS] > 

RIGHTS MGT. > COUNTERS.
3 Press SEND.
The machine sends the interim report of usage 
counters to the email address specified in the "Admin" 
user account.

Resetting the usage counters

This action resets the usage counters of all user accounts 
for the current month.
To reset the usage counters:

1 Press the MENU key.
2 Select SETTINGS > [OTHER PARAMETERS] > 

RIGHTS MGT. > COUNTERS.
3 Press DELETE.
The usage counters for the current month are reset to 
zero.

Note

You must have machine administrator rights 
to access this function.

Note

If the "Admin" user account specifies an 
email address, the report is also sent by 
email.
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Photocopying 
documents
Your machine allows you to make one or several 
photocopies.
You can also configure numerous settings to make 
photocopies according to your needs.

Choosing the photocopy options 
correctly

Binding

Binding means the way printed pages are bound together 
to make up a book. Two bindings are possible: long edges 
and short edges.
Long edge binding
The pages are printed to be bound on the left margin and 
turned from right to left.

Short edge binding
The pages are printed to be bound at the top and turned 
from bottom to top.

Mosaic copy

Mosaic copying allows several pages to be photocopied 
on 1 page. The possible combinations are WITHOUT (1 -
> 1), 2 -> 1 or 4 -> 1.
This mode is only available for the autofeed scanner.

Poster copy

Poster mode allows one page to be photocopied onto 
several pages. The possible combinations are NONE (1 -
> 1), 1 -> 4 or 1 -> 9.
This mode is only available for the flatbed scanner.
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Zoom

The zoom parameter is used to enlarge or reduce the 
original document. The zoom value is between 25% and 
400%.
The configuration of this function depends on two 
parameters, SCALE and ZOOM. The following table 
summarizes the possibilities available according to the 
defined values:

 

Simple photocopy

In this case, the default settings are applied.
Cancelling an operation

1 Insert the document to photocopy (see section 
Inserting original documents [ 20]).

2 Press COPY.
3 Enter the number of copies required and press OK.

4 Press  to photocopy the document in black and 

white or  to photocopy the document in colour.
User rights

Duplex photocopying
Cancelling an operation

1 Insert the document to photocopy (see section 
Inserting original documents [ 20]).

2 Press COPY.
3 Enter the number of copies required and press OK.

The first settings appear on the screen. Use 
OTHER PARAMETERS to access all available 
settings.

4 Press DUPLEX.
5 Select the required option from the list. Press OK to 

confirm.
 

6 To change the binding type, press BINDING 
EDGE. Select the required option from the list (see 
section Binding [ 47]). Press OK to confirm.

7 Press  to photocopy the document in black and 

white or  to photocopy the document in colour.
User rights

Photocopy with toner saving

TONER SAVE mode is used to reduce the quantity of 
toner consumed on the page and thus reduce printing 
costs.
When using this mode, the consumption of toner is 
reduced and the print is lighter.
Cancelling an operation

1 Insert the document to photocopy (see section 
Inserting original documents [ 20]).

2 Press COPY.
3 Enter the number of copies required and press OK.
4 Press TONER SAVE.
5 Select the required status from the list.
6 Press OK to confirm the new setting.

SCALE ZOOM

1:1 Inactive

ZOOM The zoom value is defined in the 
ZOOM parameter. This value 
can be entered or selected from 
the list of predefined values.

FORMAT 
CONVERS.

Scaling is automatic depending 
on the paper formats defined in 
the SCAN FORMAT and 
PRINTED PAPER parameters.

Note

You may cancel an operation at any time by 

pressing .

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

You may cancel an operation at any time by 

pressing .

Duplex mode Description

DUPLEX -> 
DUPLEX

input document duplex 
output document duplex

FRONT -> 
DUPLEX

input document reverse side only
output document duplex

DUPLEX -> 
FRONT

input document duplex 
output document reverse side 
only

FRONT -> 
FRONT

input document reverse side only
output document reverse side 
only

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

You may cancel an operation at any time by 

pressing .
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7 Press  to photocopy the document in black and 

white or  to photocopy the document in colour.
User rights

Elaborated photocopy

Elaborated copies are used to set specific settings for the 
current photocopy.

1 Insert the document to photocopy (see section 
Inserting original documents [ 20]).

2 Press COPY.
3 Enter the number of copies required and press OK.

The first settings appear on the screen. Use 
OTHER PARAMETERS to access all available 
settings.

4 To change the resolution, press QUALITY. Select 
the most suitable resolution for your document 
from the options available and press OK to confirm.

 

5 To change the contrast, press CONTRAST. Select 
the most suitable contrast for your document from 
the available options. Press OK to confirm.

6 To change the luminosity, press BRIGHTNESS. 
Select the most suitable luminosity for your docu-
ment from the available options. Press OK to con-
firm.

7 To activate / deactivate the assembled option, 
press COLLATE COPY. Select the required op-
tion. Press OK to confirm.

 

8 If the finisher option is installed on the machine, 
you can select the output tray and the finish for the 
photocopied document. Press OUTPUT 
FINISHING. Select the required option from the list. 
Press OK to confirm.

 

9 Press PAPER TYPE. Select the paper type used 
from the list. Press OK to confirm.

10 To change the size of the photocopied document, 
press SCALE.

 

11 To modify the analysis format, press SCAN 
FORMAT. Select the paper format of the original 
document in the list. Press OK to confirm.

12 To define the output document format, press 
PRINTED PAPER. Select the required option in 
the list and press OK to confirm.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Resolu-
tion Description

SPEED Low resolution.

NORMAL Resolution suited for documents with 
frames (magazines, cover pages, 
etc.). Use this resolution to prevent 
dithering problems.

TEXT Resolution suitable for documents 
containing text.

TEXT AND 
IMAGE

Resolution suitable for documents 
containing text and colour images.

PHOTO Resolution suitable for documents 
containing colour images, 
photographs.

Assem-
bled op-

tion
Description

YES The printer assembles the copies of 
the original document.
E.g.: If you make three copies of a 
10-page document, the document is 
copied three times from page 1 to 10.

NO The printer does not assemble the 
copies of the original document.
E.g.: If you make three copies of a 
10-page document, page 1 is copied 
three times, then page 2, then page 
3 and so on.

Option Description

UPPER TRAY The photocopied document exits 
on the finisher's upper output tray.

LOWER 
TRAY

The photocopied document exits 
on the finisher's lower output tray.

LWR TRAY 
STAPLED

The photocopied document is 
stapled and exits on the finisher's 
lower output tray.

LOW. TRAY 
SHIFTED

The photocopied document is 
offset and exits on the finisher's 
lower output tray.

Option Description

1:1 The document is printed in scale 
1.

ZOOM When this option is activated, the 
value defined in the ZOOM 
parameter is taken into account.

FORMAT 
CONVERS.

Scaling is automatic depending 
on the paper formats defined in 
the SCAN FORMAT and 
PRINTED PAPER parameters.
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13 To define the zoom to be applied, press ZOOM. 
Enter the required zoom value using the virtual key-
board or select a value from the predefined values 
in the list. Press OK to confirm.

14 If you are using the autofeed scanner, you can mo-
saic print your documents. Press MOSAIC and se-
lect the required option from the list (see section 
Mosaic copy [ 47]). Press OK to confirm.

15 If you are using the flatbed scanner, you can poster 
print your documents. Press BANNER and select 
the required option from the list (see section Poster 
copy [ 47]). Press OK to confirm.

16 Press  to photocopy the document in black and 

white or  to photocopy the document in colour.
User rights

Identity card photocopy
Cancelling an operation

The IDENTITY CARD Copy function is used to copy both 
sides of an identity card or a document such as a driver's 
license on a sheet of A4 format (original document size 
< A5) or a sheet in Letter format (original document size 
< Statement).
The screen displays the instructions (when the original 
document should be placed, when the document should 
be turned over, etc.) and asks your confirmation to start 
the task.

1 Press COPY.
2 Enter the number of copies required and press OK.

The first settings appear on the screen. Use 
OTHER PARAMETERS to access all available 
settings.

3 Press IDENTITY CARD. Select the required status 
from the list. Press OK to confirm.

4 To change the resolution, press QUALITY. Select 
the most suitable resolution for your document 
from the options available and press OK to confirm.

 

5 To change the contrast, press CONTRAST. Select 
the most suitable contrast for your document from 
the available options. Press OK to confirm.

6 To change the luminosity, press BRIGHTNESS. 
Select the most suitable luminosity for your docu-
ment from the available options. Press OK to con-
firm.

7 Press PAPER TYPE. Select the paper type used 
from the list. Press OK to confirm.

8 Place your identity card or other official document 
against the flatbed scanner glass, as indicated be-
low:

9 Press  to photocopy the document in black and 

white or  to photocopy the document in colour.
The document is scanned.

10 Turn the document over and press OK to confirm.
The machine prints out a copy of your document.
User rights

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

You may cancel an operation at any time by 

pressing .

Resolu-
tion Description

SPEED Low resolution.

NORMAL Resolution suited for documents with 
frames (magazines, cover pages, 
etc.). Use this resolution to prevent 
dithering problems.

TEXT Resolution suitable for documents 
containing text.

TEXT AND 
IMAGE

Resolution suitable for documents 
containing text and colour images.

PHOTO Resolution suitable for documents 
containing colour images, 
photographs.

Note

For best results, select PHOTO resolution.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Resolu-
tion Description
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Faxing 

documents
Sending faxes

Simple emission
Cancelling an operation

1 Insert the document to fax (see section Inserting 
original documents [ 20]).

2 Press FAX.
3 Enter the number of the recipient using the virtual 

keyboard or the keypad or select the recipient as 
follows:

 

4 To add other recipients, press  and specify the 
second recipient (see previous step). Repeat the 
operation for each recipient to add (maximum 10 
contacts or lists of contacts).

5 Press  or  to send the document.

User rights

Elaborate emission
Cancelling an operation

1 Insert the document to fax (see section Inserting 
original documents [ 20]).

2 Press FAX.
3 Enter the number of the recipient using the virtual 

keyboard or select the recipient as follows:

Note

You may cancel an operation at any time by 

pressing .

To select a recipi-
ent... then...

from the address 
book

In the data field Address 
book, press  then:

Select the contact or list of 
contacts required from the 
address book entries. Use 
the up and down arrows to 
view all entries in the ad-
dress book.
OR
Enter the first few letters of 
the name of your corre-
spondent using the virtual 
keyboard, and add letters 
until the full name of the re-
quired correspondent is 
displayed.
OR
Enter the figures of short 
number of your corre-
spondent using the virtual 
keyboard or the keypad un-
til the full name of the re-
quired correspondent is 
displayed.

from the 10 last 
recipients saved. Press .

Select the required recipient. 
Use the up and down arrows 
to view all recipients in the 
memory.

Note

You can delete the last recipient entered by 

pressing the  key. Repeat this until the 
first recipient entered if you want to delete 
all.

Note

You can view the recipient(s) entered by 
pressing OTHER PARAMETERS.

Note

If you are using the flatbed scanner, you can 
scan more than one page. Place the next 
page on the scanner, select NEXT. Select 
SEND when all pages have been scanned.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

You may cancel an operation at any time by 

pressing .
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4 To add other recipients, press  and specify the 
second recipient (see previous step). Repeat the 
operation for each recipient to add (maximum 10 
contacts or lists of contacts)..

5 Press OTHER PARAMETERS to access the pa-
rameters you want to change

6 Press OK to confirm the recipient(s) entered.
7 To change the resolution, press QUALITY. Select 

the most suitable resolution for your document 
from the options available and press OK to confirm.

 

8 To change the contrast, press CONTRAST. Select 
the most suitable contrast for your document from 
the available options. Press OK to confirm.

9 If you use the autofeed scanner and your document 
is double-sided, press DUPLEX to activate / deac-
tivate double-sided scanning of the document. Se-
lect the required option from the list. Press OK to 
confirm.

10 To specify the number of pages in the document 
before sending, press NUMBER OF PAGES. Enter 
the number of pages using the virtual keyboard or 
the number pad. Press OK to confirm.

11 To activate / deactivate the Multiple Scan option, 
press MULTIPLE SCAN. Select the option YES to 
activate or NO to deactivate it (see Using the 
Multiple Scan option correctly [ 20]). Press OK to 
confirm.

12 Press  or  to send the document.

User rights

To select a recipi-
ent... then...

from the address 
book

In the data field Address 
book, press  then:

Select the contact or list of 
contacts required from the 
address book entries. Use 
the up and down arrows to 
view all entries in the ad-
dress book.
OR
Enter the first few letters of 
the name of your corre-
spondent using the virtual 
keyboard, and add letters 
until the full name of the re-
quired correspondent is 
displayed.
OR
Enter the figures of short 
number of your corre-
spondent using the virtual 
keyboard or the keypad un-
til the full name of the re-
quired correspondent is 
displayed.

from the 10 last 
recipients saved. Press .

Select the required recipient. 
Use the up and down arrows 
to view all recipients in the 
memory.

Note

You can delete the last recipient entered by 

pressing the  key. Repeat this until the 
first recipient entered if you want to delete 
all.

Note

You can view the recipient(s) entered by 
pressing OTHER PARAMETERS.

Quality Description

NORMAL Resolution suitable for good quality 
documents not containing drawings 
and/or small details.

FINE Resolution suitable for documents 
containing drawings or small 
characters.

SUPER 
FINE

Resolution suitable for documents 
containing drawings (with fine lines) 
or very small characters (on the 
conditions that the receiving fax 
machine can process them).

PHOTO Resolution suitable for documents 
containing colour images and/or 
photographs.

Note

If you are using the flatbed scanner, you can 
scan more than one page. Place the next 
page on the scanner, select NEXT. Select 
SEND when all pages have been scanned.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.
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Deferred emission

This function allows you to send a document later.
To plan a deferred emission:
Cancelling an operation

1 Insert the document to fax (see section Inserting 
original documents [ 20]).

2 Press FAX.
3 Enter the number of the recipient using the virtual 

keyboard or select the recipient as follows:
 

4 To add other recipients, press  and specify the 
second recipient (see previous step). Repeat the 
operation for each recipient to add (maximum 10 
contacts or lists of contacts)..

5 Press OTHER PARAMETERS to access the pa-
rameters you want to change

6 To modify the send date, press DATE. Enter the re-
quired date using the virtual keyboard. Use the  
and  keys to pass from one character to the next. 
In the event of an error, use the  key to delete 
a character. Press OK to confirm.

7 To modify the send time, press TIME. Enter the re-
quired time using the virtual keyboard. Use the  
and  keys to pass from one character to the next. 
In the event of an error, use the  key to delete 
a character. Press OK to confirm.

8 Press  or  to send the document.

You document is saved and placed on standby in the 
send queue. It will be sent at the planned date and time.
User rights

Stopping an emission in progress 

It is possible to stop an emission in progress whatever the 
emission type, but it will differ depending on whether the 
emission is to one or several recipients.
• For an emission to one recipient, the document is de-

leted.
• For an emission to several recipients, only the recipi-

ent for the document in progress when the emission is 
stopped is deleted from the emission queue.

To stop an emission in progress :

1 Press .
A message asking you to confirm the cancellation 
is displayed on the screen.

2 Press OK to confirm cancelling the emission in 
progress.

For several recipients, you can delete the other recipients 
from the emission queue (see Deleting a document 
awaiting emission [ 54]).
If the machine is configured to print out an emission report 
(see the section Emission report [ 29]), it will be printed 
out, indicating that the communication was stopped at the 
request of the user.

Note
You may cancel an operation at any time by 

pressing .

To select a recipi-
ent... then...

from the address 
book

In the data field Address 
book, press  then:

Select the contact or list of 
contacts required from the 
address book entries. Use 
the up and down arrows to 
view all entries in the ad-
dress book.
OR
Enter the first few letters of 
the name of your corre-
spondent using the virtual 
keyboard, and add letters 
until the full name of the re-
quired correspondent is 
displayed.
OR
Enter the figures of short 
number of your corre-
spondent using the virtual 
keyboard or the keypad un-
til the full name of the re-
quired correspondent is 
displayed.

from the 10 last 
recipients saved. Press .

Select the required recipient. 
Use the up and down arrows 
to view all recipients in the 
memory.

Note
You can delete the last recipient entered by 

pressing the  key. Repeat this until the 
first recipient entered if you want to delete 
all.

Note

You can view the recipient(s) entered by 
pressing OTHER PARAMETERS.

Note
If you are using the flatbed scanner, you can 
scan more than one page. Place the next 
page on the scanner, select NEXT. Select 
SEND when all pages have been scanned.

Note
Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.
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Receiving faxes

The reception of faxes depends on the configuration of 
your machine.
By default, the machine prints out the faxes as and when 
they are received.
If the administrator has activated secure printing of 
received faxes, users wishing to recover a document 
saved in the memory, must manually force printing from 
the machine's print queue.
The settings for customizing printing of received faxes are 
described in the section Fax reception settings [ 30].

Printing received faxes in the memory

When secure printing of received documents is active, the 
machine saves the faxes received in the memory to 
preserve confidentiality.
To recover a fax received and saved in the memory:
User rights

1 Press MENU.
2 Press PRINT QUEUE.
3 Press PRINT.

The faxes received and saved in the memory are 
identified by FAX HELD.

4 Select the required fax.
The machine prints out the fax selected.

Monitoring fax emissions

The emission queue contains requests:
• currently being sent,
• awaiting emission (preceded by other requests or 

awaiting a new emission attempt),
• deferred,
• rejected (stopped or maximum number of attempts 

reached).
Accessing the emission queue

1 Press MENU.
2 Press SEND QUEUE.

The emission queue allows you to:
• Force a request (on standby or rejected) to be sent
• Edit the recipient(s) for an emission request (on stand-

by)
• Edit the date / time of an emission request
• Delete an emission request (on standby or rejected) 
• Print out a document awaiting emission

Forcing an emission request

To force sending or resend a fax that is on standby or has 
been rejected:

1 Press SEND.
The faxes are identified by FAX.

2 Select the required emission request and press 
OK.

You emission request becomes the priority. The 
corresponding document is sent once the telephone line 
is available.

Editing an emission request

To edit an emission request from the emission queue:
1 Press DISPLAY/EDIT.

The faxes are identified by FAX.
2 Select the required emission request and press 

OK.
The emission options for the selected request are 
displayed.

3 To change the recipient(s), press RECIPIENT. En-
ter the required modifications and press OK to con-
firm.

4 To modify the send date, press DATE. Enter the re-
quired date and press OK to confirm.

5 To modify the send time, press TIME. Enter the re-
quired time and press OK to confirm.

Deleting a document awaiting emission

To delete an emission request from the emission queue 
and cancel the emission:

1 Press DELETE.
The faxes are identified by FAX.

2 Select the required emission request and press 
OK.

The selected emission request disappears from the 
emission queue.

Print out a document awaiting emission

To print out a document awaiting emission:
1 Press PRINT.

The faxes are identified by FAX.
2 Select the required emission request and press 

OK.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

Deleting an emission request is irreversible.
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Printing 
documents
Your machine offers numerous printing options.
In particular, you can configure numerous settings to print 
documents according to your needs.
User rights

Prerequisites

To be able to print on the machine, you must first have 
installed the print drivers available in the PC Kit on your 
computer.
For more information, consult the section PC functions 
[ 77].

Choosing print options correctly

In this section you will find a description for each tab of the 
printing options available in the machine's print driver.
To access these options, launch a print from your 
computer, select the machine from the list of available 
printers and click on the print options.
A preview allows you to check the print options applied to 
your document in real time.

Paper tab

This tab allows you to:
• specify the number of copies of the document to be 

printed. When printing several copies, remember to 
use the copy assembly option.

• define the paper format and type to be used to print 
the document according to the paper formats and 
types loaded in the machine's paper trays, or activate 
automatic selection and verification of the paper to be 
used by the machine.

• If the finisher option is installed on the machine, you 
can select the output tray and the finish for the print-
ed document:
– printed document exits on the lower finisher tray

– printed document exits on the upper finisher tray

– printed document stapled and exits on the upper 
finisher tray

– printed document offset and exits on the upper 
finisher tray

• activate duplex printing of the document by selecting 
the type of binding required: long edges or short edges 
(see the section Binding [ 47]).

• specify the orientation of the document to be printed 
(portrait or landscape) or apply a 180° rotation.

• print several pages of the document on the same 
page (16 maximum), insert a surround, modify the lay-
out.
Printing in booklet mode allows you to print the doc-
ument on double format paper of the specified docu-
ment format. In this way you can fold the document in 
two to make a booklet.

Custom sizes tab

This tab allows you to:
• create a personalised paper format. The personalized 

paper format will then be available in the list of paper 
formats offered by the machine. Before starting, en-
sure that the paper format you want to create is com-
patible with the paper formats which can be used on 
the machine (see Recommendations for paper 
[ 146]).

• edit a personalised paper format.
• delete a personalised paper format.

Job security tab

This tab allows you to:
• name  the print task to be able to identify it more easily 

in the machine's print queue. You can allocate a name 
and associate a user name to the task.

• activate / deactivate saving of the print task in the 
machine's print queue, before and / or after printing:
– hold before printing: on receiving the print task, 

the machine does not automatically print the doc-
ument. You have to manually launch printing of 
the document by forcing it directly from the ma-
chine's print queue. Don't hesitate to use this 
function if you want to be present when your doc-
ument is printed.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

The availability and access to the print opti-
ons may vary according to the operating sy-
stem used and the print drivers installed.

Note

This function is not available for PostScript 
print drivers.
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– save after printing: once the document is print-
ed, the machine does not delete the print task 
from the print queue, but saves it for subsequent 
printing. You can then manually launch printing of 
the document again by forcing it directly from the 
machine's print queue. Don't hesitate to use this 
function to make documents available for printing 
on demand.

– job life: the print task is held before printing and / 
or saved after printing for a period that you define; 
indefinitely or for a specified number of hours.

• secure printing of the document by associating a 4-
figure code or a fingerprint. On receiving the print task, 
the machine does not automatically print the docu-
ment. You have to manually launch printing of the doc-
ument by forcing it directly from the machine's print 
queue. You will then be asked for the 4-figure code or 
the fingerprint associated with the print task.
However, before using this function, consider the fol-
lowing:

– if rights management is deactivated or if the print 
function is free for all to use, you can enter the 
identification information of your choice.

– if rights management is activated and the print 
function is restricted, only authorized user ac-
counts will be able to print on the machine. If you 
user account authorizes you to print, you must en-
ter the 4-figure code or use the fingerprint associ-
ated with your user account. On receiving the print 
task, the machine will check if the identification in-
formation correspond to those in the authorized 
user account. Otherwise, the machine will delete 
the print task from the print queue.

Advanced tab

This tab allows you to:
• print front and back cover pages, and dividers.
• select the paper tray containing the front and back 

cover pages, and the dividers.
• specify the paper format and type on which to print the 

front and back cover pages, and the dividers.
• specify the print and binding margins for printing sev-

eral pages on one page or in booklet mode.

Colour tab

This tab allows you to:
• print the document in colour.
• print the document in greyscale.

Watermarks tab

This tab allows you to:
• insert a watermark in a document to be printed, on all 

pages of the document or only on the first page.
• create a personalised watermark. The personalised 

watermark will then be available in the list of water-
marks offered by the machine. Creating a watermark 
allows you to personalize the text to insert, specify the 
font characteristics and define its position in the docu-
ment.

• edit a watermark.
• delete a watermark.

Overlays tab

This tab allows you to:
• select an overlay to be used. Ensure that the format 

and orientation of the overlay to be used correspond to 
the format and orientation of the document to print.

• add or delete overlay files.
• create an overlay.
• define the superposition of an overlay and a docu-

ment.
• print the overlay on all pages, the first page, even pag-

es and odd pages.
• place the overlay in the foreground or background of 

the document to print.

Fonts tab

This tab allows you to:
• select the font usage mode.
• select the font transmission mode.

Device options tab

This tab allows you to consult the options installed on the 
machine (duplex module, additional paper tray, etc.).

Settings tab

This tab allows you to:
• restore the factory settings.
• restore the print options to their default values.
• save your most commonly used print options. Then 

you can select them directly in the selection box of set-
tings to apply to document printing. If modifications are 
made, you will be able to restore these print options.

Note

This function is only available for PostScript 
print drivers.
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Simple printing

In this case, the default settings are applied.
User rights

1 Use the command Print in the File menu of the ap-
plication open on the screen.

2 Select the machine from the list of available print-
ers.

3 Enter the number of copies to print.
4 Click OK to start printing.

You can monitor your print tasks in the print queue (see 
the section Monitoring printing [ 58]).

Duplex printing
User rights

1 Use the command Print in the File menu of the ap-
plication open on the screen.

2 Select the machine from the list of available print-
ers.

3 Click Properties to access the print options.
4 Select the Paper tab.
5 Enter the number of copies to print. When printing 

several copies, activate / deactivate the copy as-
sembly option.

6 Activate duplex printing by selecting the required 
binding: long edges or short edges.

7 Click OK to start printing.
You can monitor your print tasks in the print queue (see 
the section Monitoring printing [ 58]).

Secure printing

In order to guarantee confidentiality of your prints, you 
can secure printing of a document by associating a 4-
figure code or a fingerprint.
On receiving the print task, the machine does not 
automatically print the document.
You have to manually launch printing of the document by 
forcing it directly from the machine's print queue. You will 
then be asked for the 4-figure code or the fingerprint 
associated with the print task.
However, before using this function, consider the 
following:
• if rights management is deactivated or if the print func-

tion is free for all to use, you can enter the identification 
information of your choice.

• if rights management is activated and the print function 
is restricted, only authorized user accounts will be able 
to print on the machine. If you user account authorizes 
you to print, you must enter the 4-figure code or use 
the fingerprint associated with your user account. On 
receiving the print task, the machine will check if the 
identification information correspond to those in the 
authorized user account. Otherwise, the machine will 
delete the print task from the print queue.

Receiving your fingerprint

To save and receive your fingerprint in the form of an 
electronic file:

1 Press MENU.
2 Select OTHER COMMANDS > IDENTIFICATION 

> SEND FINGERPRINT.
3 Press RECIPIENT(S). Enter your email address 

using the virtual keyboard. In the event of an error, 
use the  key to delete a character. Press 
OTHER PARAMETERS to confirm.

4 To copy the email to other recipients, press CC 
RECIPIENT(S). Specify the recipient(s) on copy, 
and press OK to confirm.

5 Press SUBJECT. Enter the subject of the email us-
ing the virtual keyboard (80 characters maximum). 
In the event of an error, use the  key to delete 
a character. Press OTHER PARAMETERS to con-
firm.

6 To customize the name of the attachment, press 
FILENAME. Enter the file name using the virtual 
keyboard (maximum 20 characters). In the event of 
an error, use the  key to delete a character. 
Press OK to confirm.

7 Press  or .
The procedure to save your fingerprint is 
launched.

8 Place the finger you will always use, your reference 
finger, on the fingerprint reader and slide it slowly 
downwards. The machine informs you when the 
option is successful.

The fingerprint is scanned and the email message is 
saved. Depending on the machine configuration, the 
email is sent via the local network or during the next 
planned internet connection.
To force the internet connection and send / receive 
emails, press MENU then select INTERNET> MAIL / 
PHONE.
On receipt of the email, just copy the file containing the 
fingerprint to your computer's hard disk.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

If you have a user account, you can save 
your fingerprint and receive it at your email 
address. To do so, personalize your user in-
formation (see Personalising your user 
account / fingerprint [ 22]).
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Launching secure printing

To launch secure printing from your computer:
User rights

1 Use the command Print in the File menu of the ap-
plication open on the screen.

2 Select the machine from the list of available print-
ers.

3 Click Properties to access the print options.
4 Define the print options required for your document 

(number of copies, paper format, etc.).
5 Click on the Job Security tab.
6 To easily identify your secure print, enter a print 

task name and a user name.
7 To associate a 4-figure code, check the PIN box 

and enter the code.
8 To associate a fingerprint, check the Fingerprint 

box, click on Browse and select the file that con-
tains your fingerprint (see Receiving your 
fingerprint [ 57]).

9 Click OK to start printing.
The print task is saved on the machine. To recover your 
print, you must manually force it from the print queue.

Recovering/Releasing secure prints

To recover a secure print on the machine:
1 Press MENU.
2 Press PRINT QUEUE.
3 Press PRINT.

Secure prints are identified by PC HELD.
4 Select your print task from the list.

An identification screen is displayed.
5 Identify yourself with the information entered when 

you sent your print task:
enter the 4-figure code associated with the print 
task.

if you associated your fingerprint with the print 
task, place your reference finger in the fingerprint 
reader and slide it slowly downwards.

6 When the identification is successfully completed, 
the machine prints your document.

If identification fails, the machine displays an explanatory 
message (insufficient rights, unknown account, etc.). In all 
cases, contact the machine's administrator.

Cancelling a print in progress

To cancel a print in progress:

1 Press the  key.
A message asking you to confirm the cancellation 
appears on the screen.

2 Press OK to confirm cancellation of the print task in 
progress.

Monitoring printing

The print queue contains documents that are:
• currently being printed,
• awaiting printing (preceded by other print tasks),
• saved in the memory for printing,
• secured awaiting to be forced.
Accessing the print queue

1 Press the MENU key.
2 Press PRINT QUEUE.

To be able to identify documents awaiting printing, the 
print queue allocates a type to the various print tasks 
managed by the machine:

 

The print queue allows you to perform the following 
operations:
• Print out the list of saved print tasks
• Force a print task
• Edit the properties of a print task
• Delete a print task

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

The type... identifies...

PC PRINT print tasks sent from a 
computer.

FAX faxes received awaiting 
printing.

MAIL emails received awaiting 
printing.

USB KEY PRINT print tasks sent from a USB 
memory key.

PRINT REPORT

print tasks automatically 
generated by the machine 
(emission report, 
communication log) or 
launched by a user from a 
machine menu (printing of 
function guide, address book, 
settings, etc.).

PC HELD

print tasks sent from a 
computer with at least one of 
the following properties:

hold before printing
secure printing

FAX HELD
received faxes saved in the 
memory (see Receiving faxes 
[ 54]).
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Print out the list of saved print tasks

To print out the list of print tasks saved in the memory by 
the machine for subsequent printing (held after printing):

1 Press PRINT THE QUEUE.
The machine prints out the list of print tasks with the 
property "Keep After".

Force a print task

To force or reprint a document from the print queue:
1 Press PRINT.
2 Select the required print task and press OK.

You print task becomes the priority. The corresponding 
document is printed as soon as the machine is available 
to print.

Editing a print task

To edit the properties of a print task from the print queue:
1 Press DISPLAY/EDIT.
2 Select the required print task and press OK.

The properties of the selected print task are dis-
played.

3 Make the required modifications and press OK to 
confirm.

Deleting a print task

To delete a print task from the print queue:

1 Press DELETE.
2 Select the required print task and press OK.

The selected print task disappears from the print queue.

Note

Deleting a print task is irreversible.
- 59 -



MF 6990dn - Agoris C935

9 
- 

U
si

ng
 a

 U
SB

 m
em

or
y 

ke
y
Using a USB 

memory key
You can connect a USB key to the machine. The 
compatible files are analyzed and you may perform the 
following operations:
• print files from your USB key;
• scan and save a document on your USB key;
• scan the content of your USB key.

Support compatibility

The machine can read the contents of the following USB 
peripherals:

 

Recommendations for using USB 
keys

• Before using a USB key, always make a backup of its 
contents. Thus, in the event of any data loss, you will 
be able to recover the contents using the backup copy.

• Always insert your USB key in the machine without 
forcing and respecting the direction of insertion.

• Never disconnect a USB key when a read or save op-
eration is in progress.

• Remove the inserted USB key only when the machine 
has completed any printing or saving operations.

• If the machine cannot read the content of the USB key, 
check that the USB key is compatible, that it is correct-
ly inserted, and that the file formats are compatible.

Viewing the content of a USB key

When you insert a USB key into the machine, its content 
is immediately analyzed. The number of files present is 
displayed and the special menu USB KEY opens.
The USB KEY function offers you methods of display and 
selection suited to the types of documents you wish to 
print:

 

Printable files (documents and images) are displayed 
without taking account of their arborescence on the USB 
key.

Printing files from a USB key

For clarity and to help you select the right printing options 
for the type of files to be printed, this section explains the 
following operations separately:
• Printing photos from a USB key;
• Printing documents from a USB key.
It is possible to select image and document files to be 
printed in the same operation. In this case, common 
printing options (paper format, paper type, number of 
copies, etc.) will apply to all files selected.

Printing photos from a USB key

To print image files present on your USB key, proceed as 
follows:
Cancelling an operation

1 Insert your USB key into the machine respecting 
the insertion direction.

The USB key is analyzed. When the analysis is 
complete, the USB KEY menu is displayed.

2 Press PRINT.
The first settings appear on the screen. Use 
OTHER PARAMETERS to access all available 
settings.

Support Characteristics

Peripheral Mass storage peripheral 2.0 
formatted in FAT 16 or FAT 32
Maximum size 20 Gb

Files Photo / Image: JPEG
Document: TIFF, TXT, PDF

Mode Description

DOCUMENTS Only printable documents on the 
USB key are displayed in the form 
of a list.
The file names and their 
extensions are displayed to 
facilitate selection.

IMAGES Only printable image files present 
on the USB key are displayed.
The images/photos are displayed 
as thumbnails to facilitate 
selection.

Note

You may cancel an operation at any time by 

pressing .
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3 Press IMAGES to select the photos to print.

The image file selection window is displayed on 
the screen.

The left-hand side contains the list of available 
files.

The right-hand side contains the files selected for 
printing.

4 Use the up and down arrows to view all available 
files. Select the required files in the left-hand side 
using the keys:

 

5 When you have selected the files, press OK to con-
firm.

6 To change the number of copies of files to print, 
press NUMBER OF COPIES. Enter the required 
number of copies using the virtual keyboard or the 
number pad. Press OK to confirm.

7 To specify the print format of the photos, press 
IMAGE SIZE. Select the print format for image files 
and press OK to confirm.

 

8 If the finisher option is installed on the machine, 
you can select the output tray and the print finish. 
Press OUTPUT FINISHING. Select the required 
option from the list. Press OK to confirm.

 

9 To change the paper type, press PAPER TYPE. 
Select the required option in the list and press OK 
to confirm.

10 To define the output document format, press 
PRINTED PAPER. Select the required option in 
the list and press OK to confirm.

11 To activate toner-saving printing, press TONER 
SAVE and select the required status. Press OK to 
confirm.

12 Press  to print files in black and white or  to 
print files in colour.

User rights

Printing documents from a USB key

To print document files present on your USB key, proceed 
as follows:
Cancelling an operation

1 Insert your USB key into the machine respecting 
the insertion direction.

The USB key is analyzed. When the analysis is 
complete, the USB KEY menu is displayed.

2 Press PRINT.
The first settings appear on the screen. Use 
OTHER PARAMETERS to access all available 
settings.

3 Press DOCUMENTS to select the documents to 
print.

The file selection window is displayed on the 
screen.

The left-hand side contains the list of available 
files.

The right-hand side contains the files selected for 
printing.

4 Use the up and down arrows to view all available 
files. Select the required files in the left-hand side 
using the keys:

 

Key Action

Add files to the list of files to print.

Add the selected file to the list of files 
to print.

Remove the selected file from the list 
of files to print.

Remove all files from the list of files 
to print.

Format Description

PHOTO Classic 10x15 cm photo printing.

FULL PAGE Print adjusted to page format 
used.

Option Description

UPPER TRAY The print out exits on the 
finisher's upper output tray.

LOWER TRAY The print out exits on the 
finisher's lower output tray.

LWR TRAY 
STAPLED

The print out is stapled and exits 
on the finisher's lower output tray.

LOW. TRAY 
SHIFTED

The print out is offset and exits on 
the finisher's lower output tray.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

You may cancel an operation at any time by 

pressing .

Key Action

Add files to the list of files to print.

Add the selected file to the list of files 
to print.

Remove the selected file from the list 
of files to print.

Remove all files from the list of files 
to print.
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5 When you have selected the files, press OK to con-

firm.
6 To change the number of copies of files to print, 

press NUMBER OF COPIES. Enter the required 
number of copies using the virtual keyboard or the 
number pad. Press OK to confirm.

7 If you have selected documents to print on both 
sides, you can use the options DUPLEX and 
BINDING EDGE. To activate/deactivate duplex 
document printing, press DUPLEX. Select the re-
quired option in the list and press OK to confirm. 

8 To change the binding type, press BINDING 
EDGE. Select the required option from the list (see 
section Binding [ 47]). Press OK to confirm.

9 If the finisher option is installed on the machine, 
you can select the output tray and the print finish. 
Press OUTPUT FINISHING. Select the required 
option from the list. Press OK to confirm.

 

10 To change the paper type, press PAPER TYPE. 
Select the required option in the list and press OK 
to confirm.

11 To define the output document format, press 
PRINTED PAPER. Select the required option in 
the list and press OK to confirm.

12 To activate toner-saving printing, press TONER 
SAVE and select the required status. Press OK to 
confirm.

13 Press  to print files in black and white or  to 
print files in colour.

User rights

Saving a document on a USB key

This function enables you to scan and save a document 
directly to a USB key, in JPEG, PDF or Secure PDF 
format.

To scan a document and save it to a USB key, proceed as 
follows:
Cancelling an operation

1 Insert the document to scan (see section Inserting 
original documents [ 20]).

2 Insert your USB key into the machine respecting 
the insertion direction.

The USB key is analyzed. When the analysis is 
complete, the USB KEY menu is displayed.

3 Press SCAN.
The first settings appear on the screen. Use 
OTHER PARAMETERS to access all available 
settings.

4 To change the destination directory on the USB 
key, press DIRECTORY PATH. Enter the file des-
tination directory (maximum 80 characters). In the 
event of an error, use the  key to delete a char-
acter. Press OK to confirm.

5 To customize the name of the scanned file, press 
FILENAME. Enter the name using the virtual key-
board (maximum 20 characters). In the event of an 
error, use the  key to delete a character. Press 
OK to confirm.

Option Description

UPPER TRAY The print out exits on the 
finisher's upper output tray.

LOWER TRAY The print out exits on the 
finisher's lower output tray.

LWR TRAY 
STAPLED

The print out is stapled and exits 
on the finisher's lower output tray.

LOW. TRAY 
SHIFTED

The print out is offset and exits on 
the finisher's lower output tray.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

Before scanning a document, check that 
there is sufficient space on your USB key.

Note

You may cancel an operation at any time by 

pressing .

Note

You can also access this function by pres-
sing SCAN then by selecting SCAN.
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6 To customize the format of the scanned file, press 

DOCUMENT FORMAT. Select the format from the 
available options and press OK to confirm.

 

7 If you have selected SECURED PDF format, press 
PASSWORD. Enter the password using the virtual 
keyboard (maximum 20 characters). In the event of 
an error, use the  key to delete a character. 
Press OK to confirm.

8 To change the resolution, press QUALITY. Select 
the most suitable resolution for your document 
from the options available and press OK to confirm.

 

9 To change the contrast, press CONTRAST. Select 
the most suitable contrast for your document from 
the available options. Press OK to confirm.

10 If you use the autofeed scanner and your document 
is double-sided, press DUPLEX to activate / deac-
tivate double-sided scanning of the document. Se-
lect the required option in the list and press OK to 
confirm.

11 To specify the number of pages in the document 
before scanning, press NUMBER OF PAGES. En-
ter the number of pages using the virtual keyboard 
or the number pad. Press OK to confirm.

12 To activate / deactivate the Multiple Scan option, 
press MULTIPLE SCAN. Select YES to activate it 
or NO to deactivate it (see Using the Multiple Scan 
option correctly [ 20]). Press OK to confirm.

13 Press  to scan the document in black and white 

or  to scan the document in colour.

User rights

The document is scanned and saved to the inserted USB 
key.

Analyzing the content of your USB 
key

After prolonged inactivity, the machine exits the USB KEY 
menu.
To view the content of your USB key again, proceed as 
follows:

1 Press the MENU key.
2 Select [OTHER COMMANDS] > USB KEY.
3 Press KEY SCAN.
The USB key is analyzed.

Format Description

IMAGE The scanned file is in format:
TIFF (black and white docu-
ment)
JPEG (colour document)

PDF The file is scanned in PDF format 
(black and white or colour 
document).

SECURED 
PDF

The file is scanned in PDF format 
(black and white or colour), 
protected by a password which 
you can define.

Resolution Description

LIGHT Low resolution.

TEXT Resolution suitable for documents 
containing text.

TEXT AND 
IMAGE

Resolution suitable for documents 
containing text and colour 
images.

PHOTO Resolution suitable for documents 
containing colour images, 
photographs.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.
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Scanning and 
sending 
documents
You machine allows you to scan and send paper 
documents in a single operation.
The scan and send function includes several Scan to 
actions, depending on the media used:

 

You can also configure numerous settings to scan and 
send documents according to your needs.

Scan to USB Key

The Scan to USB Key function allows you to scan a 
document and save it on a USB key connected to the 
machine.
For the detailed procedure, and for information about 
compatibility and recommendations for using USB 
peripherals, see the section Using a USB memory key 
[ 60].

Scan to Mail

The Scan to Mail function allows you to scan a document 
and send it as an attachment to an email address, in 
JPEG, PDF or Secure PDF format.
To scan a document and send it as an attachment to an 
email address:

Cancelling an operation

1 Insert the document to scan (see section Inserting 
original documents [ 20]).

2 Press the SCAN key.
3 Select SCAN TO MAIL.
4 Enter the email address of the recipient using the 

virtual keyboard or select the recipient as follows:
 

5 To add other recipients, press  and specify the 
second recipient (see previous step). Repeat the 
operation for each recipient to add (maximum 10 
contacts or lists of contacts)..

Function Description

Scan to USB Key Scan a document and save it on 
a USB key connected to the 
machine.

Scan to Mail Send an email with the scanned 
document as an attachment.

Scan to File Save a scanned document in a 
file and place it directly:

on an FTP server (Scan to 
FTP) ;
in a shared directory on a com-
puter connected to the local 
network (Scan to SMB).

Scan to PC Scan a document and save it 
directly on a computer via the 
document manager associated 
with the Companion Suite Pro 
software.

Scan to Archive Scan a document and save it 
directly in the fax server 
archiving system.

Note

You may cancel an operation at any time by 

pressing .

To select a recipi-
ent... then...

from the address 
book

In the data field Address 
book, press  then:

Select the contact or list of 
contacts required from the 
address book entries. Use 
the up and down arrows to 
view all entries in the ad-
dress book.
OR
Enter the first few letters of 
the name of your corre-
spondent using the virtual 
keyboard, and add letters 
until the full name of the re-
quired correspondent is 
displayed.
OR
Enter the figures of short 
number of your corre-
spondent using the virtual 
keyboard or the keypad un-
til the full name of the re-
quired correspondent is 
displayed.

from the 10 last 
recipients saved. Press .

Select the required recipient. 
Use the up and down arrows 
to view all recipients in the 
memory.

Note
You can delete the last recipient entered by 

pressing the  key. Repeat this until the 
first recipient entered if you want to delete 
all.
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6 Press OTHER PARAMETERS to access the pa-
rameters you want to change

7 To copy the email to other recipients, press CC 
RECIPIENT. Specify the recipient(s) on copy, and 
press OK to confirm.

8 Press SUBJECT. Enter the subject of the email us-
ing the virtual keyboard (80 characters maximum). 
In the event of an error, use the  key to delete 
a character. Press OK to confirm.

9 To customize the name of the attachment, press 
FILENAME. Enter the file name using the virtual 
keyboard (maximum 20 characters). In the event of 
an error, use the  key to delete a character. 
Press OK to confirm.

10 To customize the format of the attachment, press 
DOCUMENT FORMAT. Select the format from the 
available options and press OK to confirm.

 

11 If you have selected SECURED PDF format, press 
PASSWORD. Enter the password using the virtual 
keyboard (maximum 20 characters). In the event of 
an error, use the  key to delete a character. 
Press OK to confirm.

12 To change the resolution, press QUALITY. Select 
the most suitable resolution for your document 
from the options available and press OK to confirm.

 

13 To change the contrast, press CONTRAST. Select 
the most suitable contrast for your document from 
the available options. Press OK to confirm.

14 If you use the autofeed scanner and your document 
is double-sided, press DUPLEX to activate / deac-
tivate double-sided scanning of the document. Se-
lect the required option from the list. Press OK to 
confirm.

15 To specify the number of pages in the document 
before sending, press NUMBER OF PAGES. Enter 
the number of pages using the virtual keyboard or 
the number pad. Press OK to confirm.

16 To activate / deactivate the Multiple Scan option, 
press MULTIPLE SCAN. Select the option YES to 
activate or NO to deactivate it (see Using the 
Multiple Scan option correctly [ 20]). Press OK to 
confirm.

17 Press  to send the document in black and white 

or  to send the document in colour.

User rights

The document is scanned and the email message is 
saved. Depending on the machine configuration, the 
email is sent via the local network or during the next 
planned internet connection.
To force the internet connection and send / receive 
emails, press MENU then select INTERNET> MAIL / 
PHONE.
You can monitor document emissions via the emission 
queue (see the section Monitoring document emissions 
[ 70]).

Note
You can view the recipient(s) entered by 
pressing OTHER PARAMETERS.

Format Description

IMAGE The file is sent in format:
TIFF (black and white docu-
ment)
JPEG (colour document)

PDF The file is sent in PDF format 
(black and white or colour 
document).

SECURED PDF The file is sent in PDF format 
(black and white or colour), 
protected by a password which 
you can define.

Note
Note the password entered, strictly respec-
ting the characters, upper and lower case 
letters. You will need to send it to the recipi-
ent(s). On opening the document, the pass-
word will be requested.

Resolution Description

LIGHT Low resolution.

TEXT Resolution suitable for documents 
containing text.

TEXT AND 
IMAGE

Resolution suitable for documents 
containing text and colour 
images.

PHOTO Resolution suitable for documents 
containing colour images, 
photographs.

Note

If you are using the flatbed scanner, you can 
scan more than one page. Place the next 
page on the scanner, select NEXT. Select 
SEND when all pages have been scanned.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.
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Scan to FTP

The Scan to FTP function allows you to scan a document 
in JPEG, PDF or Secure PDF format and place it on an 
FTP server, for archiving for example.
To connect to the FTP server, you need to know the FTP 
user name and the password.
When sending files, the machine connects to the FTP 
server using the defined connection settings.
To scan a document and place it on an FTP server:
Cancelling an operation

1 Insert the document to scan (see section Inserting 
original documents [ 20]).

2 Press SCAN.
3 Select SCAN TO FTP.
4 Enter the address of the FTP server using the vir-

tual keyboard or select it as follows:
 

5 Press OTHER PARAMETERS to access the pa-
rameters you want to change

6 Press NETWORK USER. Enter the FTP user 
name (80 characters maximum). In the event of an 
error, use the  key to delete a character. Press 
OK to confirm.

7 Press NETWORK PASSWD. Enter the FTP pass-
word. Press OK to confirm.

8 To specify a destination directory on the FTP serv-
er, press NETWORK PATH. Enter the file destina-
tion directory (for example: server name/John), and 
press OK to confirm.

When no directory is entered, the files are stored 
directly in the root directory of the FTP server.

9 To customize the name of the attachment, press 
FILENAME. Enter the file name using the virtual 
keyboard (maximum 20 characters). In the event of 
an error, use the  key to delete a character. 
Press OK to confirm.

10 To customize the format of the attachment, press 
DOCUMENT FORMAT. Select the format from the 
available options and press OK to confirm.

 

11 If you have selected SECURED PDF format, press 
PASSWORD. Enter the password using the virtual 
keyboard (maximum 20 characters). In the event of 
an error, use the  key to delete a character. 
Press OK to confirm.

Note

You may cancel an operation at any time by 

pressing .

To select an FTP 
address... then...

defined in an 
address book 
contact

In the data field Address 
book, press  then:

Select the contact or list of 
contacts required from the 
address book entries. Use 
the up and down arrows to 
view all entries in the ad-
dress book.
OR
Enter the first few letters of 
the name of your corre-
spondent using the virtual 
keyboard, and add letters 
until the full name of the re-
quired correspondent is 
displayed.
OR
Enter the figures of short 
number of your corre-
spondent using the virtual 
keyboard or the keypad un-
til the full name of the re-
quired correspondent is 
displayed.

Note

Emission to several recipients is not possi-
ble with this function.

Note

If you have selected the FTP address from 
the address book, the settings  NETWORK 
USER, NETWORK PASSWD and 
NETWORK PATH are automatically com-
pleted with the existing information.

Format Description

IMAGE The file is sent in format:
TIFF (black and white docu-
ment)
JPEG (colour document)

PDF The file is sent in PDF format 
(black and white or colour 
document).

SECURED PDF The file is sent in PDF format 
(black and white or colour), 
protected by a password which 
you can define.

Note
Note the password entered, strictly respec-
ting the characters, upper and lower case 
letters. You will need to send it to the recipi-
ent(s). On opening the document, the pass-
word will be requested.
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12 To change the resolution, press QUALITY. Select 
the resolution the best suited to your document 
from the options available and press OK to confirm.

 

13 To change the contrast, press CONTRAST. Select 
the most suitable contrast for your document from 
the available options. Press OK to confirm.

14 If you use the autofeed scanner and your document 
is double-sided, press DUPLEX to activate / deac-
tivate double-sided scanning of the document. Se-
lect the required option from the list. Press OK to 
confirm.

15 To specify the number of pages in the document 
before sending, press NUMBER OF PAGES. Enter 
the number of pages using the virtual keyboard or 
the number pad. Press OK to confirm.

16 To activate / deactivate the Multiple Scan option, 
press MULTIPLE SCAN. Select the option YES to 
activate or NO to deactivate it (see Using the 
Multiple Scan option correctly [ 20]). Press OK to 
confirm.

17 Press  to send the document in black and white 

or  to send the document in colour.

User rights

The document is scanned and saved. It will be placed on 
the FTP server at the next connection to the local 
network.
You can monitor document emissions via the emission 
queue (see the section Monitoring document emissions 
[ 70]).

Scan to SMB

The Scan to SMB function allows you to scan a 
document in JPEG, PDF or Secure PDF format and place 
it directly in a shared directory on a computer connected 
to the local network, on your PC for example.
To connect to the destination PC, you must know the 
name of the PC, the full path to the destination directory 
(shared address), the SMB user and its password.
The SMB address is in the following format:
• smb://Server_name/SharedFolder
• smb://Server_IP_address/SharedFolder
When sending files, the machine connects to the 
destination PC using the defined connection settings.
To scan a document and place it in a shared directory on 
a PC via the local network:
Cancelling an operation

1 Insert the document to scan (see section Inserting 
original documents [ 20]).

2 Press SCAN.
3 Select SCAN TO SMB.
4 Enter the SMB address using the virtual keyboard 

or select it as follows:
 

Resolution Description

LIGHT Low resolution.

TEXT Resolution suitable for documents 
containing text.

TEXT AND 
IMAGE

Resolution suitable for documents 
containing text and colour 
images.

PHOTO Resolution suitable for documents 
containing colour images, 
photographs.

Note

If you are using the flatbed scanner, you can 
scan more than one page. Place the next 
page on the scanner, select NEXT. Select 
SEND when all pages have been scanned.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

You may cancel an operation at any time by 

pressing .

To select an SMB 
address... then...

defined in an 
address book 
contact

In the data field Address 
book, press  then:

Select the contact or list of 
contacts required from the 
address book entries. Use 
the up and down arrows to 
view all entries in the ad-
dress book.
OR
Enter the first few letters of 
the name of your corre-
spondent using the virtual 
keyboard, and add letters 
until the full name of the re-
quired correspondent is 
displayed.
OR
Enter the figures of short 
number of your corre-
spondent using the virtual 
keyboard or the keypad un-
til the full name of the re-
quired correspondent is 
displayed.
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5 Press OTHER PARAMETERS to access the pa-
rameters you want to change

6 Press NETWORK USER. Enter the SMB user 
name (80 characters maximum). In the event of an 
error, use the  key to delete a character. Press 
OK to confirm.

7 Press NETWORK PASSWD. Enter the SMB pass-
word. Press OK to confirm.

8 To specify a destination directory in the shared di-
rectory on the destination PC, press NETWORK 
PATH. Enter the file destination directory and 
press OK to confirm.

When no directory is entered, the files are stored 
directly in the root directory of the shared directory 
on the destination PC.

9 To customize the name of the attachment, press 
FILENAME. Enter the file name using the virtual 
keyboard (maximum 20 characters). In the event of 
an error, use the  key to delete a character. 
Press OK to confirm.

10 To customize the format of the attachment, press 
DOCUMENT FORMAT. Select the format from the 
available options and press OK to confirm.

 

11 If you have selected SECURED PDF format, press 
PASSWORD. Enter the password using the virtual 
keyboard (maximum 20 characters). In the event of 
an error, use the  key to delete a character. 
Press OK to confirm.

12 To change the resolution, press QUALITY. Select 
the resolution the best suited to your document 
from the options available and press OK to confirm.

 

13 To change the contrast, press CONTRAST. Select 
the most suitable contrast for your document from 
the available options. Press OK to confirm.

14 If you use the autofeed scanner and your document 
is double-sided, press DUPLEX to activate / deac-
tivate double-sided scanning of the document. Se-
lect the required option from the list. Press OK to 
confirm.

15 To specify the number of pages in the document 
before sending, press NUMBER OF PAGES. Enter 
the number of pages using the virtual keyboard or 
the number pad. Press OK to confirm.

16 To activate / deactivate the Multiple Scan option, 
press MULTIPLE SCAN. Select the option YES to 
activate or NO to deactivate it (see Using the 
Multiple Scan option correctly [ 20]). Press OK to 
confirm.

17 Press  to send the document in black and white 

or  to send the document in colour.

User rights

Note

Emission to several recipients is not possi-
ble with this function.

Note

If you have selected the SMB address from 
the address book, the settings NETWORK 
USER, NETWORK PASSWD and 
NETWORK PATH are automatically com-
pleted with the existing information.

Format Description

IMAGE The file is sent in format:
TIFF (black and white docu-
ment)
JPEG (colour document)

PDF The file is sent in PDF format 
(black and white or colour 
document).

SECURED PDF The file is sent in PDF format 
(black and white or colour), 
protected by a password which 
you can define.

Note

Note the password entered, strictly respec-
ting the characters, upper and lower case 
letters. You will need to send it to the recipi-
ent(s). On opening the document, the pass-
word will be requested.

Resolution Description

LIGHT Low resolution.

TEXT Resolution suitable for documents 
containing text.

TEXT AND 
IMAGE

Resolution suitable for documents 
containing text and colour 
images.

PHOTO Resolution suitable for documents 
containing colour images, 
photographs.

Note

If you are using the flatbed scanner, you can 
scan more than one page. Place the next 
page on the scanner, select NEXT. Select 
SEND when all pages have been scanned.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.
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The document is scanned and saved. It will be placed in 
the shared directory on the destination PC during the next 
connection to the local network.
You can monitor document emissions via the emission 
queue (see the section Monitoring document emissions 
[ 70]).

Scan to PC

The Scan to PC function allows you to scan a document 
and save it directly to a computer via the document 
manager in the Companion Suite Pro software.
For more information on installing and configuring the 
Companion Suite Pro software, see the section PC 
Functions [ 77].
To scan a document and open it directly on a computer 
registered on the machine:
Cancelling an operation

1 Insert the document to scan (see section Inserting 
original documents [ 20]).

2 Press SCAN.
3 Select SCAN TO PC.
4 If more than one computer is registered on the ma-

chine, a list of available computers is displayed on 
the screen. Select the required computer and press 
OK to confirm.

5 Press  or  to send the document.
User rights

The document is scanned and saved on the selected 
computer, with the scan settings defined in the peripheral 
manager associated with the Companion Suite Pro 
software.

Scan to Archive

The Scan to Archive function allows you to scan a 
document and send it on your fax server for archiving.
To use this function, the fax server function must be 
activated and configured on the machine (see 
Configuring the fax server (optional) [ 32]).
To scan a document and archive it directly on your fax 
server:
Cancelling an operation

1 Insert the document to scan (see section Inserting 
original documents [ 20]).

2 Press SCAN.
3 Select SCAN TO ARCHIVE.
4 To modify the user name, press USER. Enter the 

required name using the virtual keyboard (80 char-
acters maximum, the default name is PUBLIC). 
Press OK to confirm.

5 To change the resolution, press QUALITY. Select 
the most suitable resolution for your document 
from the options available and press OK to confirm.

 

6 To change the contrast, press CONTRAST. Select 
the most suitable contrast for your document from 
the available options. Press OK to confirm.

7 If you use the autofeed scanner and your document 
is double-sided, press DUPLEX to activate / deac-
tivate double-sided scanning of the document. Se-
lect the required option from the list. Press OK to 
confirm.

8 To specify the number of pages in the document 
before sending, press NUMBER OF PAGES. Enter 
the number of pages using the virtual keyboard or 
the number pad. Press OK to confirm.

9 To activate / deactivate the Multiple Scan option, 
press MULTIPLE SCAN. Select the option YES to 
activate or NO to deactivate it (see Using the 
Multiple Scan option correctly [ 20]). Press OK to 
confirm.

10 Press  to send the document in black and white 

or  to send the document in colour.
User rights

The document is scanned and saved. It will be sent to the 
fax server for archiving during the next connection to the 
local network.
You can monitor document emissions via the emission 
queue (see the section Monitoring document emissions 
[ 70]).

Note

You may cancel an operation at any time by 

pressing .

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note
You may cancel an operation at any time by 

pressing .

Resolution Description

LIGHT Low resolution.

TEXT Resolution suitable for documents 
containing text.

TEXT AND 
IMAGE

Resolution suitable for documents 
containing text and colour 
images.

PHOTO Resolution suitable for documents 
containing colour images, 
photographs.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.
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Stopping an emission in progress 

It is possible to stop an emission in progress whatever the 
emission type, but it will differ depending on whether the 
emission is to one or several recipients.
• For an emission to one recipient, the document is de-

leted.
• For an emission to several recipients, only the recipi-

ent for the document in progress when the emission is 
stopped is deleted from the emission queue.

To stop an emission in progress :

1 Press .
A message asking you to confirm the cancellation 
is displayed on the screen.

2 Press OK to confirm cancelling the emission in 
progress.

For several recipients, you can delete the other recipients 
from the emission queue (see Deleting a document 
awaiting emission [ 71]).
If the machine is configured to print out an emission report 
(see the section Emission report [ 40]), it will be printed 
out, indicating that the communication was stopped at the 
request of the user.

Receiving emails

Emails are automatically received via the local network or 
at each internet connection, if this is configured on the 
machine.

The machine systematically prints out emails received.
Some email and attachment formats cannot be 
processed by the machine. They will be printed out with 
an indication of the elements that could not be processed. 
You will still be able to consult them directly on your email 
client.
The machine can process the following formats:

 

The settings for customizing printing of received emails 
are described in the section Print settings for received 
faxes [ 30].

Monitoring document emissions

The emission queue contains requests:
• currently being sent,
• awaiting emission (preceded by other requests or 

awaiting a new emission attempt),
• deferred,
• rejected (stopped or maximum number of attempts 

reached).
Accessing the emission queue

1 Press MENU.
2 Press SEND QUEUE.

To enable you to identify emissions, the emission queue 
allocates a type to the various Scan to emission modes:

 

The emission queue allows you to:
• Force a request (on standby or rejected) to be sent
• Edit the recipient(s) for an emission request (on stand-

by)
• Edit the destination directory for an emission request
• Delete an emission request (on standby or rejected) 
• Print the document in an emission request

Forcing an emission request

To force sending or resend a document that is on standby 
or has been rejected:

1 Press SEND.
Documents sent by email or for archiving are 
identified by MAIL or NETWORK, documents 
sent to an FTP or SMB address are identified by 
FILE or NETWORK.

2 Select the required emission request and press 
OK.

You emission request becomes the priority.

Note

To force the internet connection and send / 
receive emails, press MENU then select 
INTERNET> MAIL / PHONE.

Element Format processed

Message body TXT

Attachment TXT
TIFF
JPEG
PDF

The type... identifies emissions...

MAIL or 
NETWORK

Scan to Mail
Scan to Archive

FILE or 
NETWORK

Scan to FTP
Scan to SMB
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Editing an emission request

To edit an emission request from the emission queue:
1 Press DISPLAY/EDIT.

Documents sent by email or for archiving are 
identified by MAIL or NETWORK, documents 
sent to an FTP or SMB address are identified by 
FILE or NETWORK.

2 Select the required emission request and press 
OK.

The emission options for the selected request are 
displayed.

3 Enter the required modifications and press OK to 
confirm.

Deleting a document awaiting emission

To delete an emission request from the emission queue 
and cancel the emission:

1 Press DELETE.
Documents sent by email or for archiving are 
identified by MAIL or NETWORK, documents 
sent to an FTP or SMB address are identified by 
FILE or NETWORK.

2 Select the required emission request and press 
OK.

The selected emission request disappears from the 
emission queue.

Print out a document awaiting emission

To print out a document awaiting emission:
1 Press PRINT.
2 Select the required emission request and press 

OK.

Note

Deleting an emission request is irreversible.
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Address book
You may build up an address book by creating contacts 
and lists of contacts. You can create up to 500 contacts, 
which can be grouped in 32 contact lists.
For each contact or contact list, you can create, consult, 
edit or delete the content. You can also print out the 
address book.
If you have installed the PC kit, you can also manage your 
address book from your computer. For more information, 
consult the section PC functions [ 77].
Finally, you can save and, if necessary, restore the 
address book using the import and export functions.

Creating and managing contacts

Contact properties

Depending on the available contact details for your 
correspondents, you can create contacts for sending 
faxes, documents via email, to an FTP address or an 
SMB address.
A contact must contain the following information:

 

Creating a contact

To create a contact:
Cancelling an operation

1 Press the MENU key.
2 Select ADDRESS BOOK > CONTACTS > 

CREATE.
3 Press NAME.
4 Enter your correspondent's name using the virtual 

keyboard (maximum 16 characters). In the event of 
an error, use the  key to delete a character. 
Press OK to confirm.

5 To customize the number associated with the con-
tact, press SPEED DIAL. Enter the desired number 
using the virtual keyboard or the number pad (from 
1 to 500). Press OK to confirm.

6 To change the resolution, press QUALITY. Select 
the resolution the best suited to your document 
from the options available and press OK to confirm.

 

7 To scan the document in colour, press COLOUR. 
Select the required option in the list and press OK 
to confirm.

You can now enter the contact details, with at least one of 
the following:
• Fax number

and / or
• Network address, to select from the following possi-

bilities:
– email address

– FTP address

– SMB address
Associating a fax number

1 Press FAX NUMBER.
2 Enter your correspondent's fax number using the 

virtual keyboard or the number pad (maximum 30 
characters). Press OK to confirm.

Property Description

Name The name is used to identify 
the correspondent.
The name must be unique.

Speed dial Number associated with the 
contact, enabling rapid 
selection of the 
correspondent.
The number must be unique.

Contact details At least one of the following 
contact details:

Fax number
and / or
Network address, to select 
from the following possibili-
ties:
– email address
– FTP address
– SMB address

Note: a contact can only have 
one network address (email or 
FTP or SMB).

Note

You may cancel an operation at any time by 

pressing .

Resolution Description

LIGHT Low resolution.

TEXT Resolution suitable for documents 
containing text.

TEXT AND 
IMAGE

Resolution suitable for documents 
containing text and colour 
images.

PHOTO Resolution suitable for documents 
containing colour images, 
photographs.

Note

If the machine is connected to a switch-
board (PABX), it may be necessary to insert 
an outgoing prefix followed by a tone pause. 
This operation is not necessary if the local 
prefix has already been programmed on the 
machine (see Local prefix [ 28]).
To insert a pause after the dial tone, enter 
the symbol "/" (slash) using the virtual key-
board.
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3 If you want to force a fax emission speed for the 
contact, press SPEED. Select the required emis-
sion speed from the available values (expressed in 
bits/second) in the list and press OK to confirm.

Associating an email address
1 Press MAIL/FTP/SMB ADR.. Enter the email ad-

dress of your correspondent using the virtual key-
board. In the event of an error, use the  key to 
delete a character. Press OK to confirm.

2 Press DOCUMENT FORMAT. Select the format 
for documents sent to the contact: PDF or IMAGE. 
Press OK to confirm.

Associating an FTP address
1 Press MAIL/FTP/SMB ADR.. Enter the contact's 

FTP address (for example: 134.1.22.9) using the 
virtual keyboard or the number pad. In the event of 
an error, use the  key to delete a character. 
Press OK to confirm.

2 Press NETWORK USER. Enter the FTP user 
name (for example: John). Press OK to confirm.

3 Press NETWORK PASSWD. Enter the FTP pass-
word. Press OK to confirm.

4 Press DOCUMENT FORMAT. Select the format 
for documents sent to the contact: PDF or IMAGE. 
Press OK to confirm.

Associating an SMB address
1 Press MAIL/FTP/SMB ADR.. Enter the contact's 

SMB address (for example: smb://Server_name/
SharedFolder or smb://Server_IP_address/
SharedFolder) using the virtual keyboard or the 
number pad. The length of the SMB address is lim-
ited to 80 characters. In the event of an error, use 
the  key to delete a character. Press OK to 
confirm.

2 Press NETWORK USER. Enter the SMB user 
name (for example: John). Press OK to confirm.

3 Press NETWORK PASSWD. Enter the SMB pass-
word. Press OK to confirm.

4 Press DOCUMENT FORMAT. Select the format 
for documents sent to the contact: PDF or IMAGE. 
Press OK to confirm.

Editing a contact

To edit a contact:
Cancelling an operation

1 Press the MENU key.
2 Select ADDRESS BOOK > CONTACTS > EDIT.
3 Select the contact to edit from the scroll down list. 

You can also enter the contact's name directly us-
ing the virtual keyboard. Press OK to confirm the 
selection.

The contact properties appear on the screen.
4 Change the required properties and confirm each 

modification by pressing OK.
5 When the modifications are complete, press MENU 

to exit the address book.

Deleting a contact

To delete a contact from the address book:

1 Press the MENU key.
2 Select ADDRESS BOOK > CONTACTS > 

DELETE.
3 Select the contact to deleted from the scroll down 

list. You can also enter the contact's name directly 
using the virtual keyboard. Press OK to confirm the 
selection.

A confirmation message is displayed.
4 Press OK to confirm the deletion.
The contact is deleted from the address book. Press 
MENU to exit the address book.

Note

For communications on a good quality tele-
phone line, with no echo, the maximum 
speed is recommended.
For communications on a bad quality line, it 
may be necessary to reduce the transmissi-
on speed.

Note

You may cancel an operation at any time by 

pressing .

Note

Deletion is irreversible.
When a contact is deleted from the address 
book, it is automatically deleted from any 
lists in which it is included.
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Creating and managing contact lists

Properties of a contact list

You can create lists of contact for sending faxes and 
documents by email.
A list of contacts contains contacts that already exist in 
the address book.
A list of contacts has the following properties:

 

A list can contain correspondents with a fax number and / 
or a network address (email, FTP or SMB address).
The machine ignores the contacts in a list that do not have 
the appropriate contact details when sending a fax 
(contacts without a fax number) or an email (contacts 
without an email address).
The same correspondent can be included in several 
contact lists. However, it is not possible to include a list of 
contacts in another list of contacts.

Creating a list of contacts

To create a list of contacts:
Cancelling an operation

1 Press the MENU key.
2 Select ADDRESS BOOK > LISTS > CREATE.
3 Press NAME.
4 Enter the name of the list using the virtual keyboard 

(maximum 16 characters). In the event of an error, 
use the  key to delete a character. Press OK 
to confirm.

5 To customize the number associated with the list, 
press SPEED DIAL. Enter the desired number us-
ing the virtual keyboard or the number pad (from 1 
to 1000). Press OK to confirm.

6 Press CONTACTS to select the contacts included 
in the list.

The contact selection window is displayed on the 
screen.

The left-hand side contains existing contacts.

The right-hand side contains contacts selected for 
the list.

7 Use the up and down arrows to view all available 
contacts. Select the required contacts in the left-
hand side using the keys:

 

8 When you have comprised the list, press OK to 
confirm.

The list of contacts has been created. Press MENU to 
exit the address book.

Editing a list of contacts

To edit a list of contacts:
Cancelling an operation

1 Press the MENU key.
2 Select ADDRESS BOOK > LISTS > EDIT.
3 Select the list of contacts to edit from the scroll 

down list. You can also enter the list's name directly 
using the virtual keyboard. Press OK to confirm the 
selection.

The properties of the list of contacts is displayed 
on the screen.

4 Change the required properties and confirm each 
modification by pressing OK.

5 When the modifications are complete, press MENU 
to exit the address book.

Property Description

Name The name is used to identify the 
list of contacts.
The name must be unique.

Speed dial Number associated with a list of 
contacts, used for rapid selection.
The number must be unique.

Content All contacts in the list.

Note

You may cancel an operation at any time by 

pressing .

Key Action

Add all contacts to the list.

Add the selected contact to the list.

Remove the selected contact from 
the list.

Remove all contacts from the list.

Note

You may cancel an operation at any time by 

pressing .
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Deleting a list of contacts

To delete a list of contacts from the address book:

1 Press the MENU key.
2 Select ADDRESS BOOK > LISTS > DELETE.
3 Select the list of contacts to delete from the scroll 

down list. You can also enter the list's name directly 
using the virtual keyboard. Press OK to confirm the 
selection.

A confirmation message is displayed.
4 Press OK to confirm the deletion.
The list of contacts is deleted from the address book. 
Press MENU to exit the address book.

Printing the address book

You can print out all entries saved in the address book, 
comprising all existing contacts and lists of contacts.
To print out the address book:

1 Press the MENU key.
2 Select ADDRESS BOOK > PRINT.
The contents of the address book are printed, classi-
fied in alphabetical order. Press MENU to exit the ad-
dress book.

Accessing contacts on the LDAP 
server

When the LDAP function is activated and configured on 
the machine, you can send documents to contacts 
declared in the LDAP server directory.
By default, when a document is sent, the screen for 
entering recipients allows you to access entries in the 
address book and the BIS function.
When the LDAP function is activated, the contacts on the 
LDAP server are directly accessible from the address 
book of the machine.

Exporting / Importing the address 
book

The address book export and import functions are 
particularly useful if you wish to make a backup copy of 
the address book, restore the content of an address book 
after accidental modifications, or to configure several 
machines with the same address book.

Exporting the address book

This function is only available from the integrated website.
User rights

To export the machine's address book:
1 Go to the integrated website (see Remote 

configuration [ 23]).
2 Select the tab ADDRESS BOOK.
3 Select the menu TRANSFER PC.
4 Select EXPORT.

A file saving window opens.
5 Enter the name of the file, the destination directory 

and confirm.
The address book is exported.

Importing an address book

This function is only available from the integrated website.
User rights

You may only import address books that have been 
exported from the machine.
To import the address book:

1 Go to the integrated website (see Remote 
configuration [ 23]).

2 Select the tab ADDRESS BOOK.
3 Select the menu TRANSFER PC.
4 Select IMPORT.

A file selection window opens.
5 Select the file to import and confirm.
The address book is imported to the machine.

Note

Deletion is irreversible.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

Access to functions depends on your user 
rights. To know which rights you have, con-
sult your machine administrator.

Note

Importing an address book fully deletes the 
existing address book.
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Restoring the address book 
(Directory card option)

This function is used to import the address book from a 
previous generation machine.

The import is based on the use of directory cards on which 
the content of a previous generation address book has 
been saved. Depending on the number of entries, the 
content may have been saved on several directory cards. 
In this case, you must insert the directory cards in the 
order in which they were saved (from the first to the last).
To import the content of an address book saved on a 
directory card:

1 Insert the first directory card into the machine's 
smart card reader.

The machine analyzes the directory card con-
tents.

2 If several directory cards are required, a message 
asking you to insert the next card is displayed on 
the screen. Insert the next directory card.

When the whole address book has been ana-
lyzed, the machine displays a restoration confir-
mation message.

3 Press OK to confirm the restoration on the machine 
of the previous generation address book.

We recommend you check the entries in the address 
book and correct any contact details that may have been 
forced during the restoration (for example: absent fax 
number forced to 0).

Note

This function is only for technicians.

Note

Importing an address book fully deletes the 
existing address book.
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PC Functions

Introduction

The Companion Suite Pro software allows you to connect 
a personal computer to a compatible multifunction 
machine.
From the PC you can:
• manage a multifunction machine and configure it ac-

cording to your needs;
• print your documents on the multifunction machine 

from your usual applications;
• scan documents in colour, in grey scale or in black and 

white and edit them on your PC;
• convert them into text using the optical character rec-

ognition (OCR) application.

Required configuration

Your personal computer must have the minimum 
following characteristics:
Operating systems supported:
• Windows 2000 with Service Pack 4 minimum;
• Windows XP x86 (Home and Pro) with Service Pack 2 

minimum;
• only for the print driver: Windows Server 2003 x86 with 

Service Pack 2 minimum;
• only for the print driver: Windows Server 2008;
• Windows Vista;
• Windows 7;
• only for the print driver: Mac OS 10.3 to 10.5;
• only for the print driver: Red Hat Enterprise Linux (ver-

sion 4), Debian GNU/Linux version 3.1 and 4.0, SuSE 
Linux Enterprise Server (version 10).

A processor of:
• 800 MHz for Windows 2000;
• 1 GHz for Windows XP x86 (Home and Pro);
• 1 GHz for Windows Vista;
• 1 GHz for Windows 7.
A CD-ROM drive.
A USB port or a free local network (LAN) port.
600 Mb of free disk space for the installation.
RAM memory of:
• minimum 256 Mb for Windows 2000;
• minimum 512 Mb for Windows XP x86 (Home and 

Pro);
• 2 Gb for Windows Vista;
• 2 Gb for Windows 7.

Installing the software

This section describes the following installation 
procedures:
• complete installation of the Companion Suite Pro soft-

ware;
• installation of drivers only using the Companion Suite 

Pro software;
• installation of drivers only.

Complete installation of the software

Complete installation copies the software required to run 
the Companion Suite Pro kit on your hard disk, i.e.:
• Companion Suite Pro LH2 (machine management 

software, printer, scanner drivers, etc.) ;
• Adobe Acrobat Reader;
• PaperPort.

Switch on your PC. Open an Administration session.
1 Open the CD-ROM drive, insert the installation CD-

ROM and close the drive.
2 An installation procedure runs automatically (Auto 

run). Otherwise, double click on setup.exe in the 
CD-ROM root directory.

3 A screen entitled Companion Suite Pro LH2 ap-
pears. This screen enables you to install or unin-
stall software, access the product's user manuals 
or explore the CD-ROM content.

4 Click on Install products.
5 The production installation screen appears. Click 

on All products.
6 The welcome screen appears. Click on Next to run 

the installation of the Companion Suite Pro kit on 
your PC.

Note

Consult the Mac/Linux CD-ROM for more 
information and the installation instructions.

Note

You may already have a version of one of 
the softwares present on the installation 
CD-ROM. If this is the case, use customized 
installation, select the software you want to 
install on your hard drive and confirm your 
choice.
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7 To continue the installation, you must read and ac-
cept the software license proposed.

8 Click on Next.
9 The final installation is ready to be run. Click on 

Install.

10 A screen appears indicating the progress of the in-
stallation.

11 When the installation is complete, restart your PC 
when necessary to update the system files.

The Companion Suite Pro is now installed on your PC.

You can now connect your multifunction machine.
To connect the multifunction machine to the PC via the 
local network, consult the section Adding a peripheral 
connected to the network [ 80].
You can run the management software for your 
multifunction machine from the menu Start > All 
programmes > Companion Suite > Companion Suite 
Pro LH2 > Companion Director or by clicking on the icon 
Companion Director on your desktop.

Installing drivers using the Companion 
Suite Pro software

Switch on your PC. Open an Administration session.
1 Open the CD-ROM drive, insert the installation CD-

ROM and close the drive.
2 An installation procedure runs automatically (Auto 

run). Otherwise, double click on setup.exe in the 
CD-ROM root directory.

3 A screen entitled Companion Suite Pro LH2 ap-
pears. This screen enables you to install or unin-
stall software, access the product's user manuals 
or explore the CD-ROM content.

4 Click on Install products.
5 The production installation screen appears. Click 

on Customized.
6 Click on Companion Suite Pro LH2.
7 The welcome screen appears. Click on Next to run 

the installation of the Companion Suite Pro kit on 
your PC.

8 To continue the installation, you must read and ac-
cept the software license proposed.

9 Click on Next.

Note

If a firewall is installed, you will be asked if 
you want to authorize the application MF-
Services to access the network. Click on 
Yes or Authorize (depending on your fire-
wall) to authorize MFService.exe to access 
the network.
Some firewalls also require the port to be 
configured. Check that the ports upf 137 
and tcp 26 are open.
Note: Windows XP with Service Pack 2 and 
later and Windows Vista and Windows 7 
have a default firewall installed.
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10 Select Install Drivers in the list and click on Next.

11 Select the destination directory for installation and 
click on Next.

12 The final installation is ready to be run. Click on 
Install.

13 A screen indicates the progress of the installation.
14 Click on OK to complete the installation.

When the installation is complete, restart your PC when 
necessary to update the system files.
The Companion Suite Pro is now installed on your PC.
You can now connect your multifunction machine.
To connect the multifunction machine to the PC via the 
local network, consult the section Adding a peripheral 
connected to the network [ 80].

Manual installation of the drivers

You can manually install the drivers for the printer and the 
scanner without running the configuration software.

LAN (local network) printer and scanner drivers

It is possible to add the LAN (local network) printers 
without installing the Companion Suite Pro software.
From the Printers window (Start > Control Panel > 
Printers and faxes or Start > Control Panel > Hardware 
and sound > Printer, depending on the operating 
system), select "Add a printer" and follow the instructions 
on the screen.
When the drivers are requested, insert the installation 
CD-ROM. The drivers are automatically detected.

Installing PostScript printer drivers

If you wish to install PostScript print drivers on your 
multifunction machine:

1 Connect to the Adobe website (http://
www.adobe.com/support/downloads/
product.jsp?product=44&platform=Windows) and 
download the appropriate universal driver installer.

2 Run the installation file on your computer and fol-
low the instructions on the screen.

3 When you are asked for the PPD file, insert the in-
stallation CD-ROM Companion Suite Pro. The 
PPD file is in the Drivers/PPD directory.

The PostScript printer is identified by default as 
Companion Suite Pro LH2 PS.

Monitoring the multifunction machine

The software you have installed contains two applications 
to manage the multifunction machine, Companion 
Director and Companion Monitor, that enable you to:
• check that your multifunction machine is properly con-

nected to your PC;
• monitor the activities of your multifunction machine 

graphically;
• monitor the status of machine consumables from your 

PC;
• rapidly access image editing applications.

Note

If you decide to install the drivers manually, 
some advanced functions will not be availa-
ble. To benefit fully from all the functions of 
the Companion Suite Pro software, do a 
complete installation (see Complete 
installation of the software [ 77]).

Note

This installation mode is only possible in 
Windows 2000, XP, Vista and 7.
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To manage the multifunction machine, run the application 
Companion Director by clicking on the icon on your 
desktop or from the menu Start > All programmes > 
Companion Suite > Companion Suite Pro LH2 > 
Companion Director.
To check that the connection between the PC and the 
multifunction machine is OK, run the application 
Companion Monitor by clicking on the icon on your 
desktop or from the menu Start > All programmes > 
Companion Suite > Companion Suite Pro LH2 > 
Companion Monitor.

Companion Director

This graphic interface enables you to run utilities and 
software to manage your multifunction machine.

Graphic presentation

Run the application by clicking on the Companion 
Director icon on your desktop or from the menu Start > 
All programmes > Companion Suite > Companion 
Suite Pro LH2 > Companion Director.

Activating utilities and applications

The graphic interface Companion Suite Pro enables you 
to run the following utilities and software:
• access the Help in this manual;
• run the PaperPort software (Doc Manager).
To run a utility or a software present in the Companion 
Suite Pro kit, place your cursor on it and click on the left 
button of the mouse.

Companion Monitor

Graphic presentation

Run the application Companion Monitor by clicking on 
the icon on your desktop or from the menu Start > All 
programmes > Companion Suite > Companion Suite 
Pro LH2 > Companion Monitor.

From this screen you can monitor the information or 
configure your multifunction machine from the tabs:
• Device selection: Display the list of peripherals man-

aged by the PC.
• Consumables: Display the status of consumables.
• Links: Display the links to the machine parameters 

and the address book.

Peripheral management

This tab displays the list of peripherals managed by the 
PC.

Adding a peripheral connected to the network

You can connect your multifunction machine to the 
network.

1 Run the application Companion Monitor by click-
ing on the icon on your desktop or from the menu 
Start > All programmes > Companion Suite > 
Companion Suite Pro LH2 > Companion 
Monitor.

2 Click on the + sign or Add.

Note

The Companion Suite Pro software must be 
installed for this operation.
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3 The list of peripherals detected on the network ap-
pears. Click on Refresh to update the list.

4 Select your multifunction machine and click on 
Next.

5 To define the multifunction machine as the default 
printer, click on Yes then click on Next.

6 The following window shows the list of the various 
properties of the printer to be installed. Click on 
Next.

7 The window indicating that the installation proce-
dure was successful appears. Click on Finish.

8 Enter the name for your PC and click on OK. The 
multifunction machine will use this name to identify 
your PC.

9 Click on OK.

10 The window indicating that the installation proce-
dure was successful appears. Click on OK.

Selecting  the current peripheral

Only one peripheral can be connected at a time.
You can select the current peripheral by clicking on the 
radio button corresponding to the peripheral.

Note

 The peripherals detected appears with the 
following information:
- NetBios name (hardware identifier) or IP 
address (network identifier).
- Network name (defined by the user).
To define the name of a peripheral on the lo-
cal network, see the section Local network 
settings [ 35].

Note

Only peripherals found on the same local 
sub-network as the PC are automatically 
detected and displayed.
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Connection status

The status of the connection between the current 
peripheral and the PC is indicated by a colour code.
The following table indicates the possible connections 
statuses:

 

Peripheral parameters

1 Select a peripheral by clicking on the correspond-
ing line in the list and click on Properties to config-
ure the scanning settings to apply to this peripheral 
when you use the Scan to function.

2 Select the required scan mode from the scroll 
down list.

3 Select the required scan resolution from the scroll 
down list.

4 Select the required output format from the scroll 
down list.

 

5  Select the required Duplex Mode, by pressing the 
check box.

6 Click on OK to confirm the new settings.

Deleting a peripheral

1 Select the peripheral from the list and click on the - 
sign or on Remove.

2 To confirm deletion of the peripheral, click on Yes. 
To cancel the deletion, click on No.

The peripheral no longer appears in the list.
You can also unregister a PC from the multifunction 
machine (see section Unregistering a PC [ 40]).

Displaying the status of consumables

The following information is available in the 
Consumables tab:
• current status of consumables;
• number of pages printed;
• number of pages scanned;
• number of pages sent and received.

Colour Status

Yellow Connection in progress.

Green Connection established.

Red The PC cannot connect to the 
peripheral.
Check the connection between 
the peripheral and the PC.

Option Description

PaperPort 
TIFF

When a Scan to PC is done from 
the peripheral, the document is 
put in TIFF format and saved in 
the directory Scan to.

PaperPort 
PDF

When a Scan to PC is done from 
the peripheral, the document is 
put in PDF format and saved in 
the directory Scan to.

Mail PDF When a Scan to PC is done from 
the peripheral, your email 
application is opened and the 
document scanned is attached as 
an attachment to a new message.
Important: to use this option, a 
client email must be configured 
on your PC.
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Links

The Links tab allows you to access various configuration 
tools from the peripheral's integrated website.

The Settings link opens the page devoted to the 
peripheral settings (see section Configuring the machine 
and services [ 23] for a detailed description of the 
settings available).
The Status link opens the page devoted to the peripheral 
status enabling you to consult its activity status.
The Address Book link opens the page for the 
peripheral's address book, allowing you to view and 
manage all the contact information stored in the 
peripheral.

Companion Suite Pro functions

Document analysis

The document can be analyzed in two ways:
• using the Scan to function (application accessible 

from the Companion Director window or the machine's 
SCAN key);

• or directly from a standard compatible application.

Analysis using the Scan to function

Run the application by clicking on the Companion 
Director icon on your desktop or from the menu Start > 
All programmes > Companion Suite > Companion 
Suite Pro LH2 > Companion Director.

1 Click on the Scan to icon or press the SCAN key 
on your machine.

2 If you press the SCAN key on your machine, you 
will then have to select Scan to PC.

3 A screen displays the progress of the current scan.

4 When the scan is complete, the scanned image ap-
pears in the PaperPort window.

To scan a document from PaperPort:
1 Click on File > Scan.
2 Select the scanner of your choice: autofeed or flat-

bed scanner.

Note

If more than one computer is registered on 
the machine, a list of available computers is 
displayed on the screen. Select the required 
computer and press OK to confirm.
The available computers are identified with 
the name of the PC you entered on adding 
the peripheral (see Peripheral management 
[ 80]).

Note

If the PaperPort software is not installed on 
your PC, the scanned image will appear on 
your desktop in TIFF format.
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3 Personalize the advanced scan properties by click-
ing on the link Adjust the quality of the scanned 
picture.

4 Adjust the required settings and click on OK.
5 Click on Scan, you can follow the scan progress on 

the screen.

Optical Character Recognition (OCR)

The optical character recognition function allows you to 
create a document editable in office software from a 
paper document or an image file.
Character recognition can only occur on printed 
characters, such as printer outputs or typed text.

1 After scanning a document in the PaperPort work-
space, you can covert it into editable text.

2 Drag the view of the scanned document onto the 

NotePad icon .

3 The scanned text appears in the NotePad window.

Printing

The Color HFCv2 print driver is automatically installed on 
your PC when you install the Companion Suite Pro 
software.

Printing on the multifunction machine

The procedure to print a document on the multifunction 
machine from your PC is identical to that of a document in 

Windows.
1 Use the Print command in the File menu of the ap-

plication currently open on the screen.
2 Select the printer Color HFCv2.

For more information on the print options, see the section 
Printing documents [ 55].

Fax communications

Fax communications enables you to:
• send documents by fax, from your machine's scan-

ners, the hard disk or your PC screen;
• receive faxes;
• monitor communications, using various services: the 

outbox, the inbox, sent items, the send log and the re-
ception log.

Settings can be used to change how your machine deals 
with fax communications. You can change these settings 
to adapt fax communications to your needs. To do so, see 
the section Fax settings [ 87].

Presentation of the Fax window

 

Note

For more details on how to use this soft-
ware, consult the product's on line help.

Marker Action

1 Create a new fax.

2 Delete a fax from one of the fax 
management folders. Except for the 
Send log and Reception log folders 
for which this command will delete 
the whole log.

3 Print a fax from one of the fax 
management folders.

4 View a fax in the Viewer.

5 Access the address book.

6 Stop sending a fax (active only for 
the outbox).

7 View all faxes present in the selected 
folder in the fax manager.

8 Preview of faxes.

9 Fax manager folders.
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Sending a fax

Sending a fax from the hard disk or from the 
machine

1 Click on the  icon in the Companion Director 
window.

2 Click on New then on FAX.

3 In the zone Sources, select Scanner if your docu-
ment is in paper format or Memory if the document 
is a computer file located on your hard disk (this file 
must be in TIFF or FAX format).

4 To send your fax to a contact, enter his number in 
the Recipients field and click on  or select a con-
tact (or a group) from one of the address books in 

the field Address books and click on .
Repeat this operation as many times as neces-

sary (use the  button to delete a contact from 
the list of contacts).

5 If necessary, set the advanced options (deferred 
sending and resolution), in the Advanced Options 
tab.

6 To attach a cover page, select the Cover page tab 
and check the box With cover page. Select the 
cover page you want to include in the drop down 
menu or create a new one. For more information, 
consult the section Cover page [ 88].

7 Click on OK to send your fax to all the contacts in 
your contacts list.

If you wish, you can consult your emission request in the 
outbox.

Sending a fax from an application

This method allows you to send a document created 
using an office application directly without printing it first.

1 From your office application, select File > Print.

2 Select the printer Fax HFCv2 and click on OK.
The Fax window opens.

3 To send your fax to a contact, enter his number in 
the Recipients field and click on  or select a con-
tact (or a group) from one of the address books in 

the field Address books and click on .
Repeat this operation as many times as neces-

sary (use the  button to delete a contact from 
the list of contacts).

4 If necessary, set the advanced options (deferred 
sending and resolution), in the Advanced Options 
tab.
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5 To attach a cover page, select the Cover page tab 
and check the box With cover page. Select the 
cover page you want to include in the drop down 
menu or create a new one. For more information, 
consult the section Cover page [ 88].

6 Click on OK to send your fax to all the contacts in 
your contacts list.

If you wish, you can consult your emission request in the 
outbox.

Receiving a fax

The windows Companion FAX Manager and 
Companion Director use various messages to indicate 

that a fax is being received. The  icon appears at the 
bottom of the window Companion FAX Manager and the 

 icon appears in the task bar.
You can automatically print out faxes once they have 
been received. To do so, you must define this setting. See 
the section Fax settings [ 87].

Monitoring fax communications

You can monitor fax communications via:
• an outbox;
• an inbox;
• an emission memory (sent items);
• a send log;
• a reception log.
These services enable you to monitor precisely the 
machine's communications, both sent and received.
The send and reception logs are automatically printed out 
when their content reaches a full page. After the 
automatic print-out, the machine creates a new log.

The outbox

The fax outbox contains:
• requests currently being sent;
• deferred emission requests;
• requests for which several attempts have been made 

and which are about to be reattempted;
• requests which have been rejected (failed calls).

Rejected requests are listed at the end so they are 
accessible if you want to resend them or delete them.
The requests are listed in the order they will be dealt with.

The send memory

The send memory allows you to save all the faxes you 
have sent.
The following information is contained in the send 
memory:
• the fax recipient;
• the date of creation of the fax;
• the date the fax was sent;
• the size of the fax.

The send log

The send log saves the history of all fax communications 
(successful or rejected) made by the machine. The log is 
automatically printed out when its content reaches a full 
page.

The log contains the following information:
• the fax recipient;
• the date the fax was sent;
• the fax status (sent, rejected, etc.).

The reception log

The reception log saves the history of all faxes received 
by the machine. The log is automatically printed out when 
its content reaches a full page.

The reception log contains the following information:
• the fax sender;
• the date of reception of the fax;
• the type of reception (on the machine or on the PC);
• the fax status.

Note

The Delete button can be used to delete the 
whole log, and not just the selected messa-
ge(s).

Note

The Delete button can be used to delete the 
whole log, and not just the selected messa-
ge(s).
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Fax settings

Accessing the Fax settings

1 Click on the  icon in the Companion Director 
window.

2 Select Tools > Options > Fax.
3 Adjust the required settings referring to the descrip-

tion of the settings below and confirm by clicking on 
OK.

Description of the Logs and reports tab

 

Description of the Fax parameters tab

 

Option Description

Automatic 
printing of a 
received 
document

The fax is automatically 
printed when it is received.

Print a reception 
report

A reception report is printed 
for each fax received.

Automatic 
printing of a 
reception log

The log is automatically 
printed out when its content 
reaches a full page.

Automatic 
printing of the 
sent document

The fax is automatically 
printed when it is sent.

Print the send 
report

An emission report is printed 
out each time a fax is sent.

Print the send log The log is automatically 
printed out when its content 
reaches a full page.

Option Description

Sending speed Default fax emission speed.

Line number Number of the telephone line 
to which your machine is 
connected.

Dialling prefix This dialling prefix is 
automatically inserted in front 
of the number before a fax is 
sent on this line.

Dialling type Must be set according to the 
type of telephone exchange to 
which your machine is 
connected.

ECM Corrects communication 
errors due to line disturbance. 
This option guarantees the 
integrity of documents 
received. However, 
communication times may be 
longer if the link is poor.

Number of tries Number of attempts to be 
made by the machine in the 
event of emission failure.

Interval between 
tries

Time between two emission 
attempts.
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Cover page

The cover page is part of a faxed document automatically 
generated by your machine in which information 
concerning the sender, the recipient, the send date and 
time, comments, etc., appear.
This page can be sent alone or as the first page of a fax, 
but always in the same communication as the fax. It is 
possible to send a document with a cover page from the 
multifunction machine or from the hard disk. In the latter 
case, part of the information on the cover page can be 
entered by the user on the emission request. A cover 
page template must be created before sending a 
document using it. However, once the cover page is 
created, a cover page template can be used for all sent 
documents.
Your machine allows you to create and personalize 
several cover pages templates that can be selected for an 
emission.

Creating a cover page template

Creating a cover page template creates a template in 
which fields (fax number, comment, subject, etc.) will be 
completed automatically by the Fax application using the 
information provided for each document recipient.
There are two steps to creating the cover page template:
• First step: Create a background image with the re-

quired logos and page formatting.
• Second step: Add the field you want to be displayed 

on the cover page: fax number, comment, subject, etc.
As mentioned before, these fields will be completed 
by the Fax application when the document is sent.

Creating a background image

For the first step, there are two ways of creating a 
background image. 
You can:
• Option (A): Design this background image in another 

application (such as Word, Excel, etc.);
OR
• Option (B): Scan a sheet of paper containing the page 

formatting of the cover page.
Details concerning option A and option B:
Option (A):

1 Open the application you want to use to edit the 
background (Word, Excel, etc.).

2 Design the background image and print this docu-
ment using the printer called Fax HFCv2.

The Send FAX dialogue box opens:

3 Add the recipients to the list of recipients. Click on 
the tab Advanced options and select the resolu-
tion Fine as indicated below:

4 Click on  to save the background image. 
The background image is created in the folder C:\Pro-
gram Files\Companion Suite Pro LH2\Docu-
ments\FAX\Temporary and has the file extension .fax.

Option (B):
1 Run Companion FAX Manager, select New > Fax 

and select the scanner as the source as indicated 
below:
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2 Add the recipients to the list of recipients. Click on 
the tab Advanced options and select the resolu-
tion Fine as indicated below:

3 Click on  to save the background image.
The background image is created in the folder C:\Pro-
gram Files\Companion Suite Pro LH2\Docu-
ments\FAX\Temporary and has the file extension .fax.

Whether you choose option A or B, a background image 
with the extension .fax is created in C:\Program 
Files\Companion Suite Pro 
LH2\Documents\FAX\Temporary.
You can now proceed to the second step described 
below.

Adding information fields

Now that the background image is created in C:\Program 
Files\Companion Suite Pro 
LH2\Documents\FAX\Temporary, you can add the 
required fields on the cover page background image:
To do so:

1 Run Companion FAX Manager, select New > 
Fax, click on the tab Cover page and click on the 
box With cover page.

2 Click on the New button. The cover page Creation 
page is displayed.

3 Click on Open in the tool bar, switch the file filter to 
*.fax and go to the directory C:\Program Files\Com-
panion Suite Pro LH2\Documents\FAX\Temporary 
containing the background image you created in 
the first step.

4 Click on the button Fields in the tool bar. A window 
opens enabling you to add the fields to the back-
ground image.

5 Click on Save to save the cover page template and 
exit this window.

6 The New Fax window opens. You can now select 
the cover page template that you want to use. By 
double clicking on the preview in the lower right-
hand corner, another window opens, displaying a 
preview of the cover page with the fields completed 
with the recipients contact details.

Creating a cover page

1 From the tab Cover page, click on New.
2 Select the cover page template you created from 

the menu File. 
A window opens containing the cover page tem-
plate you created:

3 Click on the  icon to display the fields available.

Note

A cover page template must be created be-
fore sending a fax using it.
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4 To add a field: 
- Select the field you want to insert by checking the 
available fields. A stamp appears as the mouse 
cursor.
- Click on the location in the template where you 
want to insert the field.
- You can move or enlarge the field as required.

5 When the fields have been inserted, save the cover 
page.

This cover page can then be selected in the tab Cover 
page of the fax emission window.

Description of the Cover page tab

 

Uninstalling the software

This section describes the following procedures:
• complete uninstallation of the Companion Suite Pro 

software,
• uninstallation of drivers only.

Complete uninstallation of the software

Switch on your PC. Open an Administration session.
Run the uninstall programme from the menu Start > All 
programmes > Companion Suite > Companion Suite 
Pro LH2 > Uninstall.

1 A confirmation window appears. Click on Yes to 
continue uninstalling the Companion Suite Pro pro-
gramme.

2 The uninstall programme starts. You can cancel 
the uninstall by clicking on Cancel.

3 Click on OK.

4 You will need to restart your system when the pro-
cedure is complete. Click on Yes.

Note

Adjust the size of your field boxes so that 
the text is legible.

Option Description

Name of the 
cover page

Name of the page selected by 
default or the name of the 
page you have chosen to use.

Sender You can enter information 
concerning the sender.

Recipient You can enter information 
concerning the recipient.
If the term Auto appears in one 
of the fields, the field is 
updated on emission if the 
recipient is in the address 
book.

Comments This is an editing window with 
all the basic functions of a text 
editor enabling you to enter a 
text that will be sent on the 
cover page.

Template preview A preview for viewing the 
cover page to be sent.
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Uninstalling the drivers

Switch on your PC. Open an Administration session.
Depending on the installation method used, select the 
appropriate uninstall mode:
• If you installed the drivers using the Companion Suite 

Pro software, consult the section Uninstalling drivers 
using the Companion Suite Pro software [ 91].

• If you installed the drivers manually, consult the sec-
tion Manually uninstalling the drivers [ 91].

Uninstalling drivers using the Companion Suite 
Pro software

Run the uninstall programme from the menu Start > All 
programmes > Companion Suite > Companion Suite 
Pro LH2 > Uninstall.

1 A confirmation window appears. Click on Yes to 
continue uninstalling the Companion Suite Pro 
LH2 drivers.

2 The uninstall programme starts. You can cancel 
the uninstall by clicking on Cancel.

Manually uninstalling the drivers

The following drivers must be removed:
• print driver
• scanner driver
To remove the print driver:

1 Open the window Printers (Start > Devices and 
Printers , depending on the operating system).

2 Select the Color HFCv2 printer and click on the 
right button of your mouse.

3 Select Remove device in the menu click on the left 
button of your mouse.

4 Click on OK to confirm the deletion.
5 Open the window Administrative Tools (Start > 

Control panel > System and Security > 
Administrative Tools, depending on the operating 
system).

6 In the sub-menu Print Management, select the 
sub-menu Print Servers then the sub_menu 
Drivers.

7 Select the Color HFCv2 driver and click on the 
right button of your mouse.

8 Select Remove driver package in the menu and 
click on the left button of your mouse.

9 Click on OK to confirm the deletion.
To remove the scanner driver:

1 Open the window Computer (Start > Computer, 
depending on the operating system).

2 Select the System Properties tab.
3 Select the Device manager.
4 In the sub-menu Imaging device, selectthe 

Scanner HFCv2 driver and click on the right button 
of the mouse.

5 Select Uninstall in the menu and click on the left 
button of your mouse.

6 A confirmation window appears.
7 Select the deletion, by pressing the check box.
8 Click on OK to confirm the deletion.

Note

You can also uninstall the Companion 
Suite Pro LH2 drivers using the Windows 
function Add/Remove programs in the 
control panel.
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Maintenance and 
incidents
Maintenance

General information

In order to maintain your machine in good working order, 
it is recommended to periodically clean the inside.
Normal use of the machine, requires the following rules to 
be respected:

• When cleaning the inside of the printer or removing 
jams, be careful not to touch the fuser unit or other hot 
parts.

• To clean the printer, use a soft cloth.
• Never spray detergent directly onto the printer as it 

may infiltrate the vents and damage internal circuits.
• To clean the machine, avoid using abrasive or corro-

sive solvents or products containing solvents (alcohol 
or benzene).

• Always start by applying the cleaning product (mild de-
tergent) to a small surface of the printer to check the 
result.

• Never use abrasive or rough cloths (steel wool or plas-
tic).

• Never leave the scanner cover open unnecessarily.
• Never try to lubricate the machine.
• Close the scanner cover gently and never subject the 

machine to vibrations.
• Never open the cartridge access cover during printing.
• Never try to dismantle the machine.
• Never use paper which has remained too long in the 

paper tray.

Cleaning

The presence of dust, dirt and paper debris on the 
external surfaces and inside the printer may hinder its 
operation. We recommend you clean it regularly.

Cleaning the outside of the printer

Clean the outside of the printer using a soft cloth soaked 
in mild household detergent.
Use  a soft cloth to clean the printer. Never use 
abrasives or corrosive detergents.

Cleaning the touch screen

To clean the touch screen safely, you must follow the 
recommendations and procedure described below.
Recommendations
• Use a soft lint-free cloth so as not to scratch the touch 

screen.
• Only use the cleaning products listed in this section.
• When using a cleaning product, always apply the so-

lution to the cloth and use the cloth to clean the touch 
screen.
If you spray liquid directly onto the touch screen, you 
risk damaging it.

List of authorised and prohibited cleaning products
 

1 Press the On/Off button to switch off the machine 
(position 0) and disconnect the mains power cable.

2 Clean the touch screen using a soft, lint-free cloth, 
with one of the authorised cleaning products.

3 Gently wipe the surface with a soft, dry cloth until it 
is dry. Exert as little pressure as possible.

4 Connect the power cable to the mains and press 
the On/Off button to switch the machine on (posi-
tion I).

Caution

For your safety, you must read the safety in-
structions in the chapter safety [ 119].

WARNING

Firstly, disconnect the power cable and all 
interface cables. Ensure that no water or 
detergent enters the printer, or it may be da-
maged or cause electrocution.

Caution

The fuser unit is extremely hot. If you open 
the access cover to the fuser unit, it takes 
about one hour to cool down.

You may use...
NEVER USE

Water
Vinegar (mixed with 
water)
Isopropyl alcohol
Benzene

Acetone
Ethyl alcohol
Ethyl acid
Ammonia
Methyl chloride
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Cleaning the scanner read devices

If one or several vertical lines appear on copies, clean the 
scanner window.

1 Open the flatbed scanner cover by folding it back 
until it is maintained in the vertical position.

2 Clean the two transparent analysis windows (A), 
the white rollers (B) and the white mats (C), using 
a soft, lint-free cloth soaked in isopropyl alcohol.

3 Close the cover of the flatbed scanner.
4 Make a copy to check that the symptoms have dis-

appeared.

Cleaning the paper feed rollers

The accumulation of paper dust and other debris on the 
paper feed rollers may cause paper feed problems.

Cleaning the paper feed rollers on the automatic 
feeder

Clean the paper feed rollers on the automatic feeder 
when:
• one or more vertical lines appear on copies of docu-

ments placed in the automatic feeder (presence of de-
bris, ink, glue, etc., in the paper feed mechanism).

• the message **PLEASE CLEAN THE SCANNER 
FEED ROLLER AS DESCRIBED IN THE USER MAN-
UAL, THEN PRESS <STOP>** informs you that the 
automatic feeder can no longer feed sheets of paper 
(dust, dirt or debris obstructing the rollers). Press OK 
to delete the message from the screen.

To clean the paper feed rollers on the automatic feeder:
1 Press the On/Off button to switch off the machine 

(position 0) and disconnect the power cable.

2 Open the cover of the autofeed scanner.

3 Clean the paper feed rollers using a soft, lint-free 
cloth soaked in isopropyl alcohol.
To clean the rollers, rotate them in the same direc-
tion as normal paper feed.

4 Wipe the rollers using a soft, lint-free cloth until they 
are dry.

5 Close the cover of the autofeed scanner.
6 Connect the power cable to the mains and press 

the On/Off button to switch the machine on (posi-
tion I).

7 Make a copy to check that the symptoms have dis-
appeared.

Cleaning the paper feed rollers in the main paper 
tray

1 Open the main paper tray.

2 Clean the paper feed rollers by wiping them with a 
soft, dry cloth.
To clean them, rotate them in the same direction as 
normal paper feed.
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3 Close the main paper tray.

Cleaning the paper feed rollers in the manual 
feeder

1 Open the manual feeder.

2 Press the centre of the sheet compression flap until 
the locking tabs (white) on the right and left are re-
leased.

3 Clean the paper feed rollers by wiping them with a 
soft, dry cloth.
To clean them, rotate them in the same direction as 
normal paper feed.

4 Close the manual feeder.

Cleaning the paper feed rollers on the duplex 
module

1 Open the manual feeder.

2 Open the cover of the duplex module.

3 Clean the paper feed rollers by wiping them with a 
soft, dry cloth.
To clean them, rotate them in the same direction as 
normal paper feed.
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4 Close the cover of the duplex module.

5 Close the manual feeder.

Cleaning the paper feed rollers in the additional 
paper tray

1 Open the additional paper tray.

2 Clean the paper feed rollers by wiping them with a 
soft, dry cloth.
To clean them, rotate them in the same direction as 
normal paper feed.

3 Close the additional paper tray.

4 Open the right side cover of the additional paper 
tray.

5 Clean the paper feed rollers by wiping them with a 
soft, dry cloth.
To clean them, rotate them in the same direction as 
normal paper feed.

6 Close the right side cover of the additional paper 
tray.

Note

Close the manual feeder before opening the 
right side cover.
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Cleaning the printer's laser lens

The printer is equipped with four laser lenses. Clean each 
one as indicated below. The cleaning bar is fixed to the 
back of the printer front cover.

1 Open the printer front cover and remove the clean-
ing bar fixed to the back of the cover.

2 Insert the cleaning bar into the opening provided 
and move it forwards and backwards 2 or 3 times.

3 Repeat this cleaning operation for each laser lens.

4 Replace the laser lens cleaning bar on its support 
at the back of the printer front cover.

5 Close the printer front cover.

Replacing consumables

To access the status of consumables, press MENU and 
select CONSUMABLES > DISPLAY (see Consumable 
status [ 42]).
After replacing a consumable, you must inform the 
machine of its characteristics.
To do so, the smart card, supplied with each toner 
cartridge, must be read by the machine after 
installing a new consumable.
The replacement of certain consumables must be 
declared on the machine, in the menu CONSUMABLES 
> DECLARE REFILL.

Replacing a toner cartridge

The machine is equipped with a consumable 
management system. It indicates when a toner cartridge 
is nearing the end of its lifespan. The following messages 
will appear on your machine:
• THE TONER CARTRIDGE X IS NEARLY EMPTY: 

the toner cartridge whose colour is identified by X (C 
for cyan, M for magenta, Y for yellow and K for black) 
has reached critical threshold (less than 10% remain-
ing in the toner cartridge);

• THE TONER CARTRIDGE X IS EMPTY - REPLACE 
IT: the toner cartridge is empty.

You can replace the toner cartridge between the time it 
has reached critical threshold and when it is empty.
If you do not replace it, the machine will not print.

The procedure for replacing the consumable is included 
with the new cartridge.
Once the toner cartridge has been replaced:

1 Insert the smart card provided with the new toner 
cartridge into the smart card reader.

2 The machine detects the smart card and displays a 
message asking you to confirm the installation of 
the new consumable. Press YES to confirm.

The machine reads the smart card. After reading, 
the machine displays a message asking you to re-
move the smart card.

Note

The lens cleaning bar is supplied with the 
printer. Store this tool in a safe place so as 
not to misplace it.

Note
Always use the smart card provided when 
replacing the toner cartridge. The smart 
card contains the information required to re-
set the toner level. If you replace the toner 
cartridge without using the smart card provi-
ded, the consumable management system 
may indicate an error.
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3 Remove the smart card from the reader.

Replacing a print unit

The machine is equipped with a consumable 
management system. It indicates when a print unit is 
nearing the end of its lifespan. The following messages 
will appear on your machine:
• THE PRINT UNIT X IS NEARING THE END OF ITS 

LIFE: the print unit whose colour is identified by X (C 
for cyan, M for magenta, Y for yellow and K for black) 
has reached critical threshold (less than 10% remain-
ing in the print unit);

• THE PRINT UNIT X IS AT THE END OF ITS LIFE: 
REPLACE IT: the print unit is empty.

You can replace the print unit between the time it has 
reached critical threshold and when it is empty.
If you do not replace it, the machine will not print.
The procedure for replacing the consumable is included 
with the new print unit.

Replacing the waste toner bottle

Replace the waste toner bottle when the machine 
displays the message THE WASTE TONER BOTTLE IS 
AT THE END OF ITS LIFE: REPLACE IT. If you do not 
replace it or declare its replacement, the machine will not 
print. After replacing, you must declare the replacement of 
this consumable.

1 Open the machine front cover.

2 Turn the waste toner bottle lock to the "Unlocked" 
position.

3 Release the left and right handles of the waste ton-
er bottle.

4 Gently remove the waste toner bottle by pulling on 
the handles.

5 Unpack the new waste toner bottle. Place the full 
bottle in the plastic bag provided, place it in the box 
for the new waste toner bottle, and dispose of it in 
accordance with local regulations in force.
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6 Slide the new waste toner bottle fully into the ma-
chine.

7 Fold down the left and right handles of the waste 
toner bottle.

8 Turn the waste toner bottle lock to the "Locked" po-
sition.

9 Close the machine front cover.

You must now declare the replacement of this 
consumable:
Administrator rights

1 Press the MENU key.
2 Select CONSUMABLES > DECLARE REFILL.
3 Press WASTE TNR BOTTLE.
The machine takes the replacement of this consuma-
ble into account.

Replacing the perfume cartridge

Replace the perfume cartridge when the machine 
displays the message THE PERFUME CARTRIDGE IS 
AT THE END OF ITS LIFE: REPLACE IT.
The procedure for replacing the consumable is included 
with the new cartridge.
After replacing the cartridge, you must declare the 
replacement of this consumable.
Administrator rights

1 Press the MENU key.
2 Select CONSUMABLES > DECLARE REFILL.
3 Press PERFUME.
The machine takes the replacement of this consuma-
ble into account.

Note

You must have machine administrator rights 
to access this function.

Note

You must have machine administrator rights 
to access this function.
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Replacing the staple cartridge

When the staple cartridge is empty, the message THE 
STAPLE CARTRIDGE IS EMPTY appears.
To replace the staple cartridge:

1 Open the cover of the stapling unit.

2 Remove the stapling unit.

3 Remove the stapler.

4 Remove the empty staple cartridge and install the 
new one.

5 Replace the stapler.

6 Replace the stapling unit.

7 Close the cover of the stapling unit.
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Replacing the feeder shoe

Replace the feeder shoe on the autofeed scanner when 
the machine displays the message THE SCANNER 
FEEDER IS AT THE END OF ITS LIFE: REPLACE IT. 
After replacing, you must declare the replacement of this 
consumable.

1 Open the cover of the autofeed scanner.

2 Press down on the tab on the feeder shoe and lift 
to remove it.

3 Unpack the new feeder shoe, place it in its housing 
and clip in into place.

4 Close the cover of the autofeed scanner.
You must now declare the replacement of this 
consumable:
Administrator rights

1 Press the MENU key.
2 Select CONSUMABLES > DECLARE REFILL.
3 Press SCANNER FEEDER.
The machine takes the replacement of this consuma-
ble into account.

Calibrating colours

The machine automatically calibrates the colours 
regularly, after a consumable is replaced or after a 
variation in temperature or humidity.
You can manually perform this operation:

1 Press the MENU key.
2 Select SETTINGS > SCANNER/PRINTER.
3 Press CALIBRATE.

Servicing

In order to ensure the performance of your machine, the 
printer should be serviced (drum change, etc.) every 120 
000 pages printed.
The feeder shoe should be replaced about every 50 000 
pages scanned on the autofeed scanner.
Contact your retailer to have servicing carried out.

Removing paper jams

If a paper jam occurs in the paper feed unit, or if no paper 
is fed, the message PAPER JAM appears with an 
indication of where the jam has occurred. The printer 
automatically goes offline when this message appears. 
Remove the paper causing the jam. When the jammed 
paper has been removed, the printer resumes printing.

Possible paper jam locations

The illustration below shows the path taken by the paper 
through the machine, including when additional paper 
trays are installed. The locations where paper jams may 
occur are indicated. Paper jams may occur at several 
places on the same path.

Note

You must have machine administrator rights 
to access this function.

1 Toner cartridge 9 Laser

2 Transfer unit 10 Print unit

3 Fuser unit 11 Transfer belt

4 Duplex unit 12 Main output tray

5 Manual feeder 13 Auxiliary output 
tray

6 Additional paper 
tray

14 Stapling unit

7 Additional paper 
tray

15 Staples

8 Main paper tray
- 100 -



MF 6990dn - Agoris C935

13
 - 

M
ai

nt
en

an
ce

 a
nd

 in
ci

de
nt

s
Considerations for removing paper jams

Remember the following indications when you try to 
remove a paper jam:
• If paper jams occur frequently, try using another type 

of paper, replacing the paper with paper from another 
ream, airing the pile before inserting it in the printer or 
turning it over. If paper jams persist despite these 
measures, it is possible that the problem is due to the 
printer.

• Depending on where the jam occurred, jammed pages 
may be reprinted when printing resumes.

Scanner paper jam

In the event of paper jam:
1 Open the cover of the autofeed scanner.

2 Remove the paper causing the jam without tearing 
it.

3 Close the cover of the autofeed scanner.

Main paper tray jam

1 Open the right side cover by pulling on the latch.

2 Remove the paper causing the jam without tearing 
it.

Note

When you remove a paper jam, remove the 
paper gently so as not to tear it. Torn paper 
is difficult to remove and may go unnoticed.
Never reload pages that have been remo-
ved from a jam.

WARNING

The fuser unit may reach very high tempe-
ratures during operation. To avoid injury, do 
not touch this zone.

Note

Do not touch the surface of the transfer belt 
or the image transfer roller, as this may risk 
deteriorating print quality.
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3 Close the right side cover.

4 Open the main paper tray and remove any paper 
loaded in it.

5 Fan the sheets you have removed and smooth the 
paper on a flat surface.

6 Load the sheets into the paper tray with the print 
surface facing up.

7 Close the main paper tray.

Additional paper tray jam

1 Open the right side cover of the additional paper 
tray.

2 Remove the paper causing the jam without tearing 
it.

3 Close the right side cover of the additional paper 
tray.

4 Open the additional paper tray and remove any pa-
per loaded in it.
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5 Fan the sheets you have removed and smooth the 
paper on a flat surface.

6 Load the sheets into the paper tray with the print 
surface facing up.

7 Close the additional paper tray.

Duplex module paper jam

1 Open the manual feeder.

2 Open the cover of the duplex module.

3 Remove the paper causing the jam without tearing 
it.

4 Close the cover of the duplex module.

5 Close the manual feeder.

Fuser unit paper jam

1 Open the right side cover by pulling on the latch.

2 Lift the two levers holding down the fuser unit cov-
er, and lower the cover.
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3 Remove the paper causing the jam without tearing 
it.

4 Close the fuser unit cover, and lower the two levers 
holding it down.

5 Close the right side cover.

Manual feeder and Transfer roller paper jam

1 Open the right side cover by pulling on the latch.

WARNING

The fuser unit may reach very high tempe-
ratures during operation. To avoid injury, do 
not touch this zone.

Note

Do not touch the surface of the transfer belt 
or the image transfer roller, as this may risk 
deteriorating print quality.
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2 Remove the paper causing the jam without tearing 
it.

3 Close the right side cover.

Transfer unit paper jam

1 Open the upper cover.

2 Remove the paper causing the jam without tearing 
it.

3 Close the upper cover.

WARNING

The fuser unit may reach very high tempe-
ratures during operation. To avoid injury, do 
not touch this zone.

Note

Do not touch the surface of the transfer belt 
or the image transfer roller, as this may risk 
deteriorating print quality.
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Stapling unit paper jam

A paper jam may occur in the following places:
• between the transfer unit and the top of the stapling 

unit;
• at the auxiliary output tray;
• inside the stapling unit.
To remove a paper jam that has occurred between the 
transfer unit and the top of the stapling unit:

1 Open the finisher cover.

2 Remove the paper causing the jam without tearing 
it.

To remove a paper jam visible at the auxiliary output 
tray:

1 Open the finisher cover.

2 Remove the paper causing the jam without tearing 
it.

To remove a paper jam that has occurred inside the 
stapling unit:

1 Open the finisher cover.

2 Turn the knob inside the unit clockwise, until the 
jammed sheet arrives in the main output tray.

3 When the sheet arrives in the main output tray, lift 
the auxiliary output tray, and remove the paper 
causing the jam without tearing it.
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Removing staple jams

To remove a staple jam:
1 Open the cover of the stapling unit.

2 Remove the stapling unit.

3 Remove the stapler.

4 Lift the staple cartridge guide, and remove any 
jammed staples.

5 Replace the guide in its initial position, and replace 
the stapler.

6 Replace the stapling unit.

7 Close the cover of the stapling unit.

Storage

If you plan not to use the machine for an extended period, 
disconnect the power cable.
We recommend you consult your retailer for the 
precautions to be taken to avoid damage when the 
machine is once again in use.
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Packing and transporting the 
machine

If you wish to transport the machine, use its original 
packaging. If you do not pack the machine correctly, the 
warranty may be void.

Scanner part

1 Press the On/Off button to switch off the machine 
(position 0) and disconnect the mains power cable.

2 Disconnect all cables connected to the machine.
3 Close the scanner reception stop.
4 Take hold of the scanner handles and lift it to sep-

arate it from the printer part.
5 Place the scanner part in its original box with its 

protective spacers.
6 Close the box using adhesive tape.

Printer part

If the Finisher module is installed, remove it before 
starting this procedure.

If additional paper trays are installed, please remove 
them before starting this procedure.

Please remove the scanner before starting this proce-
dure.

The machine should be switched off and all cables 
disconnected.

1 Remove all toner cartridges and waste toner bot-
tles from the printer. Place the toner cartridges and 
the waste toner bottle in their original box to pre-
vent possible leakage of toner.

2 Pack the printer and place it in its original box with 
all the original protective spacers.

3 Place all documentation (printed documents, CD-
Rom, etc.) in the box.

4 Close the box using adhesive tape.

Firmware update

Consult our website www.sagemcom.com to know 
whether there are any firmware updates available for your 
machine and download the appropriate file to your PC.
It can then be installed either:
• from the integrated website;
• or using the Companion Suite Pro software.
Administrator rights

To install the update from the integrated website:
1 Go to the integrated website (see Remote 

configuration [ 23]).
2 Select the SERVICES tab.
3 Select the menu TRANSFER PC.
4 In FIRMWARE UPDATE, press Browse.
5 Select the file to download and run the update.

To install the update from the Companion Suite Pro 
software:

To update the machine firmware, the Companion 
Suite Pro software must be installed on your PC, 
which must be connected to the machine (see PC 
Functions [ 77]).

1 Go to the update wizard (Start > All programs > 
Companion Suite > Companion Suite Pro LH2 > 
Companion - Firmware update).

2 Select the file to download and run the update.
Do not hesitate to consult the website www.sagemcom to 
know whether new versions of this manual are available 
once your software has been updated.

Note

You must have machine administrator rights 
to access this function.
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Troubleshooting

The following sections describe problems you may encounter and the corrective actions you can implement to resolve 
them.
Some solutions may require cleaning or replacing certain machine components.
If the corrective action suggested does not solve the problem, reboot the terminal before contacting a maintenance 
technician.

Troubleshooting

The table in this section exhaustively presents the problems that may occur and the corrective actions you can 
implement to solve them.
If the corrective action suggested does not solve the problem, reboot the terminal before contacting a maintenance 
technician.

 

Symptom Possible cause Solution

When the machine 
is switched on, 
nothing appears 
on the screen

The mains cable is not correctly 
connected to the power plug.

Check that the mains cable is correctly connected to 
the power plug.

The On/Off button is not in 
position I.

Place the switch in the O position (Off), then to the I 
position (On).

The plug used for the machine is 
defective.

Connect another electrical appliance to the plug to 
check if it is working.

The machine 
resets or switches 
off frequently.

The mains cable is not correctly 
connected to the power plug.

Switch off the machine, check that the power cable is 
connected to the plug and switch the machine on 
again.

A system error occurred. Contact a maintenance technician.

The machine does 
not detect the 
presence of the 
document inserted 
in the autofeed 
scanner

The document is too thick or 
incorrectly positioned.

1 Remove the document.
2 Check that the document is not too thick (max-

imum 70 sheets of paper 80 g/m²).
3 Fan the sheets.
4 Move the sheets close to the limit stop.

The machine does 
not receive faxes

The telephone cable is not 
correctly connected to the 
telephone line.

1 Check that the telephone cable is correctly con-
nected.

2 Connect a telephone to the line to check that 
there is a dial tone on the telephone line.

The machine does 
not send faxes

The telephone cable is not 
correctly connected to the 
telephone line.

1 Check that the telephone cable is correctly con-
nected.

2 Connect a telephone to the line to check that 
there is a dial tone on the telephone line.

3 Check that the prefix is properly programmed 
and used.

The machine 
receives a blank 
page

Document incorrectly sent or 
printer problem

1 Photocopy a document: if it is correct, the ma-
chine is working normally.

2 Call your correspondent and ask him to send 
the document again. The document may have 
been inserted upside down.

The machine will 
not print sent data

An error message is displayed 
on the machine screen.

Follow the instruction in the screen message.

The print job was cancelled 
because you are not authorized 
to print.

Contact the machine administrator to know your 
rights.
Print rights must be defined in your user account.
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The message THE 
TONER 
CARTRIDGE IS 
NEARLY EMPTY 
is displayed more 
than is normal

A toner cartridge is defective. Replace the defective toner cartridge with a new 
toner cartridge.

The printed pages are highly 
charged with toner.

See the consumable specifications described in 
Characteristics [ 143].

Impossible to print 
from a USB key

The USB key is not compatible. Check the compatibility of the USB key used (see 
Using a USB memory key [ 60]).

The file format is not compatible. Check the compatibility of your files (see Using a 
USB memory key [ 60]).

The print job was cancelled 
because you are not authorized 
to print.

Contact the machine administrator to know your 
rights.
Print rights must be defined in your user account.

Printing is too slow The printer is configured to print 
in slow mode (e.g. thick or 
transparent paper).

Printing on special media is slower.
If you are using standard paper, ensure that the 
appropriate media is defined in the printer driver.

The energy saving mode is 
activated.

In this mode, printing takes a while to start (see 
Energy saving [ 24]).

The print job is very complex. Please wait. No action required.

Printer memory is insufficient. If the print jobs dealt with by the machine are mostly 
comprised of very complex jobs, and print times are 
affected, you can add memory.
Contact your retailer for more information.

An incorrect toner cartridge is 
installed.

Only use the correct toner cartridges. See the 
consumable specifications described in 
Characteristics [ 143].
Contact your retailer for more information.

Duplex printing is 
causing problems

The media used is not correct or 
the printing parameters are not 
correctly defined.

Ensure you are printing on media that is compatible 
with duplex mode (see Recommendations for paper 
[ 146]).
Do not use envelopes, labels, cards, thick or glossy 
supports, transparencies.
Check that the paper tray does not contain different 
types of media.

Check that your document contains more than one 
page.

In the printer driver, check that you have selected 
"Duplex" mode.

The printer is 
making an unusual 
noise

The machine is not resting on a 
flat and stable surface.

The machine must be placed on a solid, horizontal 
surface (see Location conditions [ 121]).

The paper tray is not correctly 
installed.

Remove the paper tray you are printing from and re-
insert it completely.

An object is caught in the printer. Switch off the machine, disconnect the mains cable 
and remove the object.
If you cannot remove it, contact a maintenance 
technician.

The display is 
disturbed

The display can be disturbed by 
interference with radio 
equipment.

Move the affected equipment away as far as 
possible.
Redirect or change the position of the antenna of the 
affected radio or TV receiver.
Connect the affected equipment to a mains power 
outlet on a different circuit to that of the source.
Reboot the terminal.

Symptom Possible cause Solution
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Troubleshooting paper jams

Frequent paper jams in a specific zone mean that this zone requires cleaning, servicing or repair.
Frequent paper jams may also occur if you are not using a compatible support.

 

Symptom Possible cause Solution

Several sheets are 
fed at the same 
time into the 
printer

The edges of the sheets are not 
aligned.

Remove the sheets from the paper tray, align the 
edges and replace them in the tray.

The media used is damp. Remove the loaded media and replace it with dry 
media.

The transparencies being used 
are charged with static 
electricity.

Remove the transparencies and feed them into the 
manual feeder one by one.
Do not fan sheets of transparencies before loading 
them.

The jam message 
remains displayed

The right side cover must be 
opened and closed to reinitialize 
the printer.

Open and close the right side printer cover.

One or several sheets have 
remained stuck in the printer.

Check once again the paper path and remove any 
sheets which may still be stuck.

Jams in the Duplex 
module

The media used is not 
compatible (format, thickness, 
type, etc.).

Only use compatible media supports (see 
Recommendations for the paper [ 146]).

Automatic duplex printing is only possible on 
standard paper from 60 to 90 g/m² [16 to 24 lb] (see 
Recommendations for the paper [ 146]).

Check that the main paper tray does not contain 
different types of media.

Envelopes, labels, thick, glossy or transparent media 
cannot be duplex printed.

One or several sheets have 
remained stuck in duplex 
module.

Check once again the paper path in the duplex 
module and remove any sheets which may still be 
stuck.
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Paper is getting 
stuck in the printer

The media is not correctly 
inserted in the paper tray.

Remove the jammed sheets and reload the media 
correctly into the paper tray (see Loading media 
[ 11]).

The paper tray contains too 
many sheets of paper.

Remove the excess sheets and reload the required 
quantity of sheets (see Loading media [ 11]).

The paper guides are not 
correctly adjusted to the format 
used.

Adjust the guides against the pile of paper loaded in 
the paper tray according to the format used.

The media loaded is warped or 
creased.

Remove the sheets, smooth and reload them.
If the jams persist, use another media.

The media used is damp. Remove the loaded media and replace it with dry 
media.

Personalized format media, 
envelopes, labels, cards, thick 
media or transparencies are 
loaded in the main paper tray or 
in an additional paper tray.

Special media must only be loaded into the manual 
feeder.

The recommended print side of 
transparencies or sheets of 
labels is not turned the right way 
up in the manual feeder.

Load the transparencies or labels correctly (see 
Recommendations for the paper [ 146] and Loading 
media [ 11]).

The print side of envelopes is 
not turned the right way up in the 
manual feeder.

Load the envelopes into the manual feeder with the 
flap facing upwards.
If the flaps are on the long edge of the envelopes, 
load the envelopes with the flaps facing to the right of 
the printer (see Loading envelopes into the manual 
feeder [ 12]).

The transparencies being used 
are charged with static 
electricity.

Remove the transparencies and feed them into the 
manual feeder one by one.
Do not fan sheets of transparencies before loading 
them.

The media used is not 
compatible (format, thickness, 
type, etc.).

Only use compatible media supports (see 
Recommendations for the paper [ 146]).

The paper feed rollers need 
cleaning.

Clean the paper feed rollers (see Cleaning the paper 
feed rollers [ 93]).

Symptom Possible cause Solution
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Troubleshooting print quality problems

The table and illustrations in this section exhaustively present print quality problems that may occur and the corrective 
actions you can implement to solve them.
If the corrective action suggested does not solve the problem, contact a maintenance technician.

 

Symptom Possible cause Solution

Blank print
White spots on 
the printed page

One or more toner cartridges are 
defective.

Remove the toner cartridges and check their 
condition.
Replace the defective toner cartridge(s).

The printer driver is not correctly 
configured.

In the driver, select the Standard paper option 
instead of Transparency.

The media used is damp. Check the ambient humidity in the media storage 
room.
Remove the loaded media and replace it with dry 
media.

The type of media defined in the 
printer driver does not 
correspond with the media in the 
paper tray.

Load the appropriate media into the paper tray.

Several sheets are fed at the 
same time into the printer

Remove the sheets from the paper tray and check 
they are not sticking together.
Fan sheets of paper (not transparencies), and 
replace them in the paper tray.

The media is not correctly 
inserted in the paper tray(s).

Remove the sheets from the paper tray and align 
their front edges.
Replace them in the paper tray and adjust the guides 
against the pile of paper.

Single-colour 
printing

One or more toner cartridges are 
defective.

Remove the toner cartridges and check their 
condition.
Replace the defective toner cartridge(s).

Print media 
creased

The media used is damp. Remove the loaded media and replace it with dry 
media.

The media used is not 
compatible (format, thickness, 
type, etc.).

Only use compatible media supports (see 
Recommendations for the paper [ 146]).

The transfer roller or fuser unit 
may be defective.

Check the condition of the transfer roller or the fuser 
unit.
If the transfer roller or fuser unit need to be replaced, 
contact a maintenance technician.
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Pale printing The laser lenses need cleaning. Clean the laser lenses (see Cleaning the printer laser 
lenses [ 96]).

The media used is damp. Remove the loaded media and replace it with dry 
media.

One of the toner cartridges is 
nearly empty.

Replace the toner cartridge.

One or more toner cartridges are 
defective.

Remove the toner cartridges and check their 
condition.
Replace the defective toner cartridge(s).

The type of media is not 
correctly defined in the printer 
driver.

The type of media used (envelopes, labels, cards, 
thick or glossy media, transparencies) must be 
defined in the printer driver.

The ink saving mode is 
activated.

In this mode, the quantity of toner consumed by 
printing is reduced.

Printing too dark One or more toner cartridges are 
defective.

Remove the toner cartridges and check their 
condition.
Replace the defective toner cartridge(s).

Fuzzy printing
Stained back-
ground
Lack of lustre

One or more toner cartridges are 
defective.

Remove the toner cartridges and check their 
condition.
Replace the defective toner cartridge(s).

The print heads are not aligned. Recalibrate the colours (see Calibrating colours 
[ 100]).

Non uniform 
printing or colour 
density

One or more toner cartridges are 
defective or nearly empty.

Remove the toner cartridges and check their 
condition.
Replace the defective or nearly empty toner 
cartridge(s).

The machine is not resting on a 
flat surface.

Place the machine on a strong, flat surface.

Irregular printing
Spotted image

The media used is damp. Check the ambient humidity in the media storage 
room.
Remove the loaded media and replace it with dry 
media.

The media used is not 
compatible (format, thickness, 
type, etc.).

Only use compatible media supports (see 
Recommendations for the paper [ 146]).

One or more toner cartridges are 
defective.

Remove the toner cartridges and check their 
condition.
Replace the defective toner cartridge(s).

Symptom Possible cause Solution
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Image not suffi-
ciently fixed
Image is easily 
smudged

The media used is damp. Remove the loaded media and replace it with dry 
media.

The media used is not 
compatible (format, thickness, 
type, etc.).

Only use compatible media supports (see 
Recommendations for the paper [ 146]).

The type of media is not 
correctly defined in the printer 
driver.

The type of media used (envelopes, labels, cards, 
thick or glossy media, transparencies) must be 
defined in the printer driver.

In the fuser unit, the cursors are 
set to the position required for 
printing on envelopes.

Before printing on any media other than envelopes, 
remember to change the position of the cursors in the 
fuser unit (see Loading envelopes into the manual 
feeder [ 12] for accessing the cursors).

Traces of toner or 
residues on the 
printed page

One or more toner cartridges are 
defective or incorrectly installed.

Remove the toner cartridges and check their 
condition.
Replace the defective toner cartridge(s).
Reinstall the toner cartridges correctly.

Traces of toner on 
the underside of 
the printed page

There is toner in the paper path. Print out several blank pages to eliminate the toner.

The transfer roller needs 
cleaning.

Clean the transfer roller.

If the transfer roller needs replacing, contact a 
maintenance technician.

Unusual motifs 
(white, black or 
colour) repeated at 
regular intervals.

The laser lenses need cleaning. Clean the laser lenses (see Cleaning the printer laser 
lenses [ 96]).

A toner cartridge is defective. Identify which colour is responsible for the unusual 
motifs and replace the corresponding toner cartridge 
with a new one.

Image defects The laser lenses need cleaning. Clean the laser lenses (see Cleaning the printer laser 
lenses [ 96]).

A toner cartridge is leaking. Remove the leaking toner cartridge. If it is defective, 
replace it.

A toner cartridge is defective. Identify which colour is responsible for the unusual 
motifs and replace the corresponding toner cartridge 
with a new one.

Symptom Possible cause Solution
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Smart card incidents

The table in this section presents problems that may occur reading smart cards and their causes.
 

Horizontal lines or 
stripes on the 
image

The machine is not resting on a 
flat surface.

Place the machine on a strong, flat surface.

There is toner in the paper path. Print out several blank pages to eliminate the toner.

One or more toner cartridges are 
defective or incorrectly installed.

Remove the toner cartridges and check their 
condition.
Replace the defective toner cartridge(s).
Reinstall the toner cartridges correctly.

Mediocre or very 
low intensity colour 
reproduction

One or more toner cartridges are 
defective.

Remove the toner cartridges and check their 
condition.
Replace the defective toner cartridge(s).
Reinstall the toner cartridges correctly.

Wrong colours One or more toner cartridges are 
defective.

Remove the toner cartridges and check that the toner 
is evenly distributed inside.
Reinstall the toner cartridges correctly.

One or more toner cartridges are 
empty or nearly empty.

Check whether the message THE TONER 
CARTRIDGE IS NEARLY EMPTY X or THE TONER 
CARTRIDGE IS EMPTY - REPLACE IT X appears 
on the machine.
Replace the toner cartridge indicated.

Incorrect 
registration of 
colours - the 
colours blend and 
vary from one 
page to the next

The front cover of the machine is 
not correctly closed.

Check that the front cover of the machine is correctly 
closed.

One or more toner cartridges are 
defective.

Remove the toner cartridges and check their 
condition.
Replace the defective toner cartridge(s).
Reinstall the toner cartridges correctly.

The media used is damp. Remove the loaded media and replace it with dry 
media.

Message Cause

Unknown card The smart card is wrong or defective.

Zero smart card capacity The smart card has already been used.

Operation cancelled Operator stop.

Operation prohibited The toner cartridge has not yet reached its critical threshold and may 
still be used before being replaced.

Symptom Possible cause Solution
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Communication failures

Communication failures may occur when scanning or sending a document.
If the communication fails, the machine will automatically reattempt to make the call later.

Scanning failure

You can:

• resend the document immediately by pressing , if the document is still present;

• cancel the operation by pressing .

Sending failure

You can:
• wait for the machine to attempt to send the document again;
• send the document again immediately via the emission queue (see section Forcing an emission request [ 54]);
• cancel the operation by deleting the corresponding request from the emission queue (see section Deleting a 

document awaiting emission [ 54]).
The machine will make 5 automatic call-back attempts. The unsent document is automatically deleted and an emission 
report is printed with a failure code and the reason why the communication failed.

Communication failure codes

The communication failure codes appear in logs and emission reports.

General codes

 

Code Meaning Reason / Solution

01 Busy or no fax answer This code appears after 6 unsuccessful attempts. You should 
try again later.

02 Busy or no fax answer This code appears after 6 unsuccessful attempts. You should 
try again later.

03 Operator stop The communication was interrupted by the user by pressing 

.

04 Non programmed number A number saved as a one-touch key or abbreviated number is 
not valid, check it. (Example: a delayed transmission was 
programmed with a one-touch key and this key has been 
deleted in the meantime).

07 Disconnection The communication was cut off (bad quality link). Check the 
number.

08 Quality The document you sent was not properly received. Contact 
your correspondent to see whether it is necessary to resend the 
document. It is possible the interference occurred in a useless 
part of the document.

12 Document receive error Ask your correspondent to check the length of the document (it 
is too long to be received in full).

13 Document incorrectly sent Ask your caller to send the document again.

15 Incompatible coding Recipient machine does not match with the send document’s 
encoding.
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Internet codes

 

Network codes

 

19 Memory saturated The machine can no longer receive as the memory is full. There 
are too many unprinted documents or documents waiting to be 
sent.
Print out the documents received and immediately send or 
delete documents waiting to be sent.

20 Memory saturated Received documents memory saturated. Print out received 
documents.

25 Caller stop The communication was stopped by the caller.

26 Disconnection Sending did not start. The telephone line is too noisy.

27 Document incorrectly sent For emission: send the document again.
For reception: ask your caller to send the document again.

Code Meaning Reason / Solution

64 No provider response Modem cannot connect to the service provider.
If the error is systematic, check the call number for the service 
provider and possibly the machine's prefix.

67 Cannot connect to SMTP 
server

Cannot connect to outgoing SMTP server, the service is 
momentarily unavailable.
If the error is systematic, check the internet connection and 
server parameters.

68 Cannot connect to POP3 
server

Cannot connect to incoming POP3 server, the service is 
momentarily unavailable.
If the error is systematic, check the internet connection and 
server parameters.

69 Disconnection from 
provider

The service is momentarily unavailable. Try again later.

70 SMTP server 
disconnection

Disconnection from the outgoing SMTP server, the service is 
momentarily unavailable. Try again later.

71 POP3 server disconnection Disconnection from the incoming POP3 server, the service is 
momentarily unavailable. Try again later.

72 Internet disconnection The service is momentarily unavailable. Try again later.

Code Meaning Reason / Solution

80 Disk protected or file 
already exists

The file could not be archived, either because the directory is 
write protected, or because a file with the same name already 
exists in the directory.

81 Incorrect authentication Incorrect "Login" and / or "Password" 

82 Unsupported 
authentication dialect or 
method

Check that the authentication proposed by the Server is NTLM.

83 Invalid password or 
directory unknown

Incorrect "Password" and / or "Directory" parameters

Code Meaning Reason / Solution
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Safety
Safety Instructions

 Before connecting your machine, check that the mains plug to which you are connecting the machine complies 
with the indications on the information label (voltage, current, frequency of electricity network) on the machine. This 
machine must be connected to a single-phase mains power supply. The machine should not be installed directly on 
the ground.
Batteries, packaging and electrical and electronic equipment (EEE), must be disposed of in accordance with the 
instructions in the ENVIRONMENT chapter in this manual.

Depending on the model, the machine's power plug may be the only means of disconnecting from the electricity 
supply. As a result, the following precautions must be taken: the machine must be connected to a nearby power plug. 
The power plug must remain easily accessible.

The machine is supplied with a mains power cable fitted with an earthed plug. An earthed power plug must be 
connected to a wall socket fitted with an earth connected to the building earth protection.

 

For installation conditions and precautions for use, please consult chapter Installation [ 9].

Laser Safety Information

CAUTION: The use of controls, adjustments or performance of procedures other than those specified in this 
guide may result in hazardous light exposure.
This equipment complies with international safety standards and is classified as a Class 1 Laser Product.
With specific reference to lasers, the equipment complies with laser product performance standards set by 
governmental, national and international agencies as a Class 1 laser product. It does not emit hazardous radiation as 
the beam is totally enclosed during all phases of customer operation and maintenance.

For Europe/Asia

This machine complies with IEC 60825-1:2007 standard, is classified as class 1 Laser Product and is safe for office/
EDP use. It contains one laser diode, of maximum power 15 milliwatts and and wavelength from 770 to 800 
nanometres.
Direct (or indirect reflected) eye contact with the laser beam may cause serious eye damage. Safety precautions and 
interlock mechanisms have been designed to prevent any possible customer exposure to laser radiation.

Repair-maintenance: Have any repair and maintenance work carried out by a 
qualified technician. It is prohibited for users to repair internal components. To 
prevent all risk of electrocution, you should not conduct these operations 
yourself, as by opening or removing covers, you are exposed to a double risk:

Irremediable injury may be caused to the human eye if it is exposed to laser 
rays.
Contact with powered components may cause electrical shock with extreme-
ly serious consequences.
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Position of safety labels on the machine

For safety, warning labels have been placed on the machine in the positions indicated below. For your safety, never 
touch these surfaces when removing a paper jam or replacing the toner cartridge.

Power switch symbols

In accordance with IEC 60417, this machine uses the following symbols for the main power switch:

•  means POWER ON.

•  means POWER OFF.
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Regulatory information
Maschinenläminformations - Verordnung - 3.GPSGV

Certifications in Europe
 

Location conditions

By choosing an appropriate location, you will preserve the longevity of the machine. Ensure that the selected 
location has the following characteristics:
• Do not install the machine directly on the ground.
• Choose a well-ventilation location.
• Ensure that the air vents located on either side of the machine and at the back of the Duplex module, are not ob-

structed. During installation, ensure that the machine is placed about forty centimetres from any object so as to fa-
cilitate opening of covers.

• Ensure that this location does not present any risk of emissions of ammonia or any other organic gases.
• The earthed socket (see safety instructions [ 119]) to which you will be connecting the machine is located nearby 

and easily accessible.
• Ensure that the machine is not directly exposed to sunlight.
• Do not place the machine in a zone exposed to drafts of air generated by air conditioning, heating or ventilation 

systems, or in a zone subject to significant differences of temperature or humidity.
• Choose a stable, horizontal surface on which the machine will not be exposed to intense vibrations.
• Keep the machine away from any objects that may obstruct the air vents.
• Do not place the machine near drapes or other flammable objects.
• Choose a location where the risks of splashes of water or other liquids are limited.
• Ensure that this location is dry, clean and dust-free.

The CE mark applied to this product indicates the declaration of 
conformity of Sagemcom Documents SAS with the applicable directions 
of the European Union, as per the dates indicated:

21 October 2009: Directive 2009/125/EC establishing a framework for the setting of 
ecodesign requirements.

12 December 2006: Directive 2006/95/EC amended. Harmonization of the laws of Member 
States relating to low-voltage equipment.

15 December 2004: Directive 2004/108/EC amended. Harmonization of the laws of Member 
States relating to electromagnetic compatibility.

9 March 1999: Directive 1999/5/EC on radio and telecommunications terminal 
equipment and mutual recognition of conformity.
The declaration of conformity can be consulted online at 
www.sagemcom.com in the "support" section or may be requested from 
the following address:
Sagemcom Documents SAS - Customer service department
250, route de l’Empereur- 92848 Rueil-Malmaison cedex - France
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Precautions for use

Take account of the important precautions below when using the machine.

Operating environment

The following section describes the operating environment required for the machine:
• Temperature: 10 °C to 35 °C [50 °F to 95 °F] with ambient humidity of between 15 and 80 % (up to 65 % ambient 

humidity for a temperature of 35 °C [95 °F]).

Precautions for using the machine

 The following section describes the precautions to be taken when using the machine:
• During printing, never switch the machine off or open its covers.
• Never use gas or flammable liquids, or objects which may generate a magnetic field around the machine.
• When disconnecting the mains cable, always take hold of the plug without pulling on the cable. A damaged cable 

presents a potential risk of fire or electrical discharge.
• Never touch the mains cable with wet hands. You risk getting an electric shock.
• Always disconnect the power cable before moving the machine; Otherwise, you risk damaging the cable and cre-

ating a risk of fire or electric shock.
• Always disconnect the mains cable if you do not plan to use the machine for a prolonged period of time.
• Never place objects on the mains cable, and never pull on it or fold it. This may cause a risk of fire or electric shock.
• Ensure that the machine never lies on the mains cable or the communication cables from any other electrical appli-

ances. Also ensure that no cables are inserted into the machine mechanism. This may prevent the machine from 
operating correctly or create a fire hazard.

• Never try to remove a fixed panel or cover. The machine contains high voltage circuits. Any contact with these cir-
cuits may lead to a risk of electric shock.

• Never try to modify the machine. This may cause a risk of fire or electric shock.
• Ensure that all paper clips, staples or other small metal parts do not enter the machine through the air vents or other 

openings. These objects may generate a risk of fire or electric shock.
• Prevent any water or other liquids from being spilled on or near the machine. Any contact of the machine with water 

or liquid may cause a risk of fire or electric shock.
• If liquid or a metal part accidentally penetrates the machine, switch it off immediately, disconnect the mains cable 

and contact your retailer. Otherwise, you may be exposed to a risk of fire or electric shock.
• If the machine emits heat, smoke, unusual smells or abnormal noises, switch it off, disconnect it immediately and 

contact your retailer. Otherwise, you may be exposed to a risk of fire or electric shock.
• Avoid using the machine during a thunder storm, as there may be a risk of electrical shock caused by lightening.
• Never move the machine during printing.
• If you want to move the machine, lift it. To move the machine, see the section Handling and moving the machine 

[ 124].
 

Precautions for using the touch screen

 The following section describes the precautions to be taken when using the touch screen:
• Never use sharp or pointed objects on the touch screen. You risk scratching or breaking the screen.
• Never subject the screen to violent shocks or pressure. You risk breaking the touch screen.

Place the machine in a well-ventilated room. When the machine is in operation, a small 
quantity of ozone is generated. Unpleasant smells may emanate from the machine if it is 
operated intensively in a poorly ventilated room. For safe operation, place the machine in a 
well-ventilated room.
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Safety information

When using the machine, the following safety precautions must always be respected.

Safety during operation

To ensure continuous safe operation of your equipment, follow these safety instructions at all times (the list below is 
non-exhaustive and may be added to or changed without prior notice).
In this section, the following symbols are used:

 

 CAUTION
• Connect the power cable directly to the wall socket and never use an extension flex.
• Disconnect the power plug (by pulling on the plug and not the cable) if the power cable or plug show signs of wear 

or damage.
• To prevent any risk of electric shock or exposure to laser beams, never remove any cover or screws other than 

those specified in the instructions.
• Switch off the power and disconnect the power plug (by pulling on the plug and not the cable) if any one of the fol-

lowing situations occur:
– You spill something on the equipment.

– You suspect the equipment needs maintenance or repair.

– The equipment cover is damaged.
• Never incinerate spilled or waste toner. Toner dust may catch fire if it is exposed to an open flame.

 Warning
• Protect the equipment from any humidity (rain, snow, etc.).
• Disconnect the mains cable from the wall socket before moving the equipment. When moving the equipment, en-

sure that the mains cable does not remain under the machine so as not to damage it.
• When disconnecting the mains cable from the wall socket, always pull on the plug (and not the cable).
• Ensure that paper clips, staples and other small metal parts do not fall into the machine.
• Keep toners (used or unused), toner cartridges (or bottles), ink (used or unused) or ink cartridges out of the reach 

of children.
• Take care not to cut yourself when working inside the machine to remove paper jams.
• For environmental reasons, do not dispose of the machine or consumables at a household waste collection point. 

The equipment can be disposed of at an authorized dealer's or a suitable collection site.
• Our products are designed to meet the highest requirements in terms of quality and functionality. We recommend 

you only use consumables purchased from an authorized dealer.

 Warning
This product complies with class A regarding radiated emissions (EN55022), and may create interference with other 
information technology equipment or radio-TV or radiocommunications receivers placed in proximity, especially if it is 
installed in a residential environment.
The installation instructions in this respect are important and must be adhered to. If it is suspected that this installation 
is creating electromagnetic interference, switching it on / off may ensure that it is indeed the source of the interference.
If the interference is created by the installation, preventive measures must be taken to reduce interactions, i.e.:
• move the affected equipment away as far as possible,
• redirect or change the position of the antenna of the affected radio or TV receiver,
• connect the affected equipment to a mains power outlet on a different circuit to that of the source.

 CAUTION
Indicates a potentially dangerous situation that may lead to death or 
serious injury if instructions are not followed.

 Warning
Indicates a potentially dangerous situation that may lead to minor or moderate 
injury, or damage the equipment if instructions are not followed.
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Power supply

The plug must remain near the appliance and easily accessible.

For the Fax or the Telephone

 Warning
Line interfaces are classified TNV-3 in accordance with standard 60950-1.
• Never use this machine near a water source (for example beside a bath, sink or washtub), in a damp basement or 

near a swimming pool.
• Avoid using the telephone (other than cordless) during an electrical storm. You may risk exposure to electric shock 

due to lightening.
• Do not use a telephone near a gas leak to report the leak.

Handling and moving the machine

Shocks during handling

During printing, the paper tray, paper feeder, trap and other machine parts should not be subjected to any shocks.

Moving the machine

When moving the machine, it should be lifted, not dragged.
• Two people are required to move the machine. Keep the machine horizontal to prevent spilling toner.
• Never lift the machine using the metal scanner frame or you risk damaging it.
• To lift the machine, close the manual feeder and take hold of the machine as shown opposite.

• Even when an additional paper tray is installed, lift the machine as shown below. Do not take hold of the additional 
paper tray handle, or the side cover, as you risk damaging the lower paper feeder.
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Handling toner cartridges

The printer uses four toner cartridges: black, yellow, magenta and cyan. Handle toner cartridges with care, avoiding 
spilling toner on your hands or in the printer.
• Never place a toner cartridge on its end. Never hold the toner cartridge upside down.
• Never shake the toner cartridge.
• Never incinerate toner or toner cartridges. The sparks generated may cause burns.
• Never open the toner cartridge or throw away the waste toner bottle.
• Keep cartridges and waste toner bottles away from children.
• Never inhale toner. If your hands are stained with toner, never wipe your eyes or touch your mouth. Ensure that 

toner does not come in contact with your skin.
• If you get toner in your eyes, rinse immediately with cold water and consult a doctor.
• Toner on the hands can be cleaned using cold water and a mild soap.
• For the removal of used cartridges and waste toner bottles, consult your retailer; or dispose of toner and toner car-

tridges at a point specified by the local or national authority.
Keep new toner cartridges:
• In their original packaging.
• In a dry, cool room away from sunlight and heat.

The storage temperature should not exceed 35° C [95° F] and 85% humidity free of condensation.
• Flat.

Do not store toner cartridges vertically or upside down as the toner risks compacting or becoming unevenly distrib-
uted.

• Away from the sea air or corrosive vapours (aerosols for example).
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Environment

Preserving the environment is an essential concern of the manufacturer. The manufacturer wishes to operate 
installations that are environmentally-friendly and has chosen to integrate environmental performance in the whole life 
cycle of its products, from manufacture to installation, use and elimination.

Packaging
 

Batteries and rechargeable batteries
 

The product
 

In this way, you participate in the reuse and recovery of Waste Electrical and Electronic Equipment which may have 
potential effects on the environment and human health.

Energy Star
 

The presence of the logo (green point) means that a contribution has been paid to an approved 
national organisation, for improving packaging recovery and recycling infrastructures.
To facilitate recycling, please respect the sorting rules in place locally for this type of waste.

If your product contains batteries or rechargeable batteries, they must be disposed of in 
designated collection points.

The crossed bin symbol on the product indicates that it belongs to the electric and electronic 
equipment family.
As such, European regulations require that it be collected selectively:

At distribution points in the event an equivalent item of equipment is purchased.
In collection points available locally (household waste facility, selective collection, etc.).

The international ENERGY STAR® programme aims at promoting the development and 
awareness of low-consumption office equipment.
As an ENERGY STAR® partner, Sagemcom Documents SAS has determined that this 
product meets the ENERGY STAR® directives in terms of energy savings.
Your machine comes with a timer which switches to Energy saving mode after the last 
copy/print, configured to 5 or 15 minutes depending on the model. You will find a more 
detailed description of this function in the section Configuring the machine in this guide.
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Software user license

READ CAREFULLY ALL THE TERMS AND CONDITIONS OF THIS LICENSE BEFORE OPENING THE SEALED 
ENVELOPE CONTAINING THE SOFTWARE. OPENING THIS ENVELOPE INDICATES YOUR ACCEPTANCE OF 
THESE TERMS AND CONDITIONS.
If you do not accept the terms and conditions of this license, please return the CD-ROM in its unopened packaging to 
your retailer, along with the other components of the product. You will be refunded the price you paid for this product. 
No refunds will be made for products if the CD-ROM packaging has been opened, if components are missing or if the 
refund request is made after a period of ten (10) days following the date of delivery, with your receipt as proof of 
purchase.

Definition

The Software means the programs and associated documentation.

License

• This license allows you to use the Software on personal computers connected on a local area network. You may 
only use the Software to print on one multifunction printer, and you may not lend or transfer Software usage right to 
third parties.

• You are authorized to make one backup copy.
• This license is non exclusive and non transferrable.

Ownership

The manufacturer or its suppliers reserve the right of ownership to the Software. You are only the owner of the CD-
ROM. You must not modify, adapt, decompile, translate, create derivative works, rent or sell the Software or 
documentation. Any rights not expressly transferred are reserved by the manufacturer or its suppliers.

Duration

This license remains in force until cancellation. You may cancel the license by destroying the program and the 
documentation and any copies of them. This license will be automatically cancelled if you fail to respect  the terms of 
this license. In the event of cancellation, you undertake to destroy all copies of the program and the documentation.

Warranty

The Software is provided "as is" without any express or implied warranty of any kind, including warranties of 
merchantability, or fitness for a particular purpose; all risks concerning the results or performance of this Software shall 
be borne by the buyer. In the event the program is defective, all costs of repair shall be at the expense of the buyer.
The following guarantee is however applicable to the license holder: the CD-ROM on which the Software is recorded, 
is guaranteed to be free from material physical defects, under normal conditions of use and operation, for a period of 
ninety (90) days after the date of delivery, with your receipt as proof of purchase.  In the event the defect on the CD-
ROM occurs as the result of an accident or improper use, this CD-ROM will not be replaced under this warranty.

Liability

Your retailer's sole liability and your sole recourse is the replacement of this CD-ROM under the terms of the warranty 
which should be returned with a copy of your receipt. In no event shall the manufacturer or anyone involved in the 
creation, manufacture, sale or delivery of this program be liable for any damages either direct, indirect, incidental, 
consequential or otherwise, (including without limitation, lost information, lost time, business interruption, lost income, 
lost clients) arising out of the use of or inability to use the Software.

Development

With a view to continuous improvement, the manufacturer reserves the right to modify the characteristics of the 
Software without notice. In the event of modifications, your user rights do not give you the right to free updates.
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Applicable law

This license is subject to French law. Any disputes arising out of the interpretation or performance of this license shall 
be settled by the courts of Paris.
Given the permanent evolution in technology, the manufacturer reserves the right to change the technical 
characteristics indicated for this product at any time, without prior notice, and/or to interrupt the production of this 
product. All product names and brands which may be registered trade marks by their respective owners are recognized 
in this document.

Registered trademarks

Given the permanent evolution in technology, Sagemcom Documents SAS reserves the right to change the technical 
characteristics indicated for this product at any time, without prior notice, and/or to interrupt the production of this 
product. Companion Suite Pro is a registered trademark of Sagemcom Documents SAS.
Sagemcom is a registered trademark.
PCL® is a registered trademark of Hewlett-Packard Company.
PostScript® is a registered trademark of Adobe Systems Incorporated.
Adobe® and Adobe® products mentions are is registered trademarks of Adobe Systems Incorporated.
PaperPort11SE is a registered trademark of Nuance Communications, Inc.
Microsoft® Windows 2000®, Microsoft® Windows Server 2003®, Microsoft® Windows Server 2008®, Microsoft® 
Windows XP®, Microsoft® Windows Vista®, Microsoft® Windows 7® and all other Microsoft® products mentioned are 
registered trademarks of Microsoft Corporation registered and/or used in the United States and/or other countries.
All other brands or product names mentioned as examples or for information are the registered trademarks of their 
respective owners.
The information contained in this manual is subject to change without notice.

Reproductions prohibited

Never print or copy documents whose reproduction is prohibited by law.
Printing and copying of the following documents are usually prohibited by law:
• bank notes;
• cheques;
• obligations;
• certificates of deposit;
• loan titles.
The above list is provided for information only and is not exhaustive. In the event of a doubt as to the legality of copying 
or printing certain documents, consult a legal advisor.
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Software licenses

This product comprises software code developed by third parties, including software code subject to the GNU General 
Public License ("GPL") or GNU Lesser General Public License ("LGPL").
The terms of the GPL and LGPL, as well as information on obtaining access to the GPL Code and LGPL Code used 
in this product, are available at:
www.sc-itportal.com/fs
The GPL Code and LGPL Code used in this product is distributed WITHOUT ANY WARRANTY and is subject to the 
copyrights of one or more authors.
For more details, please refer to the GPL Code and LGPL Code for this product and the terms of the GPL and LGPL.

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

GNU GENERAL PUBLIC LICENSE Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA. 
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
Preamble
  The licenses for most software are designed to take away your freedom to share and change it.  By contrast, the GNU 
General Public License is intended to guarantee your freedom to share and change free software--to make sure the 
software is free for all its users.  This General Public License applies to most of the Free Software Foundation's 
software and to any other program whose authors commit to using it.  (Some other Free Software Foundation software 
is covered by the GNU Lesser General Public License instead.)  You can apply it to your programs, too.
  When we speak of free software, we are referring to freedom, not price.  Our General Public Licenses are designed 
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), 
that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new 
free programs; and that you know you can do these things.
  To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to 
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the 
software, or if you modify it.
  For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all 
the rights that you have. You must make sure that they, too, receive or can get the source code.  And you must show 
them these terms so they know their rights.
  We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal 
permission to copy, distribute and/or modify the software.
  Also, for each author's protection and ours, we want to make certain that everyone understands that there is no 
warranty for this free software.  If the software is modified by someone else and passed on, we want its recipients to 
know that what they have is not the original, so that any problems introduced by others will not reflect on the original 
authors' reputations.
  Finally, any free program is threatened constantly by software patents.  We wish to avoid the danger that redistributors 
of a free program will individually obtain patent licenses, in effect making the program proprietary.  To prevent this, we 
have made it clear that any patent must be licensed for everyone's free use or not licensed at all.
  The precise terms and conditions for copying, distribution and modification follow.
GNU GENERAL PUBLIC LICENSE
   TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
  0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it 
may be distributed under the terms of this General Public License.  The "Program", below, refers to any such program 
or work, and a "work based on the Program" means either the Program or any derivative work under copyright law: that 
is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated into 
another language.  (Hereinafter, translation is included without limitation in the term "modification".)  Each licensee is 
addressed as "you".
Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.  
The act of running the Program is not restricted, and the output from the Program is covered only if its contents 
constitute a work based on the Program (independent of having been made by running the Program). Whether that is 
true depends on what the Program does.
  1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium, 
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer 
of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and give any other 
recipients of the Program a copy of this License along with the Program.
You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection 
in exchange for a fee.
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  2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, 
and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet 
all of these conditions:
a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of any 
change.
b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the 
Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.
c) If the modified program normally reads commands interactively when run, you must cause it, when started running 
for such interactive use in the most ordinary way, to print or display an announcement including an appropriate 
copyright notice and a notice that there is no warranty (or else, saying that you provide a warranty) and that users may 
redistribute the program under these conditions, and telling the user how to view a copy of this License.  (Exception: if 
the Program itself is interactive but does not normally print such an announcement, your work based on the Program 
is not required to print an announcement.)
These requirements apply to the modified work as a whole.  If identifiable sections of that work are not derived from 
the Program, and can be reasonably considered independent and separate works in themselves, then this License, 
and its terms, do not apply to those sections when you distribute them as separate works.  But when you distribute the 
same sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the 
terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every 
part regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the 
intent is to exercise the right to control the distribution of derivative or collective works based on the Program.
In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on 
the Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this 
License.
  3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable 
form under the terms of Sections 1 and 2 above provided that you also do one of the following:
a) Accompany it with the complete corresponding machine-readable source code, which must be distributed under the 
terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your 
cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, 
to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
c) Accompany it with the information you received as to the offer to distribute corresponding source code.  (This 
alternative is allowed only for noncommercial distribution and only if you received the program in object code or 
executable form with such an offer, in accord with Subsection b above.)
The source code for a work means the preferred form of the work for making modifications to it.  For an executable 
work, complete source code means all the source code for all modules it contains, plus any associated interface 
definition files, plus the scripts used to control compilation and installation of the executable.  However, as a special 
exception, the source code distributed need not include anything that is normally distributed (in either source or binary 
form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, 
unless that component itself accompanies the executable.
If distribution of executable or object code is made by offering access to copy from a designated place, then offering 
equivalent access to copy the source code from the same place counts as distribution of the source code, even though 
third parties are not compelled to copy the source along with the object code.
  4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License.  
Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate 
your rights under this License. However, parties who have received copies, or rights, from you under this License will 
not have their licenses terminated so long as such parties remain in full compliance.
  5. You are not required to accept this License, since you have not signed it.  However, nothing else grants you 
permission to modify or distribute the Program or its derivative works.  These actions are prohibited by law if you do 
not accept this License.  Therefore, by modifying or distributing the Program (or any work based on the Program), you 
indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying 
the Program or works based on it.
  6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives 
a license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions.  You 
may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible 
for enforcing compliance by third parties to this License.
  7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to 
patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the 
conditions of this License, they do not excuse you from the conditions of this License.  If you cannot distribute so as to 
satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence 
you may not distribute the Program at all.  For example, if a patent license would not permit royalty-free redistribution 
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of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy 
both it and this License would be to refrain entirely from distribution of the Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the 
section is intended to apply and the section as a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest 
validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution 
system, which is implemented by public license practices.  Many people have made generous contributions to the wide 
range of software distributed through that system in reliance on consistent application of that system; it is up to the 
author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot 
impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.
  8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted 
interfaces, the original copyright holder who places the Program under this License may add an explicit geographical 
distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus 
excluded.  In such case, this License incorporates the limitation as if written in the body of this License.
  9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time 
to time.  Such new versions will be similar in spirit to the present version, but may differ in detail to address new 
problems or concerns.
Each version is given a distinguishing version number.  If the Program specifies a version number of this License which 
applies to it and "any later version", you have the option of following the terms and conditions either of that version or 
of any later version published by the Free Software Foundation.  If the Program does not specify a version number of 
this License, you may choose any version ever published by the Free Software Foundation.
  10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, 
write to the author to ask for permission.  For software which is copyrighted by the Free Software Foundation, write to 
the Free Software Foundation; we sometimes make exceptions for this.  Our decision will be guided by the two goals 
of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software 
generally.
NO WARRANTY
  11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE 
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN OTHERWISE STATED IN 
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE 
RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM 
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
  12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY 
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM 
AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE 
PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR 
LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY 
OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs
  If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve 
this is to make it free software which everyone can redistribute and change under these terms.
 To do so, attach the following notices to the program.  It is safest to attach them to the start of each source file to most 
effectively convey the exclusion of warranty; and each file should have at least the "copyright" line and a pointer to 
where the full notice is found.
    <one line to give the program's name and a brief idea of what it does.> Copyright (C) <year>  <name of author>
    This program is free software; you can redistribute it and/or modify it under the terms of the GNU General Public 
License as published by the Free Software Foundation; either version 2 of the License, or (at your option) any later 
version.
    This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the 
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU General Public 
License for more details.
    You should have received a copy of the GNU General Public License along with this program; if not, write to the Free 
Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.
Also add information on how to contact you by electronic and paper mail.
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If the program is interactive, make it output a short notice like this when it starts in an interactive mode:
    Gnomovision version 69, Copyright (C) year name of author Gnomovision comes with ABSOLUTELY NO 
WARRANTY; for details type `show w'. This is free software, and you are welcome to redistribute it under certain 
conditions; type `show c' for details.
The hypothetical commands `show w' and `show c' should show the appropriate parts of the General Public License.  
Of course, the commands you use may be called something other than `show w' and `show c'; they could even be 
mouse-clicks or menu items--whatever suits your program.
You should also get your employer (if you work as a programmer) or your school, if any, to sign a "copyright disclaimer" 
for the program, if necessary.  Here is a sample; alter the names:
  Yoyodyne, Inc., hereby disclaims all copyright interest in the program `Gnomovision' (which makes passes at 
compilers) written by James Hacker.
  <signature of Ty Coon>, 1 April 1989
  Ty Coon, President of Vice
This General Public License does not permit incorporating your program into proprietary programs.  If your program is 
a subroutine library, you may consider it more useful to permit linking proprietary applications with the library.  If this is 
what you want to do, use the GNU Lesser General Public License instead of this License.

GNU LESSER GENERAL PUBLIC LICENSE Version 2.1, February 1999

GNU LESSER GENERAL PUBLIC LICENSE Version 2.1, February 1999
Copyright (C) 1991, 1999 Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  
USA. Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not 
allowed.
[This is the first released version of the Lesser GPL.  It also counts as the successor of the GNU Library Public License, 
version 2, hence the version number 2.1.]
Preamble
  The licenses for most software are designed to take away your freedom to share and change it.  By contrast, the GNU 
General Public Licenses are intended to guarantee your freedom to share and change free software--to make sure the 
software is free for all its users.
  This license, the Lesser General Public License, applies to some specially designated software packages--typically 
libraries--of the Free Software Foundation and other authors who decide to use it.  You can use it too, but we suggest 
you first think carefully about whether this license or the ordinary General Public License is the better strategy to use 
in any particular case, based on the explanations below.
  When we speak of free software, we are referring to freedom of use, not price.  Our General Public Licenses are 
designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if 
you wish); that you receive source code or can get it if you want it; that you can change the software and use pieces 
of it in new free programs; and that you are informed that you can do these things.
  To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to 
surrender these rights.  These restrictions translate to certain responsibilities for you if you distribute copies of the 
library or if you modify it.
  For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights 
that we gave you.  You must make sure that they, too, receive or can get the source code.  If you link other code with 
the library, you must provide complete object files to the recipients, so that they can relink them with the library after 
making changes to the library and recompiling it.  And you must show them these terms so they know their rights.
 We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which 
gives you legal permission to copy, distribute and/or modify the library.
  To protect each distributor, we want to make it very clear that there is no warranty for the free library.  Also, if the 
library is modified by someone else and passed on, the recipients should know that what they have is not the original 
version, so that the original author's reputation will not be affected by problems that might be introduced by others.
  Finally, software patents pose a constant threat to the existence of any free program.  We wish to make sure that a 
company cannot effectively restrict the users of a free program by obtaining a restrictive license from a patent holder.  
Therefore, we insist that any patent license obtained for a version of the library must be consistent with the full freedom 
of use specified in this license.
  Most GNU software, including some libraries, is covered by the ordinary GNU General Public License.  This license, 
the GNU Lesser General Public License, applies to certain designated libraries, and is quite different from the ordinary 
General Public License.  We use this license for certain libraries in order to permit linking those libraries into non-free 
programs.
  When a program is linked with a library, whether statically or using a shared library, the combination of the two is 
legally speaking a combined work, a derivative of the original library.  The ordinary General Public License therefore 
permits such linking only if the entire combination fits its criteria of freedom.  The Lesser General Public License permits 
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more lax criteria for linking other code with the library.
  We call this license the "Lesser" General Public License because it does Less to protect the user's freedom than the 
ordinary General Public License.  It also provides other free software developers Less of an advantage over competing 
non-free programs.  These disadvantages are the reason we use the ordinary General Public License for many 
libraries.  However, the Lesser license provides advantages in certain special circumstances.
  For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, 
so that it becomes a de-facto standard.  To achieve this, non-free programs must be allowed to use the library.  A more 
frequent case is that a free library does the same job as widely used non-free libraries.  In this case, there is little to 
gain by limiting the free library to free software only, so we use the Lesser General Public License.
  In other cases, permission to use a particular library in non-free programs enables a greater number of people to use 
a large body of free software.  For example, permission to use the GNU C Library in non-free programs enables many 
more people to use the whole GNU operating system, as well as its variant, the GNU/Linux operating system.
  Although the Lesser General Public License is Less protective of the users' freedom, it does ensure that the user of 
a program that is linked with the Library has the freedom and the wherewithal to run that program using a modified 
version of the Library.
  The precise terms and conditions for copying, distribution and modification follow.  Pay close attention to the difference 
between a "work based on the library" and a "work that uses the library".  The former contains code derived from the 
library, whereas the latter must be combined with the library in order to run.
GNU LESSER GENERAL PUBLIC LICENSE
   TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
  0. This License Agreement applies to any software library or other program which contains a notice placed by the 
copyright holder or other authorized party saying it may be distributed under the terms of this Lesser General Public 
License (also called "this License"). Each licensee is addressed as "you".
  A "library" means a collection of software functions and/or data prepared so as to be conveniently linked with 
application programs (which use some of those functions and data) to form executables.
  The "Library", below, refers to any such software library or work which has been distributed under these terms.  A 
"work based on the Library" means either the Library or any derivative work under copyright law: that is to say, a work 
containing the Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly into 
another language.  (Hereinafter, translation is included without limitation in the term "modification".)
  "Source code" for a work means the preferred form of the work for making modifications to it.  For a library, complete 
source code means all the source code for all modules it contains, plus any associated interface definition files, plus 
the scripts used to control compilation and installation of the library.
  Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.  
The act of running a program using the Library is not restricted, and output from such a program is covered only if its 
contents constitute a work based on the Library (independent of the use of the Library in a tool for writing it).  Whether 
that is true depends on what the Library does and what the program that uses the Library does.
  1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any 
medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and 
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and 
distribute a copy of this License along with the Library.
  You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection 
in exchange for a fee.
  2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, 
and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet 
all of these conditions:
    a) The modified work must itself be a software library.
    b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of 
any change.
    c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.
    d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program 
that uses the facility, other than as an argument passed when the facility is invoked, then you must make a good faith 
effort to ensure that, in the event an application does not supply such function or table, the facility still operates, and 
performs whatever part of its purpose remains meaningful.
    (For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent 
of the application.  Therefore, Subsection 2d requires that any application-supplied function or table used by this 
function must be optional: if the application does not supply it, the square root function must still compute square roots.)
These requirements apply to the modified work as a whole.  If identifiable sections of that work are not derived from 
the Library, and can be reasonably considered independent and separate works in themselves, then this License, and 
its terms, do not apply to those sections when you distribute them as separate works.  But when you distribute the same 
sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the terms of 
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this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part 
regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the 
intent is to exercise the right to control the distribution of derivative or collective works based on the Library.
In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the 
Library) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.
  3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy 
of the Library.  To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU 
General Public License, version 2, instead of to this License.  (If a newer version than version 2 of the ordinary GNU 
General Public License has appeared, then you can specify that version instead if you wish.)  Do not make any other 
change in these notices.
  Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License 
applies to all subsequent copies and derivative works made from that copy.
  This option is useful when you wish to copy part of the code of the Library into a program that is not a library.
  4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable 
form under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding 
machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium 
customarily used for software interchange.
  If distribution of object code is made by offering access to copy from a designated place, then offering equivalent 
access to copy the source code from the same place satisfies the requirement to distribute the source code, even 
though third parties are not compelled to copy the source along with the object code.
  5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being 
compiled or linked with it, is called a "work that uses the Library".  Such a work, in isolation, is not a derivative work of 
the Library, and therefore falls outside the scope of this License.
  However, linking a "work that uses the Library" with the Library creates an executable that is a derivative of the Library 
(because it contains portions of the Library), rather than a "work that uses the library".  The executable is therefore 
covered by this License. Section 6 states terms for distribution of such executables.
  When a "work that uses the Library" uses material from a header file that is part of the Library, the object code for the 
work may be a derivative work of the Library even though the source code is not. Whether this is true is especially 
significant if the work can be linked without the Library, or if the work is itself a library.  The threshold for this to be true 
is not precisely defined by law.
  If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and 
small inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it 
is legally a derivative work.  (Executables containing this object code plus portions of the Library will still fall under 
Section 6.)
  Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms 
of Section 6. Any executables containing that work also fall under Section 6, whether or not they are linked directly with 
the Library itself.
  6. As an exception to the Sections above, you may also combine or link a "work that uses the Library" with the Library 
to produce a work containing portions of the Library, and distribute that work under terms of your choice, provided that 
the terms permit modification of the work for the customer's own use and reverse engineering for debugging such 
modifications.
  You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its 
use are covered by this License.  You must supply a copy of this License.  If the work during execution displays 
copyright notices, you must include the copyright notice for the Library among them, as well as a reference directing 
the user to the copy of this License.  Also, you must do one of these things:
    a) Accompany the work with the complete corresponding machine-readable source code for the Library including 
whatever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work 
is an executable linked with the Library, with the complete machine-readable "work that uses the Library", as object 
code and/or source code, so that the user can modify the Library and then relink to produce a modified executable 
containing the modified Library.  (It is understood that the user who changes the contents of definitions files in the 
Library will not necessarily be able to recompile the application to use the modified definitions.)
    b) Use a suitable shared library mechanism for linking with the Library.  A suitable mechanism is one that (1) uses 
at run time a copy of the library already present on the user's computer system, rather than copying library functions 
into the executable, and (2) will operate properly with a modified version of the library, if the user installs one, as long 
as the modified version is interface-compatible with the version that the work was made with.
    c) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified 
in Subsection 6a, above, for a charge no more than the cost of performing this distribution.
    d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to 
copy the above specified materials from the same place.
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    e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.
  For an executable, the required form of the "work that uses the Library" must include any data and utility programs 
needed for reproducing the executable from it.  However, as a special exception, the materials to be distributed need 
not include anything that is normally distributed (in either source or binary form) with the major components (compiler, 
kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies 
the executable.
  It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not 
normally accompany the operating system.  Such a contradiction means you cannot use both them and the Library 
together in an executable that you distribute.
  7. You may place library facilities that are a work based on the Library side-by-side in a single library together with 
other library facilities not covered by this License, and distribute such a combined library, provided that the separate 
distribution of the work based on the Library and of the other library facilities is otherwise permitted, and provided that 
you do these two things:
    a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other 
library facilities.  This must be distributed under the terms of the Sections above.
    b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and 
explaining where to find the accompanying uncombined form of the same work.
  8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this 
License.  Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will 
automatically terminate your rights under this License.  However, parties who have received copies, or rights, from you 
under this License will not have their licenses terminated so long as such parties remain in full compliance.
  9. You are not required to accept this License, since you have not signed it.  However, nothing else grants you 
permission to modify or distribute the Library or its derivative works.  These actions are prohibited by law if you do not 
accept this License.  Therefore, by modifying or distributing the Library (or any work based on the Library), you indicate 
your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the 
Library or works based on it.
  10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a 
license from the original licensor to copy, distribute, link with or modify the Library subject to these terms and conditions.  
You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not 
responsible for enforcing compliance by third parties with this License.
  11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited 
to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the 
conditions of this License, they do not excuse you from the conditions of this License.  If you cannot distribute so as to 
satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence 
you may not distribute the Library at all.  For example, if a patent license would not permit royalty-free redistribution of 
the Library by all those who receive copies directly or indirectly through you, then the only way you could satisfy both 
it and this License would be to refrain entirely from distribution of the Library.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the 
section is intended to apply, and the section as a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest 
validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution 
system which is implemented by public license practices.  Many people have made generous contributions to the wide 
range of software distributed through that system in reliance on consistent application of that system; it is up to the 
author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot 
impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.
  12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted 
interfaces, the original copyright holder who places the Library under this License may add an explicit geographical 
distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus 
excluded.  In such case, this License incorporates the limitation as if written in the body of this License.
  13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License 
from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address 
new problems or concerns.
Each version is given a distinguishing version number.  If the Library specifies a version number of this License which 
applies to it and "any later version", you have the option of following the terms and conditions either of that version or 
of any later version published by the Free Software Foundation.  If the Library does not specify a license version 
number, you may choose any version ever published by the Free Software Foundation.
  14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are 
incompatible with these, write to the author to ask for permission.  For software which is copyrighted by the Free 
Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this.  Our decision 
will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the 
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sharing and reuse of software generally.
NO WARRANTY
  15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, 
TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE 
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF 
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY 
AND PERFORMANCE OF THE LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU 
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
  16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY 
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS 
PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL 
OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING 
BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY 
YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN 
IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Libraries
  If you develop a new library, and you want it to be of the greatest possible use to the public, we recommend making 
it free software that everyone can redistribute and change.  You can do so by permitting redistribution under these 
terms (or, alternatively, under the terms of the ordinary General Public License).
  To apply these terms, attach the following notices to the library.  It is safest to attach them to the start of each source 
file to most effectively convey the exclusion of warranty; and each file should have at least the "copyright" line and a 
pointer to where the full notice is found.
    <one line to give the library's name and a brief idea of what it does.> Copyright (C) <year>  <name of author>
    This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public 
License as published by the Free Software Foundation; either version 2.1 of the License, or (at your option) any later 
version.
    This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied 
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU Lesser General Public 
License for more details.
    You should have received a copy of the GNU Lesser General Public License along with this library; if not, write to 
the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  USA.
Also add information on how to contact you by electronic and paper mail.
You should also get your employer (if you work as a programmer) or your school, if any, to sign a "copyright disclaimer" 
for the library, if necessary.  Here is a sample; alter the names:
  Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for tweaking knobs) written by 
James Random Hacker.
  <signature of Ty Coon>, 1 April 1990
  Ty Coon, President of Vice
That's all there is to it!

OpenOffice.org v 3.1.0 - GNU LGPLv3

This product contains third-party free software (OpenOffice.org) where the software code is subject to a GNU Lesser 
General Public License ("LGPL").
The terms and conditions for GPL and LGPL as well as LGPL access information used for this product can be found at 
www.sc-itportal.com/fs
For more information, please refer to the LGPL code for this product as well as the terms and conditions for GPL and 
LGPL.

GNU GENERAL PUBLIC LICENSE Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>  Everyone is permitted to copy and distribute 
verbatim copies  of this license document, but changing it is not allowed.
Preamble
 The GNU General Public License is a free, copyleft license for software and other kinds of works.
 The licenses for most software and other practical works are designed to take away your freedom to share and change 
the works.  By contrast, the GNU General Public License is intended to guarantee your freedom to share and change 
- 136 -



MF 6990dn - Agoris C935

15
 - 

Sa
fe

ty
all versions of a program--to make sure it remains free software for all its users.  We, the Free Software Foundation, 
use the GNU General Public License for most of our software; it applies also to any other work released this way by its 
authors.  You can apply it to your programs, too.
 When we speak of free software, we are referring to freedom, not price.  Our General Public Licenses are designed 
to make sure that you have the freedom to distribute copies of free software (and charge for them if you wish), that you 
receive source code or can get it if you want it, that you can change the software or use pieces of it in new free 
programs, and that you know you can do these things.
 To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights.  
Therefore, you have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities 
to respect the freedom of others.
 For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients 
the same freedoms that you received.  You must make sure that they, too, receive or can get the source code.  And 
you must show them these terms so they know their rights.
 Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer 
you this License giving you legal permission to copy, distribute and/or modify it.
 For the developers’ and authors’ protection, the GPL clearly explains that there is no warranty for this free software.  
For both users’ and authors’ sake, the GPL requires that modified versions be marked as changed, so that their 
problems will not be attributed erroneously to authors of previous versions.
 Some devices are designed to deny users access to install or run modified versions of the software inside them, 
although the manufacturer can do so.  This is fundamentally incompatible with the aim of protecting users’ freedom to 
change the software.  The systematic pattern of such abuse occurs in the area of products for individuals to use, which 
is precisely where it is most unacceptable.  Therefore, we have designed this version of the GPL to prohibit the practice 
for those products.  If such problems arise substantially in other domains, we stand ready to extend this provision to 
those domains in future versions of the GPL, as needed to protect the freedom of users.
 Finally, every program is threatened constantly by software patents. States should not allow patents to restrict 
development and use of software on general-purpose computers, but in those that do, we wish to avoid the special 
danger that patents applied to a free program could make it effectively proprietary.  To prevent this, the GPL assures 
that patents cannot be used to render the program non-free.
 The precise terms and conditions for copying, distribution and modification follow.
TERMS AND CONDITIONS
 0. Definitions.
 "This License" refers to version 3 of the GNU General Public License.
 "Copyright" also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.
 "The Program" refers to any copyrightable work licensed under this License.  Each licensee is addressed as "you".  
"Licensees" and "recipients" may be individuals or organizations.
 To "modify" a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, 
other than the making of an exact copy.  The resulting work is called a "modified version" of the earlier work or a work 
"based on" the earlier work.
 A "covered work" means either the unmodified Program or a work based on the Program.
 To "propagate" a work means to do anything with it that, without permission, would make you directly or secondarily 
liable for infringement under applicable copyright law, except executing it on a computer or modifying a private copy.  
Propagation includes copying, distribution (with or without modification), making available to the public, and in some 
countries other activities as well.
 To "convey" a work means any kind of propagation that enables other parties to make or receive copies.  Mere 
interaction with a user through a computer network, with no transfer of a copy, is not conveying.
 An interactive user interface displays "Appropriate Legal Notices" to the extent that it includes a convenient and 
prominently visible feature that (1) displays an appropriate copyright notice, and (2) tells the user that there is no 
warranty for the work (except to the extent that warranties are provided), that licensees may convey the work under 
this License, and how to view a copy of this License.  If the interface presents a list of user commands or options, such 
as a menu, a prominent item in the list meets this criterion.
 1. Source Code.
 The "source code" for a work means the preferred form of the work for making modifications to it.  "Object code" means 
any non-source form of a work.
 A "Standard Interface" means an interface that either is an official standard defined by a recognized standards body, 
or, in the case of interfaces specified for a particular programming language, one that is widely used among developers 
working in that language.
 The "System Libraries" of an executable work include anything, other than the work as a whole, that (a) is included in 
the normal form of packaging a Major Component, but which is not part of that Major Component, and (b) serves only 
to enable use of the work with that Major Component, or to implement a Standard Interface for which an implementation 
is available to the public in source code form.  A "Major Component", in this context, means a major essential 
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component (kernel, window system, and so on) of the specific operating system (if any) on which the executable work 
runs, or a compiler used to produce the work, or an object code interpreter used to run it.
 The "Corresponding Source" for a work in object code form means all the source code needed to generate, install, and 
(for an executable work) run the object code and to modify the work, including scripts to control those activities.  
However, it does not include the work’s System Libraries, or general-purpose tools or generally available free programs 
which are used unmodified in performing those activities but which are not part of the work.  For example, 
Corresponding Source includes interface definition files associated with source files for the work, and the source code 
for shared libraries and dynamically linked subprograms that the work is specifically designed to require, such as by 
intimate data communication or control flow between those subprograms and other parts of the work.
 The Corresponding Source need not include anything that users can regenerate automatically from other parts of the 
Corresponding Source.
 The Corresponding Source for a work in source code form is that same work.
 2. Basic Permissions.
 All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided 
the stated conditions are met.  This License explicitly affirms your unlimited permission to run the unmodified Program.  
The output from running a covered work is covered by this License only if the output, given its content, constitutes a 
covered work.  This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.
 You may make, run and propagate covered works that you do not convey, without conditions so long as your license 
otherwise remains in force.  You may convey covered works to others for the sole purpose of having them make 
modifications exclusively for you, or provide you with facilities for running those works, provided that you comply with 
the terms of this License in conveying all material for which you do not control copyright.  Those thus making or running 
the covered works for you must do so exclusively on your behalf, under your direction and control, on terms that prohibit 
them from making any copies of your copyrighted material outside their relationship with you.
 Conveying under any other circumstances is permitted solely under the conditions stated below.  Sublicensing is not 
allowed; section 10 makes it unnecessary.
 3. Protecting Users’ Legal Rights From Anti-Circumvention Law.
 No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling 
obligations under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or 
restricting circumvention of such measures.
 When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to 
the extent such circumvention is effected by exercising rights under this License with respect to the covered work, and 
you disclaim any intention to limit operation or modification of the work as a means of enforcing, against the work’s 
users, your or third parties’ legal rights to forbid circumvention of technological measures.
 4. Conveying Verbatim Copies.
 You may convey verbatim copies of the Program’s source code as you receive it, in any medium, provided that you 
conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating 
that this License and any non-permissive terms added in accord with section 7 apply to the code; keep intact all notices 
of the absence of any warranty; and give all recipients a copy of this License along with the Program.  You may charge 
any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.
 5. Conveying Modified Source Versions.
 You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of 
source code under the terms of section 4, provided that you also meet all of these conditions:
 a) The work must carry prominent notices stating that you modified     it, and giving a relevant date.
 b) The work must carry prominent notices stating that it is     released under this License and any conditions added 
under section     7.  This requirement modifies the requirement in section 4 to     "keep intact all notices".
 c) You must license the entire work, as a whole, under this     License to anyone who comes into possession of a copy.  
This     License will therefore apply, along with any applicable section 7     additional terms, to the whole of the work, 
and all its parts,     regardless of how they are packaged.  This License gives no     permission to license the work in 
any other way, but it does not     invalidate such permission if you have separately received it.
 d) If the work has interactive user interfaces, each must display     Appropriate Legal Notices; however, if the Program 
has interactive     interfaces that do not display Appropriate Legal Notices, your     work need not make them do so.
 A compilation of a covered work with other separate and independent works, which are not by their nature extensions 
of the covered work, and which are not combined with it such as to form a larger program, in or on a volume of a storage 
or distribution medium, is called an "aggregate" if the compilation and its resulting copyright are not used to limit the 
access or legal rights of the compilation’s users beyond what the individual works permit.  Inclusion of a covered work 
in an aggregate does not cause this License to apply to the other parts of the aggregate.
 6. Conveying Non-Source Forms.
 You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey 
the machine-readable Corresponding Source under the terms of this License, in one of these ways:
 a) Convey the object code in, or embodied in, a physical product     (including a physical distribution medium), 
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accompanied by the     Corresponding Source fixed on a durable physical medium     customarily used for software 
interchange.
 b) Convey the object code in, or embodied in, a physical product     (including a physical distribution medium), 
accompanied by a     written offer, valid for at least three years and valid for as     long as you offer spare parts or 
customer support for that product     model, to give anyone who possesses the object code either (1) a     copy of the 
Corresponding Source for all the software in the     product that is covered by this License, on a durable physical     
medium customarily used for software interchange, for a price no     more than your reasonable cost of physically 
performing this     conveying of source, or (2) access to copy the     Corresponding Source from a network server at no 
charge.
 c) Convey individual copies of the object code with a copy of the     written offer to provide the Corresponding Source.  
This     alternative is allowed only occasionally and noncommercially, and     only if you received the object code with 
such an offer, in accord     with subsection 6b.
 d) Convey the object code by offering access from a designated     place (gratis or for a charge), and offer equivalent 
access to the     Corresponding Source in the same way through the same place at no     further charge.  You need not 
require recipients to copy the     Corresponding Source along with the object code.  If the place to     copy the object 
code is a network server, the Corresponding Source     may be on a different server (operated by you or a third party)     
that supports equivalent copying facilities, provided you maintain     clear directions next to the object code saying 
where to find the     Corresponding Source.  Regardless of what server hosts the     Corresponding Source, you remain 
obligated to ensure that it is     available for as long as needed to satisfy these requirements.
 e) Convey the object code using peer-to-peer transmission, provided     you inform other peers where the object code 
and Corresponding     Source of the work are being offered to the general public at no     charge under subsection 6d.
 A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System 
Library, need not be included in conveying the object code work.
 A "User Product" is either (1) a "consumer product", which means any tangible personal property which is normally 
used for personal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling.  In 
determining whether a product is a consumer product, doubtful cases shall be resolved in favor of coverage.  For a 
particular product received by a particular user, "normally used" refers to a typical or common use of that class of 
product, regardless of the status of the particular user or of the way in which the particular user actually uses, or expects 
or is expected to use, the product.  A product is a consumer product regardless of whether the product has substantial 
commercial, industrial or non-consumer uses, unless such uses represent the only significant mode of use of the 
product.
 "Installation Information" for a User Product means any methods, procedures, authorization keys, or other information 
required to install and execute modified versions of a covered work in that User Product from a modified version of its 
Corresponding Source.  The information must suffice to ensure that the continued functioning of the modified object 
code is in no case prevented or interfered with solely because modification has been made.
 If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the 
conveying occurs as part of a transaction in which the right of possession and use of the User Product is transferred 
to the recipient in perpetuity or for a fixed term (regardless of how the transaction is characterized), the Corresponding 
Source conveyed under this section must be accompanied by the Installation Information.  But this requirement does 
not apply if neither you nor any third party retains the ability to install modified object code on the User Product (for 
example, the work has been installed in ROM).
 The requirement to provide Installation Information does not include a requirement to continue to provide support 
service, warranty, or updates for a work that has been modified or installed by the recipient, or for the User Product in 
which it has been modified or installed.  Access to a network may be denied when the modification itself materially and 
adversely affects the operation of the network or violates the rules and protocols for communication across the network.
 Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format 
that is publicly documented (and with an implementation available to the public in source code form), and must require 
no special password or key for unpacking, reading or copying.
 7. Additional Terms.
 "Additional permissions" are terms that supplement the terms of this License by making exceptions from one or more 
of its conditions. Additional permissions that are applicable to the entire Program shall be treated as though they were 
included in this License, to the extent that they are valid under applicable law.  If additional permissions apply only to 
part of the Program, that part may be used separately under those permissions, but the entire Program remains 
governed by this License without regard to the additional permissions.
 When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, 
or from any part of it.  (Additional permissions may be written to require their own removal in certain cases when you 
modify the work.)  You may place additional permissions on material, added by you to a covered work, for which you 
have or can give appropriate copyright permission.
 Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by 
the copyright holders of that material) supplement the terms of this License with terms:
 a) Disclaiming warranty or limiting liability differently from the     terms of sections 15 and 16 of this License; or
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 b) Requiring preservation of specified reasonable legal notices or     author attributions in that material or in the 
Appropriate Legal     Notices displayed by works containing it; or
 c) Prohibiting misrepresentation of the origin of that material, or     requiring that modified versions of such material be 
marked in     reasonable ways as different from the original version; or
 d) Limiting the use for publicity purposes of names of licensors or     authors of the material; or
 e) Declining to grant rights under trademark law for use of some     trade names, trademarks, or service marks; or
 f) Requiring indemnification of licensors and authors of that     material by anyone who conveys the material (or 
modified versions of     it) with contractual assumptions of liability to the recipient, for     any liability that these contractual 
assumptions directly impose on     those licensors and authors.
 All other non-permissive additional terms are considered "further restrictions" within the meaning of section 10.  If the 
Program as you received it, or any part of it, contains a notice stating that it is governed by this License along with a 
term that is a further restriction, you may remove that term.  If a license document contains a further restriction but 
permits relicensing or conveying under this License, you may add to a covered work material governed by the terms 
of that license document, provided that the further restriction does not survive such relicensing or conveying.
 If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement 
of the additional terms that apply to those files, or a notice indicating where to find the applicable terms.
 Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as 
exceptions; the above requirements apply either way.
 8. Termination.
 You may not propagate or modify a covered work except as expressly provided under this License.  Any attempt 
otherwise to propagate or modify it is void, and will automatically terminate your rights under this License (including 
any patent licenses granted under the third paragraph of section 11).
 However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) 
provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if 
the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.
 Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you 
of the violation by some reasonable means, this is the first time you have received notice of violation of this License 
(for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.
 Termination of your rights under this section does not terminate the licenses of parties who have received copies or 
rights from you under this License.  If your rights have been terminated and not permanently reinstated, you do not 
qualify to receive new licenses for the same material under section 10.
 9. Acceptance Not Required for Having Copies.
 You are not required to accept this License in order to receive or run a copy of the Program.  Ancillary propagation of 
a covered work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does 
not require acceptance.  However, nothing other than this License grants you permission to propagate or modify any 
covered work.  These actions infringe copyright if you do not accept this License.  Therefore, by modifying or 
propagating a covered work, you indicate your acceptance of this License to do so.
 10. Automatic Licensing of Downstream Recipients.
 Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, 
modify and propagate that work, subject to this License.  You are not responsible for enforcing compliance by third 
parties with this License.
 An "entity transaction" is a transaction transferring control of an organization, or substantially all assets of one, or 
subdividing an organization, or merging organizations.  If propagation of a covered work results from an entity 
transaction, each party to that transaction who receives a copy of the work also receives whatever licenses to the work 
the party’s predecessor in interest had or could give under the previous paragraph, plus a right to possession of the 
Corresponding Source of the work from the predecessor in interest, if the predecessor has it or can get it with 
reasonable efforts.
 You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License.  For 
example, you may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, 
and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is 
infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.
 11. Patents.
 A "contributor" is a copyright holder who authorizes use under this License of the Program or a work on which the 
Program is based.  The work thus licensed is called the contributor’s "contributor version".
 A contributor’s "essential patent claims" are all patent claims owned or controlled by the contributor, whether already 
acquired or hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, 
or selling its contributor version, but do not include claims that would be infringed only as a consequence of further 
modification of the contributor version.  For purposes of this definition, "control" includes the right to grant patent 
sublicenses in a manner consistent with the requirements of this License.
 Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor’s essential 
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patent claims, to make, use, sell, offer for sale, import and otherwise run, modify and propagate the contents of its 
contributor version.
 In the following three paragraphs, a "patent license" is any express agreement or commitment, however denominated, 
not to enforce a patent (such as an express permission to practice a patent or covenant not to sue for patent 
infringement).  To "grant" such a patent license to a party means to make such an agreement or commitment not to 
enforce a patent against the party.
 If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not 
available for anyone to copy, free of charge and under the terms of this License, through a publicly available network 
server or other readily accessible means, then you must either (1) cause the Corresponding Source to be so available, 
or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner 
consistent with the requirements of this License, to extend the patent license to downstream recipients.  "Knowingly 
relying" means you have actual knowledge that, but for the patent license, your conveying the covered work in a 
country, or your recipient’s use of the covered work in a country, would infringe one or more identifiable patents in that 
country that you have reason to believe are valid.
 If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring 
conveyance of, a covered work, and grant a patent license to some of the parties receiving the covered work 
authorizing them to use, propagate, modify or convey a specific copy of the covered work, then the patent license you 
grant is automatically extended to all recipients of the covered work and works based on it.
 A patent license is "discriminatory" if it does not include within the scope of its coverage, prohibits the exercise of, or 
is conditioned on the non-exercise of one or more of the rights that are specifically granted under this License.  You 
may not convey a covered work if you are a party to an arrangement with a third party that is in the business of 
distributing software, under which you make payment to the third party based on the extent of your activity of conveying 
the work, and under which the third party grants, to any of the parties who would receive the covered work from you, 
a discriminatory patent license (a) in connection with copies of the covered work conveyed by you (or copies made 
from those copies), or (b) primarily for and in connection with specific products or compilations that contain the covered 
work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.
 Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement 
that may otherwise be available to you under applicable patent law.
 12. No Surrender of Others’ Freedom.
 If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of 
this License, they do not excuse you from the conditions of this License.  If you cannot convey a covered work so as 
to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a 
consequence you may not convey it at all.  For example, if you agree to terms that obligate you to collect a royalty for 
further conveying from those to whom you convey the Program, the only way you could satisfy both those terms and 
this License would be to refrain entirely from conveying the Program.
 13. Use with the GNU Affero General Public License.
 Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a 
work licensed under version 3 of the GNU Affero General Public License into a single combined work, and to convey 
the resulting work.  The terms of this License will continue to apply to the part which is the covered work, but the special 
requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply 
to the combination as such.
 14. Revised Versions of this License.
 The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time 
to time.  Such new versions will be similar in spirit to the present version, but may differ in detail to address new 
problems or concerns.
 Each version is given a distinguishing version number.  If the Program specifies that a certain numbered version of the 
GNU General Public License "or any later version" applies to it, you have the option of following the terms and 
conditions either of that numbered version or of any later version published by the Free Software Foundation.  If the 
Program does not specify a version number of the GNU General Public License, you may choose any version ever 
published by the Free Software Foundation.
 If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, 
that proxy’s public statement of acceptance of a version permanently authorizes you to choose that version for the 
Program.
 Later license versions may give you additional or different permissions.  However, no additional obligations are 
imposed on any author or copyright holder as a result of your choosing to follow a later version.
 15. Disclaimer of Warranty.
 THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT 
WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE 
THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.  
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SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, 
REPAIR OR CORRECTION.
 16. Limitation of Liability.
 IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT 
HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, 
BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED 
TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD 
PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH 
HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
 17. Interpretation of Sections 15 and 16.
 If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to 
their terms, reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability 
in connection with the Program, unless a warranty or assumption of liability accompanies a copy of the Program in 
return for a fee.
END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs
 If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve 
this is to make it free software which everyone can redistribute and change under these terms.
 To do so, attach the following notices to the program.  It is safest to attach them to the start of each source file to most 
effectively state the exclusion of warranty; and each file should have at least the "copyright" line and a pointer to where 
the full notice is found.
 <one line to give the program’s name and a brief idea of what it does.>     Copyright (C) <year>  <name of author>
 This program is free software: you can redistribute it and/or modify     it under the terms of the GNU General Public 
License as published by     the Free Software Foundation, either version 3 of the License, or     (at your option) any 
later version.
 This program is distributed in the hope that it will be useful,     but WITHOUT ANY WARRANTY; without even the 
implied warranty of     MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the     GNU General 
Public License for more details.
 You should have received a copy of the GNU General Public License     along with this program.  If not, see <http://
www.gnu.org/licenses/>.
Also add information on how to contact you by electronic and paper mail.
 If the program does terminal interaction, make it output a short notice like this when it starts in an interactive mode:
 <program>  Copyright (C) <year>  <name of author>     This program comes with ABSOLUTELY NO WARRANTY; for 
details type ‘show w’.     This is free software, and you are welcome to redistribute it     under certain conditions; type 
‘show c’ for details.
The hypothetical commands ‘show w’ and ‘show c’ should show the appropriate parts of the General Public License.  
Of course, your program’s commands might be different; for a GUI interface, you would use an "about box".
 You should also get your employer (if you work as a programmer) or school, if any, to sign a "copyright disclaimer" for 
the program, if necessary. For more information on this, and how to apply and follow the GNU GPL, see <http://
www.gnu.org/licenses/>.
 The GNU General Public License does not permit incorporating your program into proprietary programs.  If your 
program is a subroutine library, you may consider it more useful to permit linking proprietary applications with the 
library.  If this is what you want to do, use the GNU Lesser General Public License instead of this License.  But first, 
please read <http://www.gnu.org/philosophy/why-not-lgpl.html>.
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Characteristics

Device type: professional machine, rapid, operating with all group 3 appliances according to UIT-T recommendations.
 

 

 

Physical characteristics

Machine

Dimensions (excluding options): Width: 534 mm
Depth: 526 mm
Height: 706 mm

Weight: Approx. 55 kg

Finisher

Dimensions: 595x495x507 mm

Weight: 14.5 kg

Additional paper tray

Dimensions: 623x548x251 mm

Weight: 9.1 kg

Electrical and environmental characteristics

Power (see identification plate): Single phase 220-240 V - 50/60 Hz - 6.5 A

Consumption: ≤ 18 W on standby
220 W typically in wait mode
700 W on average during printing (peak of 1400 W)

Admissible ambient temperature: Operating: 10 °C to 35 °C [50 °F to  95 °F] with maximum differ-
ence of 10 °C per hour.
Storage: 0 °C  to 35 °C [32 °F to  95 °F] with maximum difference 
of 10 °C per hour.

Admissible humidity: 30 % to 85 % RH (without condensation) with maximum difference of 
20 % per hour.

Peripheral characteristics

Printer

Type: Laser

Resolution: 600 dpi

Speed: 30 ppm Colour / 35 ppm B&W (A4)
The print speed may vary according to the operating system, 
computer specifications, the application, connection method (LAN, 
USB or wireless), the paper format and finally the file type and size.

Preheating time: 45 s

Memory: 512 Mb, extendible to 768 Mb

Time to print the first page: 14 s front (standard A4 paper)
21 s duplex (standard A4 paper)
18 s (other paper thicknesses)

Copier

Type: Colour and B&W copier

Copy speed: 30 cpm Colour / 35 cpm B&W (A4) maximum for a multiple copy

Resolution: 600 dpi
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Multiple copies: 99 pages maximum

Zoom ranges: 25 % to 400 %

Scanner

Type: Colour scanner

Autofeed capacity: 70 sheets (80 g/m²)

Colour depth: 48 bits

Resolution: 600 dpi

Software compatibility: TWAIN, WIA

Maximum paper format: Letter

Print media

Main paper tray: Capacity: maximum 500 sheets of standard paper (80 g/m² [22 lb]).
Paper format: A4, Letter
Paper: Standard or Recycled
Weight: 60 to 90 g/m² [16 to 26 lb]

Manual feeder: Capacity: maximum 100 sheets
Paper format: A4, A5, A6, B5, Executive, Letter, Legal, Gov Letter, 
Gov Legal, Statement, Personalised (92x48 to 216x356mm or 
216x1200 mm)
Paper: Standard, Recycled, Thick, Transparencies, Headed, Enve-
lopes, Labels
Weight: 91 to 210 g/m² [25 to 55.9 lb]

Additional paper tray: Capacity: maximum 500 sheets of standard paper (80 g/m² [22 lb]).
Paper format: A4, B5, Executive, Letter, Legal, Gov Letter, Gov Le-
gal
Paper: Standard or Recycled
Weight: 60 to 90 g/m² [16 to 26 lb]

Output tray capacity: 200 sheets standard paper (80 g/m² [22 lb]).

Duplex: Paper format: A4, B5, Executive, Letter, Legal, Gov Letter, Gov Le-
gal
Paper: Standard or Recycled
Weight: 60 to 90 g/m² [16 to 26 lb]

Finisher (offset and stapling): Paper format: A4, A5, A6, B5, Letter, Legal
Paper: Standard or Recycled
Weight: 60 to 90 g/m² [16 to 26 lb]
Upper output tray capacity: maximum 100 sheets standard paper 
(80 g/m² [22 lb]).
Lower output tray capacity: maximum 500 sheets standard paper 
(80 g/m² [22 lb]).

Print languages

Emulation: PCL® 6, PCL® 5

PostScript® level 3
PDF 1.4 without transparency or gradient

Peripheral characteristics
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These specifications may be changed, with a view to their improvement, without notice.

Communication

Fax Communication

Type: PSTN, ITU T30, G3

Type: PSTN-Super G3

Communication speed: In group 3: 33600 / 14400 / 12000 / 9600 / 7200 / 4800 / 2400 bps
The effective transmission duration for an A4 page varies from a few 
seconds to about one minute (depending on the quality of the line, 
the modem speed, the quantity of information on the original and the 
resolution), without taking into account the exchange initialisation 
procedure.

Types of coding: MH (Modified Huffman), MR (Modified Read), MMR (Modified 
Modified Read), JBIG, JPEG

Dial type: DTMF

Internet - general characteristics

Type: PSTN-V34

Communication speed: 33600 bps maximum (V34Fax)

Protocol: TCP/IP/PPP protocols
PAP & CHAP - MD5 C protocols
SMTP/POP3/MIME protocols for emails

Connectivity

Network port: Ethernet 10 BaseT/100 BaseTx

USB port: 1 x USB 2.0 slave port (PC connection)
2 x USB 2.0 master ports (USB memory key reader)

PC connection: Operating system: Windows 2000 ≥ SP4, Windows XP x86 ≥ SP2, 
Windows Vista, Windows 7, Windows 2003 Server x86 ≥ SP2 (for 
printing only), Windows 2008 Server (for printing only)

Consumable specifications

Reference paper: Technostar A4 - 80g/m2

Toner cartridge: The lifespan of the cartridge toners depends mainly on the type of 
document printed and the average number of pages per print.
Contact your retailer for more detailed information.
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Recommendations for the paper

This paragraph contains information concerning the type of support that can be used for printing.
• Adding paper to the pile may cause double feed.
• When removing the paper tray, always take it in both hands to prevent dropping it.
• Do not use paper that is already printed by your machine or another printer; the ink or toner on the paper may dam-

age your machine's printing system.
• Correct any rippling in the paper before printing.
• Rippling (or curving) should not exceed 10 mm.
• Store the paper carefully to prevent feed problems and image defects due to paper being left in damp conditions.
• Never use damp paper or paper that has been left in an open packet.
• After opening the package, keep the paper in a plastic bag.
• Never use paper with extreme rippling, folded paper or any other damaged paper.

Which paper formats can be used?
 

Support Format
Millimetres (inches)

Main 
tray

Manual 
feeder

Additional 
tray Duplex

Finisher
Stapling/

Offset

Letter 215.9 x 279.4 (8.5 x 11.0) Yes Yes Yes* Yes Yes

Legal-14 215.9 x 355.6 (8.5 x 14.0) No Yes Yes* Yes Yes

Statement 139.7 x 215.9 (5.5 x 8.5) No Yes Yes Yes No

Executive 184.0 x 266.7 (7.25 x 10.5) No Yes Yes* Yes No

A4 210.0 x 297.0 (8.2 x 11.7) Yes Yes Yes* Yes Yes

A5 148.0 x 210.0 (5.9 x 8.3) No Yes Yes No Yes

A6 105.0 x 148.0 (4.1 x 5.8) No Yes Yes No Yes

Gov Letter 203.2 x 266.7 (8.0 x 10.5) No Yes Yes Yes No

Gov Legal 216.0 x 330.2 (8.5 x 13.0) No Yes Yes* Yes No

B5 (JIS) 182.0 x 257.0 (7.1 x 10.1) No Yes Yes* Yes Yes

Envelope 
Com10

104.7 x 241.3 (4.09 x 9.5) No Yes Yes No No

Envelope DL 110.0 x 220.0 (4.3 x 8.7) No Yes Yes No No

Envelope C5 162.0 x 229.0 (6.4 x 9.0) No Yes Yes No No

Envelope 
Monarch

98.4 x 190.5 (3.875 x 7.5) No Yes Yes No No

Personalised Width: 92.0 to 216.0 (3.6 x 8.5)
Length: 148.0 to 356.0 (5.9 to 
14.0)

No Yes No** No** No

* Paper format automatically detected.
** Duplex printing is possible in personalised mode for formats greater than B5 (JIS) and less than Legal.
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Standard / recycled paper

 

Recommendations for use
Use: media suitable for laser printing such as standard or recycled paper.
Do not use the media listed below:
• Surface-treated media (such as carbon paper or treated colour paper).
• Carbon-backed paper.
• Media not approved for laser (heat-sensitive paper, paper for lamination or filming).
• Cold transfer media.
• Press printing media.
• Specific media for ink jet printers (ultra-fine paper, glossy paper, glossy film, post cards, etc.).
• Paper pre-printed on another machine:

– pre-printed on an ink jet printer,

– pre-printed on a monochrome or colour laser printing and copying system,

– pre-printed on a thermal printer,

– pre-printed on another printer or fax machine.
• Dusty media.
• Wet or damp paper.

• Coated paper.
• Adhesive paper.
• Folded, creased, warped, embossed, deformed or crinkled paper.
• Cut-out, perforated or torn paper.
• Paper that is too supple, too rigid or too fibrous.
• Paper with a different texture (roughness) on the front and the back.
• Paper too fine or too thick.
• Media charged with static electricity.
• Laminated, gilded or too bright media.
• Media not withstanding the fusing temperature (180°C [356°F]).
• Paper not cut at right angles or of irregular dimensions.
• Paper with glue, adhesive, staples, attachments, hooks or eyes.
• Acid paper.
• Any any other unapproved media.

Main and additional paper tray Manual feeder

Capacity Up to 500 sheets depending on the 
weight used.

Up to 100 sheets depending on the 
weight used.

Orientation Print side facing down Print side facing up

Driver Standard / recycled paper

Weight 60 to 90 g/m² (16 to 26 lb)

Duplex See section Which paper formats can be used? [ 146].

Note

Store media in a room where relative humi-
dity is between 35% and 85%. Toner does 
not adhere to damp surfaces.
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Thick paper

Paper is considered to be thick when its weight exceeds 90 g/m² (24 lb).
 

Recommendations for use
Avoid placing different types of paper (different weights or formats) in the manual feeder as this may risk causing paper 
jams.

Envelopes
 

Recommendations for use

Use envelopes: 
• For laser printers, with diagonal closure, ordinary pre-glued folds, edges and flaps.
• Approved for laser printing.
• Dry.

Main and additional paper tray Manual feeder

Capacity Not supported Up to 20 sheets depending on 
thickness.

Orientation Not supported Print side facing down

Driver Thick 1 (91 to 150 g/m² )
Thick 2 (151 to 210 g/m² )

Weight 91 to 210 g/m² (25 to 55.9 lb)

Duplex Not supported

Note

Banner paper can be printed if it complies 
with the following conditions:
Weight between 127 and 160 g/m²
Maximum width 216 mm
Maximum length 357 mm

Main and additional paper tray Manual feeder

Capacity Not supported Up to 10 envelopes depending on 
thickness.

Orientation Not supported Print side facing down

Driver Envelope

Weight 91 to 163 g/m² (25 to 43 lb)

Duplex Not supported

Note

Envelopes must be printed on the address 
side. It is recommended to print outside the 
three-play zones (front+back+flap) in order 
to avoid printing problems (poorly printed 
characters, etc.).
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Do not use envelopes:

• With self-adhesive flaps.
• With adhesive ribbons, metal attachments, clips or removable strips.
• With transparent windows.
• Of thick texture (example: reinforced envelopes).
• Comprised of fused, volatile, or discolouring material or emitting toxic vapours.
• Pre-sealed.

Labels

A sheet of labels is comprised of a front side (printable surface) and an adhesive back, covered with a protective film:
• The front side must meet standard Paper specifications.
• The front must fully cover the protective side, without allowing any adhesive to show on the surface.
You can print continuous sheets of labels but depending on the media used and the printing environment, paper feed 
problems may occur. If so, stop the continuous print and print out sheets one by one.
Before printing on label sheets, it is recommended to print out a test on standard paper to check page formatting. For 
more information concerning printing labels, consult your application documentation.

 

Recommendations for use
Using sheets of labels:
• Recommended for laser printers
• Format A4 or Letter (sheets of self-adhesive labels).
Do not use sheets of labels:
• With easily removed labels or protective film that is unstuck.
• Allowing adhesive substances to show on the surface.
• Pre-cut or perforated.

Headed paper

Before starting printing on your headed paper, print out a test on standard paper to check page formatting.
 

Main and additional paper tray Manual feeder

Capacity Not supported Up to 20 sheets of labels depending 
on thickness.

Orientation Not supported Print side facing down

Driver Labels

Weight 60 to 163 g/m² (16 to 43 lb)

Duplex Not supported

Main and additional paper tray Manual feeder

Capacity Not supported Up to 20 sheets depending on the 
format and thickness of the media.

Orientation Not supported Print side facing down

Driver Heading

Weight 60 to 90 g/m² (16 to 24 lb)

Duplex See section Which paper formats can be used? [ 146].
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Cards

Before starting printing cards, print out a test on standard paper to check page formatting.
 

Recommendations for use
Use cards for laser printers.
Do not use cards:
• Coated.
• For ink-jet printers.
• Pre-cut or perforated.
• Pre-printed or multicoloured.

Transparencies

It is possible to print continuously on transparencies, but feed problems may occur due to the media quality, the 
accumulation of static electricity and the print environment.
Before starting printing transparencies, print out a test on standard paper to check page formatting.

 

Recommendations for use:
• Only use transparencies for laser printers.
• Regularly clean the printer paper path as transparencies are highly sensitive to dirt.
• Remove printed transparencies from the output tray to prevent the accumulation of static electricity.
• Do not fan your transparencies before loading them into the manual feeder, as this creates static electricity and may 

cause printing errors.
• Avoid handling transparencies before loading them into the manual feeder as fingerprints may affect print quality.
• Do not use transparencies:

– Charged with static electricity (transparencies that stick together).

– For ink-jet printers.

Main and additional paper tray Manual feeder

Capacity Not supported Up to 20 cards depending on 
thickness.

Orientation Not supported Print side facing down

Driver Card

Weight 60 to 90 g/m² (16 to 24 lb)

Duplex Not supported

Note

If the cards are warped, flatten them before 
loading them into the manual feeder.

Main and additional paper tray Manual feeder

Capacity Not supported Up to 20 transparencies depending 
on thickness.

Orientation Not supported Print side facing down

Driver Transparency

Weight 60 to 90 g/m² (16 to 24 lb)

Duplex Not supported
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Glossy

First test the glossy media to be used to ensure acceptable print quality and speed.
 

Recommendations for use
Avoid mixing glossy media with other media in the manual feeder so as not to create jams.

Printable surface

Each media has its own printable surface, the maximum surface which can be printed clearly without distortion.
This surface is limited by two hardware constraints, the size of the media and the margins required by the printer and 
a software constraint, the memory available for the full page frame buffer. Whatever the media, the guaranteed print 
surface corresponds to the size of the media minus 4 mm from each edge.

On Banner paper, the bottom margin is 10 mm.
Printable surface for envelopes
Envelopes have a flap zone that is not guaranteed which varies according to type.

 

Page margins

The margins are defined in the computer application. When the application allows, personalise the margins taking 
account of the guaranteed printable surface.

Main and additional paper tray Manual feeder

Capacity Not supported Up to 20 glossy sheets depending on 
thickness.

Orientation Not supported Print side facing down

Driver Glossy 1
Glossy 2

Weight 100 to 158 g/m² (26.5 to 42 lb)

Duplex Not supported

Marker Description

1 Non printable surface 4 mm (0.157")

2 Surface not guaranteed

3 Surface guaranteed
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